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MpbAoyog

H mopoloa mTuxlakn spyoaocia €Xel WG oTtOXo TNV eKpddnon tou Director péow
EKTIALSEVUTIKWY MaBOnudtwyv  .H tnAekmawdevon umopel va Ponbriocesl otnv ekpdadnon
TIOAULECIKWV £dappoywyv. Méow authg pmopel va petadoBel n yvwon otav umapxeL To
MPOPANUA TNG amooctaong kat TG EMewbng xpovou petafl ekmoldEVOUEVOL  Kal
EKTIALOEUTH.

Apxikd Ba  SnuoupynBel Eéva  ekmaudeuTiKO  site He  TO  MPOYpPAUUQ
DreamWeaver 6tou  meplypddovtal  ta  Poolkd  epyadsioc TOU  TTPOYPAUHATOC
Director.Oucolaotik@ To site autd amoteAel éva ‘manual’ tou Tmpoypdupatog Director
.Eniong 1o site Ba mepléxel mapadeiypata Kot aoknoelg 6rmou Ba AUvovtal Brua mpog BRua
LLE OKOTIO TNV EUKOAOTEPN eKUABNON Tou. To site Slvel Tnv sukalpia o KAmolov va pabet
ard HOVoC TOU TIC BAOIKEG SuVATOTNTEG TOU MPoypappatod. Etol wote va elval o B€on va
dnuoupyel tig Skég Tou Tatvieg cuvbualovtag Ta MOAUECLKA oToLKE A,
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1.BaOLKEG EVVOLEG

1.1 Animation —Xyediokivnon

O Opoc Animation onuoiver amddoon (®VTAVIOG Kol Kiviiong 6€ OTOTIKEG
napovotdoels. Eivor ) dtadwcacio pe v omoia mpootiBeton 10 ototyeio ¢ kivnong
o€ po eikova. Etvor n ameikdvion kamolov avTikelpnévoy kabmg petafailoviot pe to
xpovo. T kdBe tétolo avtikeipevo Bo mpémer va dNUIOVPYOVVTOL OLOPOPETIKES
Hoppég KaBdg petafdAlovton pe Tov xpovo.

1.2 Awavoopatikd (vector) ypopikd

Awvocpatikd (Vector) ypoeikd amoteAoOvTol amd YPOUUES Kol KOUTOAES Ol
omoieg  mopdyovior omd  poOMUOTIKOVS  LTOAOYIGHOVS  KOL  GUVOPTNGOELS
Xpnowponotobvtar S0t eivan pikpd oe péyebog emopévmg Umopovy va, poptmBodv
€0KOAO, OO TOV EKAGTOTE QLAAOUETPNTN lotoceridwv (browser) .Emiong eivau
aveCdptnta g avdivong g 006vng Kot umopodv vKoAn va TuT®BoLV ylati eivon
aveEdptnta omd TV avdAvoTn EKTOTOONG TOL EKTVTTMTY).

1.3 Avadkng popenc (Bitmap 1 raster) ypagika

Ta ypagikd dvadikng Hopeng omotehovvTal amd Eva mivoka 000 SlCTAGEWMV.
O dwdudotatog mivakag mepiEyel tov aplud tov gwkovootoryeiov (pixels) mov
katalopPavouv oprlovting kot kabétmg o ewova . Ta euwovostoryeia pmopodv va
gtvar dlapopetikod ypodpatog. To péyebog pog bitmap ewovag givar moAd peydio
vyl yuoo KéOe eikovootoyeio mpémel va LUAAGGCETOL 1| TANPOPOPID Yol TO YPOUA
tov. To Pactkd pelovéknua eivor 6t 1 HeTAfOAN] TG SLACTAONG TOV CVYKEKPIUEVOV
EIKOVOV PEPVEL GOPaPEC TOAAES POPES ATIMAEIEG GTNV TOLOTNTA TOVG .

1.4 Kapé (frame- Keyframes)

Kd&Be oyéd10 tov animation , ovopdleton kapé (frame ). O dpog wopé
AVOPEPETOL GE U0 LOVADO ¥POVOL GTO animation Tov 0moiov T0 aKPPBEG ¥POVOLOYIKO
pnkog e&aptdtor amd to OG0 ypnyopa ovamapdystal To animation (frame rate). ['a
napadetypa, oto film rate (24fps), éva kapé dapkel 1/24 tov devteporéntov.Ta
keyframes eivon kapé ota omoia 0 oYedOGTNG TOL animation onpovpyet pa Tola yo
éva yapoktpa (1 o€ otidnmote divel kivnon). To animation dnpovpyeiton Otov Eva
avtikeipevo ta&devel N oAddlel amd éva keyframe oe aAlo.

1.5 Ztpdpara (layers)

Edv pia ewcdvo avtiotoyel my. o éva Pipiio, tote éva otpdpo Ba elvar o
oeAida tov Pipriov avtod. Ta amiovotepa yYpagikd mepEyovv POVO £vo. GTPMLLO
AvTifétog Ta mo cVVOETA YPOEIKA YPNCILOTOI0VY TOAAG oTpduata. To oTpduaTe
umopetl va etvar odpova 1 Oyt kot Bo pog Bonbnicovv oty dnpovpyia cHvOETWV
YPOPIKADV.



2. To Hpoypappa Director

2.1H wotopia tov Director

To Director exd66nke 1o 1985 pe 1o dvopa "VideoWorks". To omoio frav
wo multimedia epappoyn yioo Macintosh g etoupeiog Apple . Exeivn v emoyn ta
Animations mepropilovior ota ypoOHOTO.  Hadpo Kol GGTPO TOV 0Bovadv TV
Macintosh.

To 1987 ovoudotnke Director pe v npocOnikn véov duvatotitov. Emeion
nrov epappoyn yro. Macintosh ovopdlovrav Macromind Director.

To 1988 &ywve ko n eloaywyn g scripting yAdocog mpoypappaticpod lingo
oto Director.Me v ypfion g yA®ocag avtig to  Director anéktnoe mapa TOAAES
duVaTOTNTEG.

Y1g apyéc tov 1990 Aoyw tev moAA®V dvvatotitewv tov , to Director
ELLPOVIGTNKE KOl GTO AEITOLPYIKO cvoatnuo Tov Windows.

To 1993 to Macromind Director ¢ywve Macromedia Director pe v ékdoon
3.1.3

To 1994 exd66nke 10 Macromedia Director 4 yw Windows kot yuo
Powermac.

To 1996 exdobnke to Macromedia Director 5

To 1997 exd6bnke o  Macromedia Director 6 pe evoopdrtoon Shockwave
Kot mp3

To 1998 exd6bnke 710 Macromedia Director 6.5 pe QuickTime 3
vrootHpién. Tnv  d  ypovid ekddbnke to  Macromedia Director 7 Aiyo mwo

BeAtiopévo

To 2000 exdobnke to Macromedia Director 8

To 2001 ekdoOnke TO Macromedia Director 8.5 pe vmoompién
Shockwave3D

To 2002 ompovpyndnke to Macromedia Director MX yvootd kot og

Director 9

Tov lavovdpto tov 2004 exdonke to  Macromedia Director MX 2004 yvwotd
kow g Director 10.Ewot n ékdoon v omoia O mapovoidcovpe oty mapodoa
gpyacia kot mivew o’ ovtyy TV €kdoomn Paciomnkov OAEG Ol LETOYEVECTEPEC.
[Mopatmpovpe 61t amd to 1993 6yedov Kabe ¥pdvo ekdidovTay Kot o vEa £Kd06T TOV
Director Otav  exdoOnke to  Macromedia Director MX 2004 éywe modon
teoodpov  puéxpt va ekdobel pia véa. To Macromedia Director MX 2004
KOVOTTOL00GE TOTE KOl TOVG TTLO OTTOLTITIKOVG YPTOTES.

To Mdprtio tov 2008 eppoaviotnke Adobe Director 11 .H Macromedia stopio
ayopdotnke amd v Adobe kot poli B’ avTiv Kot To AOYIGHIKE TG .


http://en.wikipedia.org/wiki/Apple_Macintosh

To Mdaptio tov 2009 eupaviotnke Adobe Director 11.5

To ZentéuPpro tov 2010 gpeaviotnke Adobe Director 11.5.8

Tov Avyovato tov 2011 eugpaviotnke Adobe Director 11.5.9

Tov ®efpovapio tov 2013  epgpaviotnke 1 tedevtaio ékdoon tov Director n
Adobe Director 12.Mgypt kot ofjpepa Tov ypaeetor avth n mruylakn n Adobe dev
£xel Tapovoioor Kdmotla kovovpla £KO00T).

2.2T givon To Director

To Director gival t0 mO OMUOPIAEG  TPOYPOLLL GUYYPOPNS EPUPLOYDV
molvpécwv Eivar emayyeApotikd mpdypoppo Kot xdpng te EVKoAIoG Tov oTn xpnon
£yel yivel 1600 apeotd 610 gupv kowod. To Director mpooeépetal 610 AeitovpyIKa
ovotuate tov Windows kot Macintosh.

To Director givat éva pdypappo pe TOAAES dLVATOTNTES, TO OTTO10 £XEL O
YPNOLUOTOMOEL GTNV KATAGKELT] TOAADV EUTOPIKMOV EQPAPUOYDV. AVTO 0QEIAETUL GTO
OTL o1 ypNoteg UmopohVE Vo ONUIOVPYGOVVE EVKOAN OMTIKEG TOPOVCIACELS M
AOYIOUIKO SAOYIKMV TOAVUECWOV E ¥pNoN N0, €OV Kot Bivteo. Aol dabétel
EVOOUATOUEVO EOKA epyaleia enelepyaciog KEWWEVOD, EIKOVAG KOL 1XOV.

Mo axopa dvvatotnta givol 0t pe to Director ot yprioteg umopovve va
yepilovior  YopTOYpPaQIKA Kol Olvuopatikd ypaeikd. Emmiéov ot ypnoteg
UTOPOLVE Vo OMLOVPYNOOVVE EVIVTOCIOKA €QE Kot vo mpocBécovve kivnon-
animation oe ovtikeipeva. H omobnkevon tov animation yivetar o€ popon
QuickTime. Exiong to Director enttpénetl Tnv elcaywyn £totpnmv toawvidv QuickTime.

2.3 Epappoyég tov Director
e Exmnaidevon (training)
e Tlodeia (education)
[epintepa (kiosks)
10 ['papeio.
X10 Xmitt.
Tovpiopde.
I'sowypagikd Xvotpata [TAnpogopiodv (GIS): T'papikn tapovsioon twv
YEQYPAPIKAOV OEOOUEVDV.
o Awpnuicels: Anpovpyio EVIVTOGLOKOV EQE Kol GUVOETIKMOV OAVTIKEILEVOV

TOV OEV VILOKEVTOL GTOVG PVGTKOVG VOLLOLG,.

o Jatpwéc epappoyés Topoypaeio: avamapdotacn Kot e£epedlvnon TOV TOUMV
7OV O1VEL O TOLOYPAPOG,.

o Téyvn.

o Iloyyvidw.



2.4H @uoco@ia tov Director
H Baocwkn eihocoeia otnv omoia otnpiletar to Director givar 1 dnpovpyio piog

Beatpiknc mapdotaonc. '’ avtd kat to kabe apyeio tov Director ovoudletor tovia
(movie) kat éyxer v enéktaon .dir .O ypnotng tov Director mailet to poro ToOL
oknvoBétn ,0 omoiog mpémel v dnuovpynoet €va oevdplo g tawviag. ‘Emetta o
¥PNOTNG TPEMEL v Kdvel cLALOYY otolyeimv. Ta otoyeio eivar To ypoaekd, ot
QOTOYPAUPIES, TO YNOLaKO Pivteo, GALEG TaVieS, (0L, KEILEVO Kol KIVOOUEVES EIKOVEC.
A@pob 1o ovAAéEel To tomobetel g mOomowog (cast-members) upéco oy
oknvn(stage). EmmAéov kabopilel mote Ko mw¢ dpa o0 kabe nbomotds. Avtd yivetal
epoocov kobopioel otovg mbomowovg mwg Ba cvumepipepbovv. H  yiAwooo
TPOYPAUUOTICHOD oV ypnowonotel To Director yio va kabopicel 1 cvumepipopd
twv nomoidv eivar 1 Lingo.

3.To Ilepipariov Epyaciog Tov Director
To nepiarrov tov Director anoteleiton amd Eeympiotd Tapdbvpa, 6oV 61O
KaBEVO OLLOOOTO10VVTOL KOVUTLA KOl EVTOAES TV O10POPMV LEVOD.

Entfecopnmis [Etomjmy —
Tpappd Epyaisiov Property Inspector

Ipoeppn Mevow

TModzmo B f Yew todly Cortid i Wndow =
Eproteioy FEFd BRE = nm RS wies O 0L LrAN Be®
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3.1 H oxnvn (Stage)

H oxmvn givar 10 Baoikd Tapdbvpo oto onoio dnpovpyesiton 1 tovia tov Director. H
oknvi kob’ OAn v Odpkeln oG Ttowviag elvor 10 kot PETafAAAovIol To
avtikeipeva kot n dpdomn mov eEghiooetar péca ot oknvil. Ot povadikés adhoyég
mov yivovtonr ot oknvn €ivor 1 petaforny  tov peyéBovg g kot tov vroPabpo
(background) tnc.

@ Untitled: Stage (100%) = [=
£ ¥ Stage (100%)

10022 -] 4 ol =

- [(m » “« . [~ [

3.2 Awvoun poérwv ( cast)

O ypnomg ,ot0 moapdBvpo Awavoun poéAwv, elodyel tovg nbomoovg mov Ha
oLUUETEYOVY otV epapuoyn Tov Director.Kabe nbomoidg Aéyetor pélog tov cast
(cast member). Méhoc tov cast umopei va givar  €wkova, yog, Pivteo, lingo script 1
o AN towvia tov Director. To cast eivon o meployn €KTOC TG oknvig 6mov ot
nbomotoi mepuévouv uéxpt va €pBet n oelpd Ttovg va epgovicfodv ot oknvr. Kdabe
nbomotdg pmopet va gpeaviCetor otn oknv oe TOAEG BE6E1C TOLTOYPOVA. ZVVOMKA
to cast pag towviag pmopetl va €xel péypt 32.000 péin. Ta péAn  epeaviCovion oe
pikpoypagpieg péoa oto cast.Emiong kdbe mBomodg poali pe v pviatovpo tov
eneavileTor kol éva eikoviolo Tov Taplotd Tt €100 ivar 0 NBoTo10¢ Ty E1KOVA, YOG
K.T.A. Xto cast ot nBomorol eivar yopopévol Kot 0 YPHOTNG 0POL TOVG EYEL KAVEL
gloaywyn oto castémeirto  pmopel va tovg kobopicel T CLUTEPLPOPE TOLG
YPNOOTOIdVTOG SCript pe ™ yAddooa lingo. H mpoPoin tov Cast pmopel va yivet pe
dvo tpoTovg omd To kovumi IIpoPoin eikovidimv kot TpoPoin Aotag(Cast view
Styles)



3.3 H moptirovpa (To score)

Type

T

Modified

Comments

H naptitovpa kabopilet to moTe 01 nBomorol Ba eppavictodhv otnv oknvy| . Aniadn o€
Ol YPOVIKN oTyp] péca otnv touvia Bo epeaviotel 1 Ba dpdoel o nbomrorog. H
nopTItovpa etvar évag  01001oToTog mivakag. Ot optldvTieg YpoUUES TOV TivoKa
ovopalovton kavaio(channels). Yadpyoov 5 koavdAiio tov €pé, T0 KavOiil TAoiciov
Kot péypt 1000 kavdAio eOOA®V TOV UTOPOVV VO TEPEXOLY GTIYULOTLTTA NOOTOLDV.
Kdébe kaval yopiletar oe mhaicwo (frames).Kabe mlaicio amoteAei 10 kapé g
tawviog. ‘Eva otrypodtomo(sprite) tov nbomoiod tomobeteitan ndve o mhaicto. Eivo
duvotov vo vrapyovv, ce Koamotwo frame, dbo M meplocdTEPA OTIYUOTUTTA EVOG
nBomo100, ta omoia dUmG TEPIEYOVTAL 6TO 1010 TAMICIO AAAL GE S1APOPETIKE KavAALn
210 otiypotvomo evog mbomolov kaBopiletar m B€omn TOL ,TO YPOUO TOV KO M

SLPAVELL TOV .

10

@ Untitled: Cast — = |[==]
W Cast:Internal =
== | e ow OO ;
i =3 3 El = [=] T 8 2 10
T 12 13 T4 15 15 f id R E:] E] 20
= =2 Zz3 =4 Z25 ] Z2T =8 58 3D
31 32 23 34 35 35 i fek:3 5 40
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@ Untitled: Score

% Score

¢
B
[
o1
e
I =1
Iember -

3.3.1 Ta xavaio(channels) tov eeé

Koavai puBupov(Tempo): pvOuilovpe v
ToYOTNTO NG Touviag o€ TAiclo avd
devtepodento (fps, frames per second)

Kaval marétac (palette): opilovue ta

'_=' ‘ Sbéca YpOUOTO Y10, TNV Tovio
L Kavait EVOAOYNC (Transition):
TpocHETov e EPE EVOALOYN G TAOIGTWV
Il
Kavair nMyov (sound): upmopodue vo
: " i YPNOUOTOGOVLE dVO KOVAALL 1)YOL Y10
62 VO TPOGOEGOVE LOVGIKY], NYNTIKE EQPE
o 2 KO QYA GELS.

Kaval  ovumeprpopdc  (Behavior 1
Script): umopodue vo  ypdyovue éva
npoypappo  (Script) ywo oldkAnpo To
TAaiG10.

3.3.2 Koavdir mhouciov (Frame Channel)

To Kavédm ITAociov Aéyeton kot aAlmdg ypouun ypoévov (timeline). To Kavdi
[TAaroiov givan 10 ykpt kova Ildve ¢’ ovtd T KavaAl vedpyovv apiBuoi ot omoiot
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aveBaivouv ava 5 kot dnAdvouvv tov aplBud miatsiov. Ta mThaicio apiBpodvrol amod
aplotepd mpog Ta 0e&d. [Tavm 610 KavdAl TAAGIOU VITAPYEL | KEPOAT] OVOTOPAYWOYNG
(playback head)n omoia pog deiyvetl o mhaiclo mov epeaviletor oTn okNvy ekeivn ™

OTLYUN.

== ‘

Member v

3.3.3 KavdAr ddrov (sprite channel)

Ta kavédiio eddrlov Bpiokoviol Katw and 10 Kavait Tioiciov. ‘Eva gldwAo (sprite)
etvat éva oTrypdtumo  €vog MBomoloy . XPNGYLOTOOVUE TAL KAVAALL EWWMA®V Y10 VoL
ovyypovicovpe 6A0VG TOLg NBomo10VG ToL £yovv TomobeTnOel 6T GKNVN 1| GTO SCOre.

3.4 Embewpntig tov 1dottov (Property Inspector)
Kd&Be nBomoidg o kdOe otrypotumo €xet 1010tnteC. Mmopolpe va epeavicovpe 1 va
OAAGEOVLE TIG 1O1OTNTEG AVTEG (P CLUOTOIDOVTAG TO TOPAOLPO TOV 1010THTOV .

¥ Property Inspector =

’K Untitled Mawie
L) @

Guides |

Guides: ﬂ
[ wisible
[¥] Snap Tar
[ | Lack
Mew: ¥ * Femove All |

-
Grid: ! ~) Dots (@] Linez
[ wisible
[]&nap To

W: |B4 H: | &4

3.5 Embewpnrig ovuneprpopmv(Behavior Inspector)

Me 10 TOpdBVPO GLUTEPIPOPDOV  UTOPOVLE VO SNULOVPYNCOVUE  CLTOUOTOL
script yopic va yperaleton va ypdpovpe kot vo Bouopacte tic eviorléc g Lingo. To
script Tov OMoVPYOVUE OVTOHOTE UE TO  TAPAOLPO GLUTEPIPOPOV ovoudleTon
CLUTEPLPOPE, TNV OTOi0 ALPOV TN ONUIOVPYNCOVUE UITOPOVLE VO TNV  ovaOEGOVUE GE
nbomolovg péca oto score. To Director mepiéyel o kKAdon omd vropovtiveg Script
nmov ovopalovton handlers  ypaupuévec oe lingo. Ta handlers kabopilovv 1
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CLUTEPLPOPE ONAAON TOV TPOTO dpdiong £vOg NBomoloy KATA TN O1dpKELD TOL £PYOU.
M suumeprpopd amotedeiton omd To dvopa TG, To cuuPdv (event) Kot Tnv evépyeLn

(action) mov yivetat petd o copPav.

£ w Code:Behavior Inspector

x|

Behaviar Inspector

3.6 H maAéta Epyoieiov

Yto mepipdArov tov Director apiotepd Ppioketor 1 foacikn ToAéTo epyareimy.
[Mopoakdto Bo avaAdcm avaAvTiKd TL KAVEL TO KAOE epyaleio.

1 Epyoieio  emoyng  (Arrow  tool)
ki XPpNOOTOLEITAL Y10l TV EMAOYN KoL TNV
TPOTOMOINGT GVIIKELEVOV KOl TO GYNLLOL
ToV £)EL TN HLopen PELoLG.
o Epyoieio meprotpopng( rotate)

Xpnowonoleitar  yioo TNV TEPLGTPOOT
evdg  mbomowod  mPOc  omoldNTOTE
KkatevBuvon .

&M Epyaieio Xépt (Hand)

Xpnoyonoteitar yuo vo. GOPOVUE EVaV
N0omo1d 6T GKNVNA 1| OTN TOPTITOVP,

Epyaieio peyébuvong(zoom)
Xpnowonotgitor yioo vo. peyedovoope m
VO GUIKPUVOVLE UL TPOPOAN

A Epyaieio KEWWEVOL (Text tool)
Xpnowonotgitor  yiwo TNV E0AYOYN
KEWEVOL GTO GKNVIKO.

7 Epyaieio ypapung (Line tool)

Xpnowonotgiton yio tn oyediaon evbeimv
YPOUHAY

Aol emAéEovpe TNV Ypapuun EmELTa
kaBopilovpe 10 TAATOG TNG YPOALUNG OE
pixel
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Epyaieio opBoymviov (Rectangle)
Xpnowonotgiton  yio T oyedioon
@30 opBoywviov moapaiinroypaupov .Eite
oVTO €lvol YEUGUEVO N UN.

Epyaieio otpoyyvrol
Hoaporinroypappov( Rounded

@ D Rectangle) Xpnoyomoteiton yio
o)£010OT GTPOYYVAOVTOPOAANAOYPALLOV
Eite avto elvon yepiopévo N un.

Epyaieio Eldenyn (Ellipse)

I Xpnoomotgitan yio tn oyedioon
@0 ‘EMewym. Eite avt eivan yepuopévn nun.
Epyaieio Checkbox
Eivor  éva  tetpdyovo medio  mov
YPNOOTOIEITAL OTOL  YPOPIKE Yoo va
B emutpéyel | va Béoel extdc Asttovpyiog
£V0L YOPAKTNPLOTIKO YVOPIGLLOL.
Epyoaleio radiobutton

Xpnoomoleital Yo vo EVEPYOTOGEL 1)
VOl OTEVEPYOTOUCEL [0l AEITOLPYia,

0 Epyaieio button.Xpnowonoteitot yio tnv
E160YMYN KOLUTLOV 6TO Cast

3.7 Ipopur Epyaieiov

Ta epyoreio elvar o mo Pacikd kol cvyvotepa ypnolonotovpuevo mapdbvpo. Ta
EPYOAEIDL UTOPOVUE VO TO. PpovUE Kol TN YPOUUN HEVOL TOv B avoALGOVUE
TOPOKATO OAAG Yoo cuvTopia Kot o ypiyopn tpodcfoct ota epyaleio emAEyOVUE T
ypouun epyoreiov. Ilepiéyer epyodeio yoo ewooymyq apyeiov, amodnkevon,
oxedlooNg SVUGUOTIK®OV CYNUATOV, EpYOAEi0 Yoo TV €loay®yn Kot emeepyacia
KEWWEVOV, EPYOAELD Y10 TO YPOUATICUO TOV AVIIKEWEVOV KaODG Kal epyareia Yo TNV
EMAOYN OVTIIKEWWEVOV 1 UEPOLS avTIKEWEV®Y. Emiong kovumid yio va avoiyouvv
katevbeiov To Topabvpa eyypapov (document window) 6mwg to Stage,to Score kot
70 Cast.

i Ta KOUMIUA QUTA ME TNV OElpd  TA

ﬁ 'E\_'l Ir—' Eﬁ XPNOLUOTOLOUKE ylot v SNULOUPYNOOUE
véa tawia, véo mapdBbupo nbomowwv (cast),

Avolypa apxelou ,eloaywyr nbomolwy .

- El ) Ta KOUMMUIA QUTA ME TNV OElpA ™™

XPNOLUOTOLOUKE yla vo  amoBnkeVoou e
KOl va KAVOUE amoBrkeuon OAwvV .

Ta KOUMIUA QUTA ME TNV OElpd  TA
XPNOULOTIOLOUE VIO VO OVOLPECOUNE HLaL
Kivnon mou kavape. Enelta eival ta yvwota
KOUMIMIA TOU  UMApXouVv O  TIOAAQ
TLPOYPAULOTO ,TNG OTTOKOTING, ™ng
avTlypadnc Kal TnG EMIKOAANONG .

Era i = To KOUMMIA QUTA HE TNV OEpad T
XPNOLLOTIOLOUKE Yl va  KAVOUWE gUPECN
nBormnolwv and to mapdbupo Twv nBomolwv
KOL yld VO KAVOUHUE  QVTIKOTAOTOON
nBorowwv (Exchange cast member).
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Ta xooumd ovtd pe v oepd Tt
YPNOLOTOIOVUE YL VO TTAUE TNV TOViOL
oTNV apyYn NG LYW VO OKOYOVUE TNV
tovio kou - Yoo voo toaiger m touvia. To
KOLUTTLO QL TE LITAPYOVV KOL GTNV GKNVY|

T1F T 0 W To wovopmd avtd pe v oepd 10
YPNOOTOIOVUE Y10 VO EUPOVIGOLUE N
vo. kpOyovpe to  mopdbupa €yypdpov
(document window).Ankadn ™ oxnvi,
T0 mopdBvpo Tv nlomoidv ,to Tapdbupo
g oknvoBeciag, Tov  embewpnti
10O10THTOV Ko TV ToAETO, BA10ONKNG.

Ta xooumd ovtd pe v oepd Tt

s J AW YPNOLOTOLOVUE Y10 VO EUPOVIGOVUE TO
napdbvpo  Loypagikig, T0 mapadupo

SLOVUOLOTIKOV oynuatwv, To mopddvpo

keévou kat to Shockwave 3D mopdabvpo

B <2 o Ta xoopmd avtd pe ™V oepd 10

YPNOUYLOTOLOVUE YO VO  EUPAVIGOVUE TO
eMOE@PNTN CLUTEPIPOPDV, TO TTAPABLPO
Yoo vo YpAWOuUE OKPITTAKLO KoL TO
Topadvpo UNVLUATOV.

¥
3.7.1 To mapd&Bupo Coypapkng ——

To mapdbvpo Loypapikng (paint window) elval yla va Snpuioupyrooupe VEEG ELKOVEG E
Vv Ponbela twv gpyoieiwv mou pag Sivovtal | va enefepyactoUUe MPOUMAPXOUTES
€lKOVEC. Me amotéAeopa va dtiaoupe NBOTOLOUC ELKOVEG KAl VO TOUG EVOWOTWOOUUE
otn oknvh . To mapdBvpo (oypaeikng £xel TOAAEG dLVOTOTNTEG Kol TOAAL epyoareio
€101 OOTE VO TO. YPNOWOTOmcovpE v otnv ewova. To mapdbvpo Paint €yet
KaOeTovg Ko optdvTIong Yapakeg, ot omoiot pag Ponbovv yia va gvbuypoppicovpe
Kot vo ToEVOUNGoLVHE TO £€pyo pag mov oyxedidlovpe. Iopakdto avaivovpe Eva Eva
Ta. epyareio Tov mapdbvpov Coypapikng. Kdamowa epyoieio vdpyovv otnv Poacikn
ToAETA EpyareiwV Ta omoia £govve NON avaAvcel. Edd Ba avaidcoovpe Olo tor AL
epyOarEia .
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@Unt'rtled: Image = =& |

£ ¥ |Image:Paint 1 =

Faint 1

+ 4 b [EI— Cp 0 T [Internal v|

1

—
d
P

EE@EJKP%@@ﬁ
ROoOONKNKSLOG

| [

4 pinels |Nnrmal - | 4 F

Zekwdue mpwto pe tnv moAéta epyaleiwv mou Ppioketal aplotepd tou TAPABVPOL
CoYpaPIKnG

To epyaheio lasso to xpnoLOMoOLOUUE yla va
] SlaAé€oupe ouvnBWC TMOAUYWVIKEG HOPdEG
i Adol SwaAé€oupe TNV meploxn LEMELTA
UTOPOUME QUTN TNV TEPOXH va TN
OTMOKOWYOULE KOl va T cUPOUUE.

To epyokeio Marquee emAéyel 10 €pyo
mov oyeddlovpe .Me owtd TO €pyaieio

. SAéyovpe  gvOLYPAPIGUEVES TEPLOYES
s, L10G EIKOVOC.
Xpnoyonotovue 10 gpyodeio
@ Registration Point yia vo aAAdEovpe ™
0¢om tov onpeiov eyypoaeng.
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1N

Xpnowonowobpue 10  gpyoreio  youo
(eraser) yio va. opnoovpe pixel péoa oty
EKOVQL

Ne |

Xpnowonotovpe 1o epyoieio Eyedropper
yla va mdpoupe SeypatoAndio xpwpatog
amod ULa €IKOVA O £VOL CUYKEKPLUEVO onuelo.

XpNOIHOTOOVUE T0 gpyareio
kovPa(bucket) yio vo yepicovpe o
neployn 1o ypodua pe to foreground

Rl || @

To epyareio poAvPod ypnolomoteitol
v xbpaln erevbepov  YPOUU®OV  pE
oKANPO AKpo.

XPNOYOTOLOVUE TO EPYOAEID OEPOYPAPO
(Airbrush ) yw va wyexdler 10 TpéY®V
EMAEYUEVO YPOUO, LEAAVL, Kot Vo YEUILEL
10 oyédro. Me airbrush Coypagilovpe
UOAOKES YPOUUES, OTMG IE TO TIVELO TTOV
o dobue mopokdte® , OAAL pE TOV
AEPOYPAPO UTOPOVUE VO, EKTOEEVOVUE
YPOLOL AKOWLOL KO OTAV OEV TOV GEPVOLLLE.
2EPVOVTOG TOV AEPOYPAPO, ONUIOVPYOVUE
OKIEG.

Xpnowonowbpe 10 gpyoreio  mvELO(
Brush) yia va Bovptoicovue pe 1o tpéyov
YPOUO, HeAdvl kol va  yepilovpe To
oyédwo. Elmope mopamdveo v owopopd
OV EYEL LLE TOV AEPOYPAPO

To ypopo oyedioaong M oAMOG xpoOUA
npooknviov (foreground color) eivar to
podpo Kot YpOMH GOVIOL 1) OAMOG
ypopa topacknviov (background color)

Me 1o pattern kaBopiloupe tOo YEMLOHQ
potiBou.

Oa avalvooupe Twpa TN Undpa epyaleiwv mou Bpioketat otn kopudr Tou TAPUBHPOL

Coypa@ikig.

To mpwto  gpyoAeio  elvar 1O
flip(avtikatontpilw).Edd  €yovpue  ovo
emioyéc 1o Flip Vertical mov eivan
yopiopa TOL  KEWWEVOL  avdmoda
katakopvea. Kor 1o Flip Horizontal
yopiopo  tov  KEWEVOL  avdmoda
opllovria.

To devtepo epyadeio eivon n mepLoTPOEN
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M
|+

(rotate).Ed® pmopodue va emié&ovue

mv TEPLOTPOPT KOTd 90°
aploTEPOGTPOPE 1M KOTA 90°
0eE100TPORO.

Axopo éva gpyadeio sivor 1 elebBepn
neplotpopn. To Free Rotate, cOpovue
onAadn 1O  OavTIKEIEVO ¢  TPOG
omoldNToTE Kotevbuvvon.

To epyokeio Ao&evm  (skew) to
YPNOOTOOVE Yo vo.  yeipoope
EMAPPAS TO OVTIKEIEVO.

XpNOOTOLOVUE TO Epyoreio warp yia va
oKePPMOOOVUE VO AVTIKEIPEVO

......

Me 1o epyodeio (perspective) mpoontikn
EMALYOVUE TO OVTIKEIUEVO KOl GEPVOLLE
TO OVTIKEIPUEVO amd Oomol0dNmoTe oNuEio
Béhovpe MOTE VoL ONULIOVPYCOVLLE TO EPE
oV EMOVUOVUE.

To epyodeio (trace edges )y va

ONUIOVPYNGOLUE EEMTEPIKT YPOUUN OTNV
EMAEYUEVT] TTEPLOYN.

Me 1o epyoieio smooth kdévovpe mio
Aetec Ko amoAég TIC EMAEYUEVES TEPLOYES
€VOG OVTIKELLEVOV.

Me 10 gpyakeio avtiotpoen (invert),

Qe OVTIGTPEPOVE  TO  YPOUATO G &V
OVTIKEILEVO.

Mo va peidoovpe 1 va avénoovpe 1

@+0 O-a QOTEWVOTNTO TNG EMAEYUEVNG TEPLOYNG

ypnowonowovue to darken color 7
lighten color.

e

Xpnowonowodpue to gpyareio  Switch
color yw vo oAld&ovue to foreground
YPOUO LLE TO EMAEYUEVO YPDOLLOL

3.7.2 To mapdaBupo dravvouatikodv oynuatov (Vector Shape) -

I

210 mopABvPO SLVUCUATIKOV GYNUATOV ONUIOVPYOVUE OLOVUCUATIKEG EIKOVES Ol
omoieg UropoHv vo, LEYOAMVOLV KOl VAL UKPOIVOUV YmpPic Vo dALOIDVOVTOL .
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@ Untitled: Image I:__i

£ ¥ Image:Vector Shape 1 =

Sl Wector Shape 1

+ 4 b rﬁ]— wﬂ i [Internal v]
h @ Linear Cgcles:i1 = Spread:imﬂ ]
AV :
O

) O

@ O

Clozed
& -, [l

b

4 Ll F

Mapakdtw mapouctdlw éva mapadsiypata o €ywve pe Vector Shape.

Mo va to dnovpynow enéieéo 10 Epyareio otpoyyviov ITlaporinioypdpipon(
Rounded Rectangle).Ta onueia amd 61ov Pmopovue va. GOPOVLE TO OVTIKEIUEVO Elvat
amo Tic teAitoec. H kdBe teditoo ovoudletor vertex kot OAeg £xovv ypopo UTAE
EKTOG OO TNV TPATN MOV EYEL YPOUO TPAGIVO KO TNV TEAELTOUO TTOVL £YEL YPDUOL
KOKKLVO.

3.7.3 To mapdabupo kepévou(text)

To mapdBvpo wewévov elvar éva  amhd epyareio oOvTaENg KeWEVOL.
Mmnopovpe va dnpovpynoovpe kot va gneepyactoope  keyévov. o mapaderypo
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umopovue va pvOuicovpe to ypdua oto Keipevo, to background ,to otvd TNG
YPOUUOTOGEPES, TO péyebog yapaktipmv KAm. Emiong pmopovue va mpocHBiécovpe
dlapopa oynuata, ypoppés, buttons kou fields.

@ nurmbers: Text = |_IE_Ii|

2 |
i Text:Text 8 i
Text 3
+ 4 b E | < 0D g |Interna| v|
Arial ~ B I U |® 2 I 15 ‘;]
| ] Ce 1 ! 2 ' 3 ' 4 & '
I

3.8  TI'popun pevod

v Kopuen Tov Topabipov epyaciog tov director Ppioketor M ypopuun
uevov (menu bar).Exel vrdpyovov Olo ta mapdbupa kor ta gpyaAeion o, omoia
enpavifovol To TEPIEGOTEPO EV GLVTOLIN oTthy em@dvela tov director.Kabe évo amd
0. 9 pevod gpeaviCovv vopevol Tov £xel TIG Aettovpyieg mov o ypnotng Hédetl va
EMALEEL.

Fite Edit View Insert Modify Control Xtras Window Help

[Mopaxdtow 0Oa avoAvcw kdbBe pevov Eexwpliotd Kot Oa avagépom Tig
Aertovpyieg mov mapéxet 1o kabéva. Ioapatnpodue 6Tt 6TO PEVOD KATOEG EMAOYES
etvan EebBopraopéves. I'a va evepyomomnBodv avtég ot emA0YES KoL VoL YivOuV EVTOVEC
povpeg mpémel va, eMAEEOVE TO KATAAANAO TapdBupo 1 ToV KaTdAANA0 NOOTO0 .
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Mew
open...
Close

Save

Save As...

Save and Compack
Save Al

Irnpart. ..
Export...

Publish Settings. ..

Page Setup...
Prink...

Recent Mavies
Recent Casks

Ezxit

CErl+0
Cerl+HF4

Chrl+5

Cerl+R
Crl+Shifk+HR

Ctrl+5Shifk-+HP
Cerl+HP

Alt+F4

¥t ypouun pevov (menu bar) n mpot
emloyn eivan 1o File. Xto File vdpyovv
Ol €MAOYEC VO ONUOLPYNGOVUE Lol VEQ
tovia, vo  avoifovue pio vIpyYovoa
touvio, (mMovie),va khgicovpe o Tovia.
EmnmAéov vmdpyovv otr emroyéc va
glodyovple Vo eayoovpe ,va.
onuooctevcovue o touvio. AAAEG axoua
EMAOYEG EIVOL VO TUTAOGOVLE Lot GKNVI M
éva nbomord .Téhog pumopovue va dovuE
TIC TPOGPaTeS Tavieg kol T Awavoun
pohov  mov €yovue avoier .Télog
vrapyel n emioyn EXxit ywo va Pyodue
and TV Tavia.

Cuk

Copy
Paste

Paste Special
Clear

Select Al

Find

Preferences

Chrl4-
Chrl4-iC
Chrl+y

Dl

Chrl+-a

H devtepn emhoyn eivar 1o  Edit.Xto
pevov Edit eivar m emioyn 10 Vv
AVOLPEGOVUE pwoe  gvépysw oL
Kavope(undo) M va ETAVOQEEPOLUE Lol
gvépyewr mov kavape. Emiong éxer t1g
KAUOOWKEG  Asttovpyleg NG OTOKOTNG
(cut),mg  avtiypaeng(Copy) kot g
emkoOAMnong (paste). Emiong €yt v
Aertovpyia va ONUOVPYNGOVLE
katevBeiov éva avtiypago aviikelpévov
HE TNV EMAOYN Duplicate. Axopo
umopobpe v emié&ovpe ol TO
AVTIKEIIEVA TOL €pYoV pE TNV EMAOYY
select all’H vo avoipéoovpe pio emioyn.
(invert  selection).Metd  vmbpyer M
emoyn  (find) yia va Ppoope  évav
nBomo1d M va avaxarvyoovpue évo handler.
Metd €xel Tic emAOYEG Yo Vo KAVOuUE
avtikotdotoon nbomowwv (Exchange cast
member).
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Marker
Display
Zoorm
Cask

v v v

Guides and Grid 4

Sprite Owerlay r

Sprite Labels k
Onion Skin

Full Screen Chrl+alk+1
Standard Wiew  Crrl+Alk+0

H tpitn emioyn eivar to View .Amo 1o
pevod  view mpofdiiovpe  Olo T
epyareion  mov dSwbéter  to director
.Emiong pmopovue va peyeBbvooue 1 va
HIKPOVOLUE TNV EUPAVIOT TV
gpyaAeimv  TOV director. EmmAéov
UTOPOVUE VO EUOAVIGOLUE TAEYUOTO
otV oknvny pe v emioyn Guides and
Grid.Téhog av éxovv yobel amd 710
nepifdriov  tov director to Pookd
epyareior tov director pmopodue pe v
emloyn Standard View va sugoavicovue
10 OA0 TO TTEPIPAALOV TOV.

Media Element r
Conkral r
Fireworks r

H tétapt emiloyn and to pevol givar to
insert . A6 1o insert sewdyovue keyframe
1 apapovpe keyframe avtictoya
UTOPOVLLE VO KAVOVLLE TO 1010 KOl LLE TOL
Frame.EmmAéov pumopovpe vo €16ayovpe
Marker ka1 6Lo o Pacikd epyoleio mov
éyet to director.

Cask Member
Sprite
Frame

e . .

Movie

Arrange L4
TransForm »
Tweak, .. Chrl+Shift-Hk

H TIléumtm emioyn eivar to Modify
Tevikd v emroyn Modify v épovue
Y. vo. tpomomoloovpe .Mmopodue va
aAldEovpe 0 @oOvto g oknvig (Font)
mv mapdypago kewévov ( Paragraph)
.Emiong va khewdmdoovpe (Lock Sprite) 1
va  Eexkleldmdoovpe €va  OTIYUIOTLTO
(Unlock Sprite). AAAn emloyn eivar va
taSivopnoovpe(Sort)  toug  mBomorovg
tovg omoiovg €yovpe. Emiong va
neplotpéyovue(Transform) KGmolo
avtikeipevo . Téhog va mepioTpéyoupe
kamowo eikova (TransForm Bitmap) 7 va
tpomtomomocovpe o swovo (Convert to
Bitmap ).
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Play
w Stop
Rewind

Step Forward
Step Backward

v Loop Plavback

Yolume
Disable Scripts

Chrl+alk+

Chrl-+ale+Right
Chrl-+alk+Left

Chrl-Al+L

Remove all Breakpoints

Ignore Breakpoints

Recompile All Scripks

Alt+F9

Shift+Fg

H emopevn emhoyn eivan to control .Edd
Eyovpe TIG emAOYEG va maiEel M Touvia
(Play),va otapoamoet (Stop) kot va
Eavomai&el (Rewind). Emiong va
nnyaivel n tovio Prpo —prpo, Kopé-Kopé
umpootd (Step Forward) kot avtictotya
Ticw (Step Backward).EmutAéov
UTOPOVLE VO TOEKAPOVE TNV ETAOYN M
toawvioo vo Eavamailetar ovveymg (Loop
Playback).Axopa pmopov e vo.
pvOuicoope v évtaon Ttov Myov (
Volume). AAn pion Aettovpyio €xel va
Kavelr pe to breakpoints. Avta  eivon
GUYKEKPIEVA onueion Tov TOTE YyiveTOn
Kéver pwoe mwovon oty toavia. Ta
Breakpoint yropobue va to apoipécovue
N va to ayvoncovpe. Téhog umopovpe va
dwayelplotovpe To. SCript mov ypdopovue
pe t Lingo.Na ta tpé€ovpe Kot vo ta

BAémovpe Pripo Prypa.

Update Movies...

Conwverk WAl Eo SWA, .,

H endpevn emdoyn eivol ol emektdoelg
(Xtras) .AnAadn €1801K& TPoypaupoTo yio
TOV EAEYYO EEMTEPIKOV GLOKEVAOV 1OV
ko Bivteo. Emiong pmopovpe va kévoope
avaVEDGT TNG TALVIOG Kol LETATPOTT] TOV
apyeiov and WAV ce SWA.

w Toolbar
w Tool Paletke
w Properky Inspeckor

Scripk

Skage
Conkrol Pansl
Zask

Scare
Message

Faink

Weckor Shape
Texk

Field

CdickTime
Shockwawve 30
DY

RealMedia
windows Media
AN Video

Cibject Inspeckor
Library FPalette
Eehawvior Inspector
Text Inspeckbar
Mermory Inspeckor
Align...

Caolor Paletkes
Markers
Stark Fage

FPanel Seks
Showe Panels

Zkrl4-ShifE+aAlE+B
Chrl+7F
Chrl+alt+5

Crrl4-0
Chrl4-1
Zerl4-2
Chrl4-3
Zerl4-4
ZEr -1

Chrl+5
Chrl4-Shife-+4
Chrl+&

Crrl+S

Crrl43
CerlH-Shife+-w
ZkrlH-Shife+E
ZerlH-Shife+-
ZerlH-Shife+2

Ckrl4+-Shift+"

Chrl-alt+;
Cerl+T

Chrl-k

ChrlH-ale+7F
ZkrlH-Shife+-r1

F4

H endpevn emdoyn eivor window .Edd
govpe  OAo T mopdBuvpa OV
enpavilovton oto  director.Av 0élovpe
éva. mapdabvpo vo  gpeovioTel 61O
director 1o toekdpovpe kot av OELovpe
vo. unv  vmapyxer oto director to
Eetoekapovpe .Ta TTapdbvpa  Toolbar,
Tool Palette ,Property Inspector, Script
,Stage Control Panel, Cast, Score
,Message ,Paint, Vector Shape, Text,
Field, QuickTime, Shockwave 3D, DVD,
Real media, Windows Media, AVI
Video, Object Inspector, Library Palette,
Behavior Inspector, Text Inspector,
Memory Inspector, Align, color Palettes
,Markers, Start page, Panel sets .
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Director Help F1 Televtaio emAoynq ot ypoppy HEVOL
givaw 10 help.O ypnotng tov director
umopel va mapet forbeto amd to help ya
omoldNmote amopic 1 TPOPANUA TOL
Transfer Your Software License. ., OLV’ClpLS’E(DTEiCSL.

online Registration
Prinkt R.eqistration

Director Suppart Cenker

Abouk Direckar, ..

4. H 'v®ooa script Ilpoypappoticpod Lingo

H TAoooa script Tlpoypappotiopod  Lingo eivar cvuPaty pe to Director ywa va
ypapovpe script.To cOhvoro tov SCript dnpovpyovv por KAGon amd VITOPOVTIVEG
script mwov ovopdalovtor yewiotég (handlers ) . Ot yeprotéc kabopilovv 1
ouumepLpopd dniadn Tov Tpdmo dpdong evog NBOTO0D KATA TN JEPKELD TOV £PYOU.
Mo cupumepipopd omoteAeitan and To Ovopa g , T0 VPV (event) Kot TV EvEPyELL
(action) mov yivetat pHeTd 10 GLUPEV.

4.1 Script Panel

Mo va dnuovpynoete éva script, emiééte pia kevhy B€om oto cast panel ko miéote [
Ctrl+0 ].To script panel epgaviCetoar. To script panel gppaviletor eniong ond Tig
dpopeg ovvropevoelg Tov Director mov €xel. Onwg yior Topdaderypo amd Tn YPopLun

epyareimv TO Kovumi

i@ 3DTextl: Script = (=]
iw Script:Movie Script ¥ =

+ 4 b ’E o v Internal

[Linga = | | [Lgtaban - | [ L= lﬂ,‘ (73

i |83

4
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4.2 To cvupav (event)

‘Eva Zvppdav elvar katt 1o omoio ovpPaivel étav mailovpe v tovio pog HEGH 61O
Director.ITopokdtm ovaeépm To To10 oTUOVTIKA cupdvta

Mouse Down Etvor 10 ocopPav mov o6tav matnbei 1o
KOVUTL TOL TOVTIKLOV
Mouse Up Eivar to cupBdv mov 6tav onkwBel to

KOVUTL TOV TOVTIKLOV

Mouse Enter

Eivar 10 cvpuBdv mov otav £yovpe €icodo
TOV TOVTIKIOV GTNV TEPLOYT| TOL Sprite

Mouse Leave

Eivar 10 cvpdv mov o6tav €yovpe ££060¢
TOV TOVTIKIOV OTO TNV TEPLOYN TOL SPrite

Mouse Within Eivaw t0 ocvppdv mov oOtav 10 movtikt
Bpioketar givar oty TEPLoyN ToL Sprite
Key Up Eivar 10 copfav mov otav elevBepwbet
€va TANKTPO TOL TANKTPOAOYiOL
Key Down Eivar to cupfav mov 6tav matn0el éva

TANKTPO TOL TANKTPOAOYIOL

Prepare Frame

Eivar to copfav mpv n kepoAn umel oe
éva kapé

Enter Frame

Eivar to copfav 6tav n kepain pumet
ce €va Kapé

Exit Frame Eivar to copfav 6tav n kepain Pyel
and €vo Kopé
startMovie Eivar to copfav 6tav apyiler n tavia
stopMovie Eivat o oupfav dtav teletdvet ) touvio
beginSprite Eivaw o ovpfav 6tov Ppiokduacte oty
apyN TOL OTLYOTLTOV
endSprite Eivow o copfav 6tav Ppiokduacte 6to
TEAOG TOV OTLYOTLITOV
idle otav dev dnpovpyeitol GAlo event.
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4.3 Ot tomot tev Script

Yrdpyovv té€coepelg drapopetikoi Tomot script. H dtapopd petald tov tomwmv script
dev elvar oto MOG HOlAlovV 1 OTO TTAC GLUTEPIPEPOVTIAL, OAAL GTO TPOTO TOL
EVEPYOUV.

1)To script tawiog .Me 1o script toawviog Oev pmopovpe va avapepbovdue oe
OoLYKEKPIEVA sprites 1 mAaicla aALG o€ OAGKANPN TV Touvia.. Edv yio mapdderypo
10 script toviag mapdyel Eva NNTIKO oNHo 6To GUGTNU OTOTE YiveTol KAIK PE TO
TOVTiIKL, ovtd TO SCript Myel 1o MyMTkd onua Oémote yivetaw KAIK OTO TOVTIKL
OTOVONTOTE GTNV TOVIAL.

2) To script ovumeprpopdc. To script cuUTEPLPOPAC EAEYYEL TaL Sprites 1] TO TAQICLOL.
3)To cast script. To cast script angvBoveton oe £va péEAOC Tov cast. ‘Exel emntooeig
uévo oe éva pélog tov cast., 0AAG €xel emmtOoelg o KAOe sprite .OAa To scripts
KatoAapPavouy pia 0éon oto mapdbvpo Cast, ektOG omd TaL scripts péAn cast.

4)Ta scripts mAoisiov avatifevtar 6”7 €va GLYKEKPYEVO TANIGLO GTO SCOre Kol To.
YPNOUOTOOVE GLVIOM®S Yo VO dNUOVPYNGOVUE YEPIGTES OV VoL €lvarl dtabEaot
o’ 6A0 TO TAOIG10 1] Y10 VO EAEYXOVLE TNV KEPOAT] OVOTAPOYWYNS XOPIG VO amatteiTon
€1l0000¢ amd ToV ¥PNoTN.

4.4 Mnvoparo (Messages)

Otav Aappdver yopo éva cvuPdv, to Director amokpivetor ekdidovtog &va
uvopa pe to idto dvopa. ‘Eva uivopa dnpovpyeiton and to Director yia va mtel 6to
KOJOKO TG YA®ooag Lingo o1t éva yeyovog €xet cupPel. To ppvopo avtd taéidevet pe
™ ogpd, péow scripts avalntaovrog Evav yeproty| (handler) pe to 010 6vopa. Av 1o
Director oev pmopet va Bpet Evav yeptot) YU avtd TO VU0, OTOPPITTEL TO UNVULOL .

4.5 To IMapaBvpo Mnvovudtwv (The Message Window)

To mapdBvpo pnvopdrtov eivor o Bondodg poc. Xto mapddvpo TV UNvoudTOV
ekteleital apéomg o kKmokag ¢ Lingo oav vo NTov Koppdtt and to GeEVApPLo, TNG
towviog. Edd doxyalovpe Tic eviohéc va do0pE TG TPEXOVV £TCL MOTE VO TIG
ypnoonomcovpe oto SCript.Eniong amd to moapdbupo v Unvopdtov pmopovpe,
otav Tpéxel N tovio, va dSovpE A0 TO. CLUPAVTO, UNVOLOTO, JXEIPLOTES, EVIOALC,
KOl GUVOPTYOELC.

@ Untitled: Message = (3 [

i w Meszage =

e ]| L= @ & || 2

-
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4.6 Tlpoypaupatiopndc pe t  Lingo
4.6.1 MetafAntéc

Mua petaBAnt) sivat pia B€on pvAung otnv  omoilo anmoBnkeVouUE Kal
Slaxepldopaote ta 6edopéva pag .Oa ypnoiponomcovpe 0 topdbvpo unvoudTov
Yo VoL ONIOVPYNCOVE TOPadELYHOTaKLe Tov Ba divovpe Tipég oTig puetafAntés Kot

Ba Kavoupe Tpders.

@ Untitled: Message

i Meszage

= (e

Heed
=

e o) LEQER || 20

put ¥

| P

O K®OKGg aVTOG onuaivel 0TLo Yy maipvel v Tyun 7.

Emetta pe v put y tonoveton n Tiun tov .

bt

Ext6¢ amd to va avabécovpe T o o LETAPANT UTOPOVUE VO, KAVOLE
kot mpa&els. Ot mpaelg  mov yivovror givalr o moAlamiociacudg ,n dwaipeon,n
nmpocBeon ,n agopeon kol n dovoun.dlapakdto o dodue Eva mapdderypa mwov Ha

TOAAOTANGLOGOVLLE dVO PETOPANTEG.

@ Untitled: Message

iw Message

= [=E=]

=7
z=19
put =*z

O K®OIKOG 0V TOG oNpaivel OTL 0 X Taipvel TNV Ty 7.
Eneita o Z maipvel tnv tun 9. Tehog pe v Put TUTOVETOL O TOAAATANGLOGLOG

LEGER | = 2

.
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4.6.2 Tomor twv petafintov (Types)

OLtumoL Twv petofAntov eival :

aképatog apbpog(integer)

10, -1, 20, -35, -92 «.a.

évag mpaypatikdc apOudc(float)

-0.7,12.0, 3.14 x.a

Yelpd yoapaxtipov(string)

‘asdf’, ‘g’ x.a

Atota (list)

X=[2,4,6,8] x.a

Ynueio tng oxknvig (point)

Y=point(4,25) k.a

®a dobue mapadEypO

oG €6dyovue TIWEG o€ UETAPANTEC TV TOTWV

dedopévav mov avaeépape . EXTOg amd 10 = ™G EVIOAN KATAYDPNONG WTOPOVUE V.

YPNOUYLOTOUCOVLE Kot TI €VTOAEG Set ko put.

4.6.3 EvtoAéc (Commands)

@ Untitled: Message

iw Meszage

Linga - LT gv H'l-v ‘ﬂ_iv :}: ;_:J

Set ==7.3

Ot evtoAéc pog otvouv 1n dvvatdTNTO Vo KIVOUUOOTE UECOH GTNV Tovia

Bacwopévor otig evépyeteg tov ypnotn. Iopaxkdto avoeépo Tu Kdvel 11 KGOe Lo

EVTOM)

go to Mag myaivel o€ ovykekpipuévo frame

play [Mailetl to cvykekpipévo frame

pause YTopatdel Tnv Keeoin

Continue Soveyiler v KeQoAn

halt ZTOUATAEL TNV TOWVIO KOl LOG ETIOTPEPEL
oToV éAEyY0 ™G S10pBwoNC

Quit 2Topatdel TV Towvio Kol TEAEMVEL TO

Director
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4.6.4 Xvvaptoelg (Functions)

H Xvvapmon eivor pa avtoddvoun povado KOdke TpoypAUILOTOS TOV EXEL
oyedloohel Yo va extelel por ovykekpiuévn epyacio. Xto Director vdpyovv £totpeg
CUVOPTNOELG OALL £YOVUE KOl TN SLVOTOTNTO VO ONLLLOVPYHCOVUE GUVOPTNCELS Kot
eueic ot idwot .

Yto Director vdpyer TA00¢ ETOUOV GUVOPTAGEDY Ol OTOIEC EYOVV KATO10
okomo. ['a va yivelr kotavont) 1 £€tolun cvvdptnon Ba deim éva mapaderypa pe v
£towun ocvvdptnon ilk() mou pag emiotpedel tLTUMOUL Sedopévwy elvat pa petaBAnTh.

@Untitled: Message =N EoN| >

i w Mezzage i
Linga - LT %v .-'IL *;v :}I: =

zet ==7.3 i
put ilkix) =
==t v="timh"

put i1lkiw)

— #float
— #=tring

A |aial I

O k®dIKaG 0VTOG onpaivel 6Tt o X maipvel Ty Tun 7.3
H ovvapmon ilk() pog emotpépet 611 givon tomov float.
Enetra 0étovpe oty y “timh” xau ilk() pog emotpéeet 1t eivon Tomov string

EmumAéov Ba deiéw €éva axoun  mapddetypo pe v EToyun ouvdptnon
integerP().H cvvaptmon avti emotpéeet boolean, on. 0 (false) kot 1 (true).Av 6vtog
po petafAntn eivon axépaia tote 1.Av Opmg dev eivar tOte 0. AVTIGTOLY(ES ETOUUECG
Tét01EG EVIOAEG etvau np  stringP() ,listP() ko ) float P().

@ Untitled: Message = [= [
i w Message =
Linge | LEGER = 2

z=18 =
put integerpiz) =
put s=tringPl(=z)

i [ ¥

O KOOGS aVTOC oNUOiveL 0TL 0 Z Taipvel TNV Tiun 18
H integerP() yia tov zZ emotpépet true. Evod n stringP() yia tov Z emotpéper false
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[Mopaxdto 0étw Kamoleg AAAEG GNUOVTIKEG ETOUEG CLVOAPTNCELS:

the clickLoc EMOTPEPEL TO X KU T0 Y TOV
ocuvieTaypévov g 0éong g oknv1g,
OTOV NTOV TO TMOVTIKL OTOV KAVOUE TNV
terevTaio POPa KAMK

the clickOn EMOTPEPEL TO TeEAELTaio  Sprite mov
KOvopE KAIK

the key EMOTPEPEL  TOV  YOPOKTAPA Omd 1O

TEAELTOLO TAKTPO TOV TOTHONKE

the shiftDown

emotpépel true av to shift key éyxet
Tpdopato TatnOel

the mouseDown

emoTpEPel  true av 10 kovumi TOL
TOVTIKI0U TTaTnONnKe

random ( num)

EMOTPEPEL £vol TVYOLO0 aplOPd HETAED TOV
I xou tov oapBpov mov Ba ddoEL O
XPMOTNG

soundBusy ( channel )

emotpépel true av évag Myog maileton
eketvn ) otiyun

the doubleClick

emoTpéPel true av &yovv yiver 600 KAk
TOV TTOVTIKLOV

4.6.5 Evroiég EAéyyov (Control Statements)
Ol &vIOAég €AEYYOVL YPMNOLLOTOIOVVTIOL Y10 VO TEPOLUE OTOPAGES KOl VO
ekteEléoovpe pa oglpd and Aertovpyieg ¢ Lingo.Ot eviolég eléyyov eivor ot
YVOOTEG EVIOLEG 0md TG YAMooeg TpoypappatiopoV. H mpodtn yvoot gival ) amin

emoyn If —then- end if.

e

@3DTE}CH.: Message

ii v Message

| Lingao -

LEGER |3 2

—— Welcome to Director —— -

z=7

if =:5 then

put

"kalhnera"

end 1if

"lkalhmera"
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BAémovpe 611 av 1oyvel 1 cuvONKN(ONAadn o0 ¥>5) TvmOVETAL N

AéEN kalimera.

H debtepn doun emhoyng eivon ) ovvBetn doun emhoyng If — then- else-end if.®a
dovpue éva mapdoelypo (e avtn T doun .

r'

@ 3DTextl: Message = =] =]
iw Meszage =
e )| LERED |3 2
x=7 *
v=3

if =®=:v then
put "kalhmera"
el=ze

put "kalhnv=ta"
end if

— "kalhmera" |
—— "kalhny=ta"

BAémovpe Ot1 av toyxver n ovvOkN(dNAadn X>Y) TumOVETAL M

AéEN kalimera 6t

apopeTikd tvrovetal n AéEN kalhnyxta.

Ag dobpue Topa TV TEAELTON SOUN ETAOYNG, TN OOUN TOAAATANG ETAOYNG.
Edd €yovpe 600 ocvvtaées. H pia eivon if—then- else if- else if... - else -end

if. Mmnopovpue

va Parovpe o6oa else if avaroya

KATOOTAGELG-CVVONKEG EXOVUE.

He TO TMOGEG

-

Eut "zero" end if

@ 30Texdtl: Message = [=3 =]
¥ Meszzage =

Linga - L =E UL NE :}u-: =]
m=—7 -

if =:0 then

put "thetilo=s"
elze_if =<0 then
put "arnhtilos"
elze

i

— '"arnhtilko=s"

bt

210 Topomave Tapaderypo divovpe Evav aptBpd Kot TVTOVEL av eivon 0eTikdg
,OPVNTIKOG 1] UNOEV .
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H devtepn ohvragn g doung emAoyng etvar | evtoAn case. H case opwg oev
ypnopuonotgitatl téoo o6co if. H odvtaén g eivar

case (petafintn) of

Tunl: evroan 1
TN 2: EVIOAN 2

T N EVTOAN N

end case
@3DTE€E|.: Message = iE”_EE_i
iw Meszage = _5-:,
[nge  »|| L= ¥ & : }j ~
=3 E

caszs (=] of
1: put "ena"
Z: put "dyo"
3. put "tria"
end caze

210 Topomdve Tapaderypa ditvovpe tov  aptBpd 3 kot pog eppaviCet to

uvopa “tria”

4.6.6 EvtoAréc Emavainyng
Yto Director vrapyovv dvo evtoréc emavainync. H Repeat - With kot Repeat

— While. Mg tn Repeat — With yvwpiloupe tov aplBuo twv emavalfqPewy .

@ 3DTextl: Message = = |_£_|

iw Message

Lingeo - LT *T UL %v [ :}: ,?ﬂ :

—— Welcome to Director —— -
w=1000 |
repeat with i1=1 to 100 =
w=y+l

end repeat

270 TOPOTAVE® TOPAOELY O apyikomol® po petafAnt Yy pe 1000 éreita v avEdvem
KaTd Eva péExpt va tdcm oto 1100.
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Me v Repeat — While dev yvopilom tov apuod tov eravoinyemv. Ot emavorlnyelg
teppatiCouv 6tav doev 1oyvEL 1] CLVONKT .

]

@ 3DTextl: Message (o !ﬁ!'?!
% Message =
i ]| LE GQER || 2

— Welcome to Director — -

repeat while the mou=eDown
nothing
end repeat

——>» nothing

i [ F

Y10 Topandvm mapddetypo. 660 To ToVTIKL Eivan Tatnuévo oto Director vo unv yivetou
timoto.

5.Acknogc-projects

[Mopaxdtom Bo dnuovpynoovpe amAEg KPEG OOKNOELS Yoo TNV KOAOTEPN
katavonon tov Director. Ou aockfoglg viomolovvtar  PrAuo mpog Prua Kot
ovvodevovton pall pe eotoypoaeies. Ot aokNoelg eivarl €Tol EMAEYUEVES DOTE VO
YPNOUOTOGOVIE OGOV TO OLVOTOV TEPLGCOTEPA KOl OlopopeTIKa  tools-menu-
panels. Xtoyog eivar vo deiovpe TG, e TOOV TPOTO Kol LE OO AOYIKY| Vo TO
ypnoonomcovpe .I'evikd yio va dnpovpyncovue pia tovia tov Director, kdvoupe
T €ENG Téooepa Pacikd Prpata

Brual: ZvAiéyovpe ta otoyygio pécmv.

Bnua 2: TomoBetodpe ta otoyeion péowv ot oknvh kot ta Balovpe oe alinAovyio
oTO SCOre.

Brjua 3: TlpocBétovpe dSwwhoywodnta kot okpunt. H dwwdoywotro pmopel va
neptlopPdvel Kovumid 1 GAAL GTOlKElD TAONYNONG OV LETAPEPOVY TOV YPNOTY CE
drapopetikd puépn g Toviag tov Director.

Brjua 4: Zvokevdlovpe v Touvia og pio TpoPoAn Kot TNV SVERETE GTOVS TEMKOVG
YPNOTEG M Ypnoponotleite to Shockwave yio vo TPOETOAGETE o TOVioL TOL Ol
TEMKOL pNOTEG UITOPOVV Vo avamapdyovv o€ va drokopiotn Web.
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5.1 Anpovpyia pag véag touviog

Bruoza:

1)

2)

3)

emlé€te file>New—>Movie ywoo va ekkivioete pa véa tawvio(Windows
Ctrl+N). Av o Director cog potfioet av 0élete va anobnkevcete Tig oA OYES ,
Kévte KAk oo No.

Ewcayoyn pog ewodvag. O Director umopei va giodyst moAlodg tOmOVG
apyeiov my.BMP,GIF, JPEG, Photoshop ot GAleg pHOpQEC YPOPIKOV.
File=> Import(Windows Ctrl+R). Xto mopdabvpo dtoeddyov tov Import, avoi&re
tov emBountd edxkelo, emAéEte v ewkova ergasial.omp kot kiik oto Add.
Ortav kdavete khk oto Add, n ewdvo Bo eppaviotei otov mivaka Aotog
apyeiov (File List) Tov mapaBvpov Stardyov.

@ Import Files into “Internal” __EE_'
hizpetvnon o= || askhshi R < W R
ergasial
Ovoua engasial Import
e
Apxeio TL’lnou:|N| Files vJ | Arupo J
[ add || adda Remove Internst...
File List:
Move Up |
tove Down
Help
hedia; [ Standard Import - I

Kévte xhk oto Import. O Director gupoaviel to mapdabvpo dtoddyov Image
Options, mov dNAGVEL OTL TO YPAPIKO TOV EIGAYETE £xel dLAPOPETIKO Pdbog
YPOLOATOG Atd TO GVOTNUA 6TO 0Toio glodyeTol. O aplOUOg TOV YPOUATOV TOV
LITOPEL VoL ELLPAVIGEL Vo, GVOTNIA VTTOAOYIGTH Kohgitor Babog ypdpatog(color
depth). H 066vn 100 bTOA0YIGTH KOl O EIKOVEG TTOV EIGAYETE UITOPEL VOl £YOVV
dwapopetikd Padn ypopdtov. ---- Mo ewkova pe Pabog ypouatog 1-bit
epeavifetor poOvo oe pavpo Kot dompo, kot per 006vn pe Babog ypopotog 1-
bit eppoaviCer povo pavpdacmpeg ekoveg. Oco peyaddtepn eival n TN TOL
Babog ypoduaToc , 1060 pEYOALTEPOC givar 0 aplBpdg TOV YPOUATOV TOL
pumopovv va gpeaviotovv. Ta ocvvnbBéotepa PBadn ypoudtov speavifovv
ypodpoto ¢ €ENG: 2- bit eppaviCer 4 ypopata, 4- bit eppaviel 16 ypopoata, 8-
bit eppavilel 256 ypopata, 16- bit epeaviCer 32.768 ypopata kot 24- kot 32-
bit eppavifovv 16.7 exatoppdplo ypoduata. Me ypopota 32- bit, ta 8- bit
deopevovtal Yo dapavela 1 yio. TAnpoeopieg «aipay. IIpoemideypéva, 10
npotoétvno Pabog ypoduatog 24- bit tov ypoaeikod emAéyetor oe avTtd TO
napdBvupo d1aAdYoL
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4)
5)

Color Depth:  Image(24 bit) : Ba6oc ypodpatoc ypoapikov
Stage(24- bit): Babog ypduatoc cvothpatog

Av dgv aAldEete €va ypagikd 10 BABOC ¥pOUATOG TNG CKNVNG, OTOV TO
glodyete , 10Te pmopel va delte Aoynueg AGUWELS TOV YPOUOTOS, OTAV TO
YPoeko gppaviCetar ot oknvn. Ot Adpyelg copPaivouv emedn n pvduion
BaBovg ypopatog g oknvng(to Pabog  xpOUATOC CLOTHUOTOS OV
YPNOUOTOEITOL OTAV dNOVPYHONKE 1 TOvia) €YEL TPOTEPAOTNTA EVOVTL TOV
BaBovg ypdpatog tov péAovg Tov cast. Onwg avamapdystal 1 Tovia, To, LEAN
TOV CaStmov TEPLEYOVV TEPLGGOTEPES TANPOPOPIES YPOUATOG ad OGEC UTOpEL
VO EULQAVIGEL M OKNVN] TPOKOAOVV O1eVEEELS OTA YpOUOTA TTOV gnPavilovv
GTNV GKNVN.

Image Options for C\Users\elpida’\De...s\askhsh1\ergasial | 28

Color Depth: @) Image [24 bits) |L|
() Stage [24 bits) [
Cancel

Palette: Import [Image Has Mo Palette]
3 Bermap to Systern - %Wt

Image: [ Trim ‘white Space
[ Dither

[7] Same Settings for Femaining lmages Help |

Em\é€te Bdbog ypduatog oknvig 24- bit kot kA oto OK.
File>Save ovoudote to apyeio cag Acknonl.dir kot amobnkedote 10 61O
(PAKELO TNG OLASOG COG.

[Tape topa va IlpocBécovue £éva  eldwAo o1 oknvi. To &ldwAo eivar po
OVOTOPACTACT) EVOC LEAOVG TOL Cast.

6)

7)

Kdévte KAk oto mhaicto 1 610 KavAAL TAOGI®OV Y10 VO LETOPEPETE TV KEPOAN
avamopoymyng oto TAaicto 1.

Metapépete to péhog 1 tov cast 6to KévTpo NG oknviG. Xto Kovail 1 tov
score, 1o €idwAo moapiotator pe pia oklaopuévn urndpa. To eidwio eppavileton
a6 to mhaico 1 emg o mAaicio 28.

I |2 ergasial T

YHMEIQXH: View->Sprite Toolbar yio v epgdvion g ypapung
epyoreiov ewdoiwv. H pikpn kovkkidoa oto mhaicto 1 tov score dnAdvel 1o

TAOUG10 apyNG KO 1) LUKPY] UTAPO GTO TEAEVTOLO TAAIGIO TOVL E0MAOL &lvar N
EvoelEn miaiciov téAovg. Mmopeite va PETOQEPETE OVTEC TIC EVOEIEELS Yo va
Kévete éva €ldmA0 va eppoviletor og AyoTepa 1 G€ TEPIGGOTEPO TAAICLA.

[Tape Tdpa va dnpovpyncovpe péAn kepévov tov Cast
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8) Window—>Text (Windows Ctrl+6) oto mapdbvpo Text 6o dnuiovpyncete
Kelpevo yuoo v mopovsioon. Mropeite va emAéEete YPOUUOTOGEPE, GTUA,
Léyehog, S1AoTLYO KOl TOUKVMGT/ 0POLimOT] YOPOKTHP®V Y10 TO KEIUEVO.

9) Emié&te I'pappatooeipd: Verdana, Bold, 36 otiyuéc

10) Ewcayete 10 xeipevo «Class of Multimedia» to keipevo yivetor ovtdpato
uéAog Tov cast.

+ ¢« » O]
Wardana = B | U = - | 1 in ‘*;

.4...|...5...

L R T

class of Multimedia

‘Eneita emAé€te 10 keipevo oto mapabupo Text ko Edit—>Copy Text.

Kévte khk oto Cast New Member yia va dnpiovpynoste évo véo péLOG Kot
Edit->Paste Text. EmovaAdfete tv owdikacio GAAN o @opd. Aniadn
éyovue 3 Cast Member pe to keipevo.

[Tapatnpnote 011 610 TapaBvpo Cast epeavilel TAnpopopieg Yo kébe pELOC
tov. Ta puéAn tov cast mov poAg omuovpynocote AEN éyxovv ovopota, ov kot
umopeite va mpocBicete ovopaTa GE AVTA.

11) File-> Save ¢ epyacioc.
Topa Ba kGdvovpe adhayn ypodpatog perdv tov Cast

12) EméEte to keipevo oto text mapdbupo yia 1o pérog 4 tov cast

13) Window->Tool Palette. Xpnowuonoteiote to «epyoreio pmpootd ypduatog »
Yo VoL avOBECETE EVaL YPOUA OTO KEIUEVO
Y10 mapdbvpo text kavte kiik oto Bélog Previous Cast Member yw vo

dMGETE SOPOPETIKA YpmdUaTa Kot ot Ao péAn Tov cast Béom 2 ko 3. Agite
To. HéEAN oto mapdbvpo cast kol mapatnpnote OTL TO Keipevo eivor akoun
uavpo. O Director gpeoviCel Tnv piviatovpa KEWWEVOD € Lodpo, £T01 HOTE VL
umopeite va to dwofalete oto dompo pdvto oto mapdbupo cast. Otav to péEAN
EUQOVIGTOVV OTN OKNVN, TOTE T YPOUATO TOV EMAEEATE ol ELPAVIGTOVV.

nternal
#:2 | « » ||O]

: clazs of
& || class of clazs of Fultime
3| Mubim A Molim & A
] i 3 [l

14) K eiote 10 mopabvpo Text.
Ta endpeva Prpata eivar va tpocBécovpe eidmwAia 6To Score
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15) Metagépate to pélog 2 tov cast oto mAaicto 1 kavdAl 2 Tov Score ,mpocoyn
oyt ot oxnvn. H petagpopd tov pedmv tov cast oto score ivor £vog dALog
TPOTOG Y10 VO ONULOVPYNGETE EIOWAQL.

16) Metagpépate 10 pélog 3 tov cast oto mhaicto 1 kavail 3 kat to péhog 4 610

miaicto 1 kovéd 4 tov score.
Mmnopeite va deite povo éva amd To €I00A0 GTN GKNVY, OV Kol TPOcOEcaTe
tpia eidmwAia oty touvia. O Director gpeavilel Tavta ta idmAn TOV KOVIAIDOV
HE VYNAOVG aplOpovg UmPooTd omd auTE TOV KOVOAM®V HE YOUNAOLG
ap1Opovs, 6tav aAANAOKOADTTOVTOL LETAED TOVG ETAV® 0T oknvh. Ta eldwAa
eupavifovion kevipapiopéva ot oknvh, emeldn o Director kevipdapet
avtoOpaTo To EIdMAN OTOV PETOPEPETE PLEAN TOV Cast GTo SCore.

Téhog odote Vv epyocia File—>Save v epyacia cog.

_B Aownonl: Score, Cast

¥ Score
ergasial
2

0
lember -
3

o4

== ) R o [ o |

Endpevn kivnon etvan va kdvoope oAlayég o€ TOAOTAAL El0mAN

17) Toatdrte minktpo Shift kou kévte KAk avdpeoa oto TAAIGLO 0pYNG Kot TEAOVG
TOV E0MA0L oTa, KavoAto 4, 3 kot 2
Kot ta tpia eldwAia keypwévov emiéyovion oto score. Topa pmopeite va to

petakivnoete 6aa pali oe po véa B€om ot oknvi my. KEVTPO.

Y10 gndpevo Prua, Bo Kotopynoete to AoTPo POVTO YOp® omd TO KEIPEVO
YPNOUOTOIOVTOS £QE PEAAVNG. Ta epé peAdvnNG TPOTOTOOHV TNV EUPAVION
eVOg EI0MAOL GTN OKMNVY|, EMNPEALOVTOG TOV TPOTO OV eRPavICeTol TO l0®AO
ENAVO o6TO AVTIKEIPEVA 1 6TO POVTO OV €ival oo Mo TOVv. AV EQUPUOGETE
éva e@€ nerdvng oe eidwla, dev emnpealoviot Ta ot To PEAN Tov cast, aAAd
LOVO M EUPAVICT] TOV ELOMAOV.

18) Ag&la oto mapdBvpo Tov Director, ot ypapun epyoreiov e0OA®V, avoi&te T0
pevov Ink kou emAéEte Background Transparent.

W tegot

Ink. l Tran=parent - |

-

Metd Ba aALaEovpe TV aAAniovyio eIV

19) Em\éEte 10 €idmA0o 610 Kavait 2 Kot peTAPEPETE TV £VOEIEN TAOLGI0V TEAOVG
oto mhaicto 10.
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20) EmiéEte 10 €100A0 670 KavaAl 3 Kot peTaPEPETE TNV EVOELEN TAOIGIOL TEAOVG
010 mAaicto 20. Enetta kdvte KAMK ovALESH 0T TAAICIO apYNS Kot TEAOLG Kol
HeTaPépeTe TO €idMA0 6T0 KOvaAl 3 mpog T de€id Yoo va TomobeTioeTe 10
mAoic1o apyng oto mAaicto 11.

21) EmiéEte 10 €id®A0 0T0 KOVAAL 4 ,KAMK OVOUESO OTO TAAIGLO. OPYNG KoL TEAOVG
KOl UETAPEPETE TO €0MAO TPOG T Ol Yoo vo. Tomofethoete 10 TAAIGLO
apyns oto miaiocto 21.

_B Aoknonl: Score, Cast

¥ Score

L=
lember -

'y ergasial {]
i—
o3——
o4———]

22) Xvveyilovpe vo Balovue pe tov id10 Tpdémo ta eidwAia oto Kavaio 2 , 3 kot 4
eVoALGE ava 10 péypt to mhaicto 90.
23) Zvpete 10 Kavai 1 péxpt to mhaicio 90

E‘

-

ergazial

i—— oz———1 og———1
O3———1 03— 03—

o4—— os——1 o4—

24) KMk oto mhaiocto 1 010 kavaAl TAGIGI®V Y10 VO LETOKIVIOETE TNV KEPOAN
AVaTOPUY®YNG 6To TAaicto 1.
25) File > Save v epyaocia cagc.

A@ov ohoKANpOCapE TO £PYO HOG TOPO B KAVOLpE avamopay®YN TG Toviag

26) KAk ot ypopun Tithov TG OKNVAG Y10 VA TN LETAPEPETE GE TPMTO TAAVO

27) KMk oto Loop Playback tov Control Panel yw vo avomapdyst v
TOPOVGIOCT) GLVEYMG.

28) Kk oto Play yia va dovpe v tawvio.

5.2 Kwobpueveg AMoteg e KOUKKIOEG

O Director cag emtpémel vo SNUIOVPYAGETE KIVIOELS UE TOAAOVG TPOTOVG,
aAAG €vag amd TOvG amAobOTEPOLG €ivar pe TN xpnon miociov kiediov(key
frames). T va ypnoponotoete éva TAaiclo KAEWL emAéyete va TAQIGLO péCa
o€ éva e10mAo, 6mov BéLeTE va gppaviotel To £idmA0 dapopeTikd og péyeboc N o€
B0éon 1M kotd kdmowo dGAAo tpémo. ‘Emeita ypnowwomoleite TV €VTOAN
Insert-> Keyframe kot kévete v aAlayn oto €idmio, Omwe Oa supaviotel oty
OKNVY| LEGA GE AVTO TO TANIG10 KAELOL.
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"Evog amAdg tpomog yio va ogigete kivnon ivan va kabopicete pa BEon apymg
Kot po. B€omn téhovg Yo éva €idmwAo kot vo apnoete tov Director vo gpovticet yia
NV EVOLIUEDT Kivnor. AvTO TO EMTLYYAVETE EIGAYOVTOG £Va TANICIO KAEWL GTO
eldwAo Kol petaKvovtag To €idmAo otn véa Béor. H véa Béom mov emiéyete Oa

etvar 1 Béon ot oknvn 6mov BéAeTe TO €ldAO Vo epPavVioTel 6TO TANIGIO TTOV
INAovete cov TAAIG10 KAEWSI.

1) File=>Open myv gpyacio Acknonl.dir
Meyoddvoope 10 €idwAo Y 1O YpaPKO @GOVIOL £TCL OOTE Vo
OVOTOPAYETOL GE OAN TNV OpKEDL TNG TOviaG, OmOTE ONAMOTE GTNV
évoeldn mhaicto téhovg v Tun 90. Opoiwg kot M aAiniovyio Twv
EOAOV oL aAAGloVV YpdUO VO EmAVOAAUPAVETOL HEXPL TO TEAOG TNG
taviog. Avtd 10N To éxovpe viomomoetl oty Acknonl.dir.
2) File>save as Aoknon?2.dir
-
ngasim — - 1
o3———1 oz——— 03—
O4———] O4————1 04—

Topa 6o [Iposbécovpe véa péln oto Cast

3)

4)

5)

6)

7)

Window—->Text kot giodyete 1o keipevo “Macromedia Director”. "Enetta
LLOPPOTTOOTE TO KeineVo pe ypouuatooelpd Verdana, otod 'Evtovo kot 24
oTyHéG pEYEBOg YPaUUOTOGEIPAS. ADCTE KOl YPMUN GTO KEIUEVO

Kl oty évdeién New Cast Member yia va dnpovpynoete éva véo péAog
Kot gl0ayete to keipevo “Audacity” Kavte Tig id1e¢ LOpPOTOGEIS OT®G
Kol 670 Prjna 3.

Anpovpynote évo akoun pérog kepévov to «Corel Drawy pe tig id1eg
LOPPOTOIGELS TOV Prinatog 3.

Kleiote 10 mapdbvpo Text. To Cast mpénet va €xet entd péin. Ta va
pvOuicovpe TOoV apOuo TV LVI0TOV POV TOV cast
Edit->Preferences>Cast kot emiéEte Tov aplBpd T@V HvVAToOpmV OV
Bélete va. BAénete ava ypoupun. 'Ensrta File—>Save

R B RS ]
clazs of b acron Audacit Corel
n. clazs af clazs of Fulime Directa Diraw
el | ST N | ST e A A A A
engasiat 2 3 4 i} 3] T

I |

Topa Oa ypnoonomoovue 1o mapdbvpo Paint

Window—>Paint kAik ot10 gpyoleio UTPOOTA YPOUATOC GTO EPYAAELD
dwfaduiong ypoudtov Kot emAEETE YpOUO HE OVTO TOL OMCATE GTO
Kelpevo g kovkkidac. Avtd Ba glval 1o apyikd ypOUO TOL HElYHOTOg
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YPOUATOV OV Bo dNUIOVPYNCETE He aVTO TO gpyaAeio. Oa emiéEete Kot
&va YpOUO. TPOOPIGHOV TTOV Ba ¥pNOIUOTONGEL TO epyaieio dtafdOuiong
YPOUATOV Gov TEMKO ypdpo pelypatog mov Ba dnpiovpynoetl péca o va
OVTIKEILEVO.

8) Kk oto gpyadeio telkov ypodpatoc dtofadpong kot emAEETE Eva xpdpa
GOV YPOUO TPOOPIGHOV.

9) Kk oto gpyareio IN'epuopévng EXeyng

10) KMk otov emdoyéa ueravng kou emdééte Gradient. Moig avobicate
peddvn owpaduiong oto epyareio 'gpuopévng Edhenyng mov emAélare.
Y10 emdpevo Pruo Bo emiéfete éva potifo dwPdbuionc mov Oa
ypnoonomacet o director yio va avapi&etl ta ypdpoto

Gradient Settings [ 28 |

Type: @) Dither
(1 Pattern |—Eancel

I ethod: [Best Colors "I
Destination RS Direction: [Sun Burst "l
L L. Cycles: [Elne "I
Foreground ...s
Background... J BRreack IE':'“E'I 'I
Pattern ... | Range: IF'aint Object "I [ Help

11) Kk oto pevov Gradient Colors......... Ko emAé&te Sun Burst. O emhoyéog
tov pevov Gradient Colors givorl n pkpn meployn avdpeoa ota epyolieio
apywov kKot TeEAMKOVD ypopatog owpabuong. To potifo Sun Burst
avopyvoeL o xpopota oPddpiong amd 1o KEVIPO €VOG OVTIKELLEVOV
npog ta €. To ypdUO 6TO KEVIPO TOV OVTIKEWEVOL Ba ivar To TEAMKO
YPOUA Kot 610 eEMTEPIKO HEPOC Ba eppaviletal 1o apyKd YPpOUL NG
dwpddong.

12) Me emileypévo axoun to epyoreio T'epuopévme EAlewyng, motdte 1o
mktpo Shift kot petaEEpeté 10 Yo va SNUIOVPYNOETE £va. GO LIKPOD
KOKAOV 670 Tapabvpo Paint.Kiegiote to mapdbopo paint.

YHMEIQYXH: T va «xotopynoete éva  avtikeipevo oto  Paint,
ypnopomomote 10 gpyareio g Moapkilag omd ™ ypouun epyoreimv tov
napafdpov Paint énerta Delete.Mnopeite eniong vo kdvete dumhd KAMK 6TO
epyoreio I'opa.

Topa Ba Tomobetoovpe €ldwAa oto SCOre.Qa peTaPépeTe TPMTO GTO SCOre
To WEAN Tov  cast yio va dnpovpynoete I0MAN Yol TIG KOUKKIOES KOt Yol TO
keipevo. Tlpwv va apyioete, aAldEte v mpoPoin Tov SCOre €161 OCTE Vo
umopeite va dgite mePlocOTEPA TANIGLOL.

13) 1o score KAk 6to pevod Zoop ko emiié€te 50%
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To mapdBvpo Zovp arréler wote va gppaviCer péxpt 100 miaiocw Tov
score. Ot emAoyég 6T0 PEVOD GOG MTPETOVY Vo eAEYEeTe TG TPOPAAETE
to score. EméEre emhoyéc opikpovong(12%,25%,50% ko 75%) o va
delte meplocodtepa mhaicwa. Emiééte peyebivoeig (200%,400%,800% ko
1600%) ywo va mpoPdiete Ayotepa miaiota. Ot emdoyég Narrower ko
Wider cog emtpémovv va oAAGEETE TO TAATOG TOV KEMMOV GTNV TPOBoAn
Covp oL emMALYETE.

14) Metagpépete 10 péLOg KOoLKKida Tov cast oto kavaAl 5, miaicio 31 tov
score. Metagépete T0 péLOG Koukkida tov cast 6to kavaAl 7 , miaicto 31
KOl 670 KovéM 9, mAoicto 31.

15) Metagpépete ta uéAn 5,6 ko 7 tov cast ota kovdAiia 6,8 kot 10 amo
miaicto 31 Tov score.

Topa Oa kdvovpe S1dtaén WOOA®V GTN OKNVN

16) Metagpépete 10 emdeyuévo €idwlo (otnv 006vn) otV Kat® TEPLOYN NG
oKNVNS, 6oL BéAeTe va gppaviotel n Tpitn ypapun keyévoo

17)Kévte KAk oto €ldwAo KOLKKIOOC ©GTO HECO TNG OKNVAG Y. VO TO
EMAEEETE KoL META UETAPEPETE TO OiMAO O0TO €I0MAO0 KEWWEVOL TOL
LETOPEPATE.

YHMEIQXH: Ot meproyés oTig YmVieg Kol 01 TEPLOYEG GTO KEVIPO €ival
yio oAAoyn tov peyéBovg Tov €WOM®AOL Kol Oyl Yoo petopopd. Me
Edit->Undo Score avaipeite 10 6Qaipo cog.

18) Metagépete kabévo amd To VITOAOUT EIdMAN Kal TOTOOETHOTE TAL MOTE VaL
ONUIOVPYNGETE UI0L OLOKANPOUEVT] AMOTO e KOVKKIOEC.

19) EmAé€te Oha ta €idwAa yoo Tt Aloto pe Kovkkideg oto SCOre kot
epapuoote epé peadvne(Background Transparent) ywo to dompo @ovro.
[Téape Tdpa vo kdvovpe otoiyion eW®A®V pe Tov Tivaka Align

20) Xt oknvi kdvte KMk o€ évo amd To €idmlo kKovkkidac. Emerta pe
natuévo to mAnktpo Shift kévte KAk 610 Kabévo amd ta GAAa eidmAa
KOVKKIOOG Kot EMAEETE TOL.

21) Kato de&1a emaéére Align horizontal center

Align

Align:

= & &

P 8 b §

Di=tribute:

Bb 9% od §9 #8 5o

- 3 L 0 =
= = = = =

[Tape Topa va Ovopdoovpe ta MéAn tov cast

22) Xto mapdBupo cast kdvte KAk 610 péELOG 8 yia va To emAEEETE.

23) 210 medio OVOHOTOG OTNV KOPLON Tov mopadvpov cast, TANKTpoAOyHoTE
Bullet xon matiote Enter yia va deytei to 6voua
Ytov Director o1 minpo@opieg mov eaivovtal 6To €idmA0 gival pio eTkETa

ewdlov. Ov etikéteg eppavitovionr péoco oto €idmio 61O SCOre Kot
neptlopPdvouy 1o dvopa Kot Tov opBud pérovg tov cast, to epé peddvng
N 11¢ ovvtetaypéveg X ko ¥ g 0éomng tov l0DA0L 6T GKNV.
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Mmnopeite va emAéEete 10 €100C TOV TANPOPOPIDOV TOV TEPLEYOVIOL CE
ETIKETEG  €10OA®V  ypnowomowdvtag v  evtoAr] View—>Display 1
eMALYOVTOG pio. ETAOYH and To avadvouevo pevov Display oto score. H
emloyn Member givor emleypévn mpoemdeypéva Kot mepAapuPavel Tig
TANPOQOpiec mov PAémeTe oTa EIdMAQ.

[Tape todpa va ddcovpe Kivnon Kepévov pe yprion Miociov Kiediov

24) Emééte ta eidmAa oTo Kavaio 5 kot 6 Kol dMOTE TR Yo TAQIGLO

téhovg v Tiun 90.

Topa BELeTE TN YPOUUN KEWEVOL VO LETOKIVEITAL ETAVD GTNV GKNVY ot
de&1d mpog ta. aplotepd. O amAoVoTEPOG TPOTOG Y10 VO KAVETE EVa E10MA0
va petokveiton omd pa Béon oe g GAAN elvarl péow puag peBodov mov
kaieitonw Tweening. O 6pog owtdg gival évog mapadootakods Opog amd
dnuovpyio Kivovuévev oyedimv, kot avapépetol o o uéhodo kotd tnv
omoio. 0 €KOVOYPAPOS oyedtdlel Ta mAaicl Omov yivovtor ot Pactkég
aAloyéG Ko PETA o 1010¢ i ot PonBoi tov oyedtdlovv OAa Ta EVILALESH
TAaicoL.

Mo va oyedidoete v kivinon pe awtd Tov TPOTO Yyl T YPOUUTY KEWWEVOD,
TPEMEL VO OPIGETE TOL TAOIGI0L GTO SCOIE OV AVTIGTOLOVV OTIC BEaELg OV
Béhete va petaxkivnOel to €idmAo mpog Kot amd. Avtd ta mhaicla eivon ta
mAoicto KAEW1d oty Kivnon

"Eva mlaicto kAe1di eivon £va mAaicto oto omoio eppaviletal éva eidwio o€

pa véa Béomn 1 pe dtapopetikd péyebog 1 aAlace katd Kamolo GAAO TPOTO
péosa o 6Lo to €idmA0 OV PAEmETE GTO SCOre.

25) 210 kavaA 6 kévte KAk 610 TAaiclo apyng Tov ewdmAov. [Ipoemdeypéva

T0 TAAIG10 aPYNS EVOG EWODAOL glvar £va TAOIG10 KAELOL.

26) Xt oknvi matdte 1o mAnktpo Shift ko petoeépete 10 €idwio oe pia

evBOYpapuun dwdpoun oty 0e€ld mhevpd g 086vNng. Me to Pripa awtd
Bécate v Béom apyng Tov keévou g £va TAaicto KAEWT g kivnong(to
miaiclo apyng). Topa mpémel va kabopicete éva mhaicto kAWl kot va
TomofeToETE TO KEIUEVO €KEL TOL TPEMEL VO EUPOVIOTEL, OimAo oTnV
KOVKKi{d0 6T0 TEAOG NG Kivnong.

27) Khik oto mhaicto 40 oto kavdai 6 ko Insert->Keyframe ondte 1 kivion

yivetoar ota mAaicloa 31 €oc 40.Metd amd 10 40 M ypapp KeWEVOL
napopével oty Béon e.

A@ob ewodyete éva mloiolo kAewdi o Director tomoBetei pia évoeiEn
TAoGiov KAEW100 610 ldmAO.

To mhaiclo kA&l cag OnAmdvel amhdg po aAdayr oe 0éon yio to id10
€l0wA0, omdTE 01 OO0 ETIKETEG E0MAOV OV PAEMETE GTO KAVAAL 6 elvar
TOLVOLLOLOTLTIEG.

2—] oz— oz—1
03— 03— o3 ——1
O4—] O4—] O4—]
& Bullet I
oF ol 7l

28) Xt oxnv motdte to TAKkTpo Shift ko petapépete 1o €idmAo KeWWEVOL

otV TEMKT ToL B0m dimAa oIV KOLKKIdO.
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29) ZEavartvAi&te v Tovia kavovtag KAk oto Rewind ko Play.
YHMEIQXH: yio vo mpoPdAete ota ypryopa £va TUNUO MG TOLVIOG,
UTTOPEITE VO LETAPEPETE TNV KEPAAT OVOTAPOYWYNS GTO KOVOIAL TAIGI®V
TPOG TO. EUTPOG Kol TPOG Ta TiG®. Avtd Kokeitan scrubbing kot cag Bonod
Vo OELTE OTO YPIYOPO. TO OTOTEAECUOTO TOV ALYV GE Lol ToviaL.

30) Khik oto STOP.

31) Xto score emréEte o €l0®AN GTO KOVAALDL 7 Kot 8 Ko LETAPEPETE TaL ETGL
®oTe To TAOioI apyG TOVG va Elval 6To TAaic1o 45.

32) Xt ypapuun epyoreiov e0dAmv 0éote 90 cav mAaiclo TéAovg Kot Yo Ta
V0 GET ELODOADV

33) Kdvre khik 610 TAaiclo apyng(mtiaicto 45) yio 1o €id®A0 6T0 Kavait 8

34) Xt oknvi matdte 1o mAnktpo Shift ko petoeépete 10 €idwio oe pia
evOvYpappn dradpopn) mpog TNV de&ld TAEVPA TG GKNVIG.

35)Xto score kavie KAIK o©T0 &€idwAo o©T10 mAaiclo 55, kavai 8 kot
insert->keyframe

36) Xt oknvn matate Shift ko petagépete 1o €idwAo oty TEMKN TOL B0
dimha otV devTEPT KOVKKIDA.

37) EmAééte ta gidwlo ota kavaiio 9 kot 10 Ko petapépeté ta HOTE T
miaiota apyng va givatl oto mhaicto 60

38) Xt ypauun epyolreiov eldminv 0éote 90 cav TAAIG10 TEAOVG

39) KMk 6710 TAIG10 0pYNG TOL E10OAOV 6TO Kavaitl 10

40) 2 oxnvi matdte Shift xor petoeépete 10 €idwAo o por evBOHYpapun
dradpopn mpog ™ de€1d TAeLPE TG GKNVAG

41) ¥1o score gloayete £va mhaiclo kAeWdi oto mhaicto 70 kavail 10

hd |

ergasial |
a— oe——11 oe——11
03— 03— 03—
o4——— o4——— o4———
Q1 Bullet
OF el

< Bullet
o2} B

ClEuliet
a7 7

e R A e Y e B e

42) ¥ oxknvn matdte Shift ko petagépete 10 €idwio oty TeEMKN T0VL B0,
dimha otV TEAEVTOLO KOVKKIOO
43) Anobnkevaote, kavte Rewind v tawvia cog kot Play.

5.3 Anpovpyia evog pikpov eiip — 0épo Hpweg tov Disney

YV gpyacio avt To TPDOTO OV ol Kdvovpe givar vo KabBopicovpe To xpmLo
™G OKNVNG Kol To puOud ¢ Taviac. Epappoyn evog xp®dUatog 6Ttny GKNvi yuo. va
ONUOVPYNGETE Eval POVTO YloL TNV Tovior kKot kabopiopd Tov pvOpov g toviog oe
TAOLG10 VA OEVTEPOAETTO.

O pvOudg eivor n toydTNTO PE TNV OTOloL KIVEITOL 1) KEPOAT OVOTOPAYWOYNG
amd TAaicl0 o TAQIGL0 Kol M TtayvTnTo pe v omoio. o director ovamopdyst TIC
KIWNGELS OTIC TOVIES GOC.

Oa avalnmoete oto Google Ewdveg 8 ewdveg amd Tic omoieg M pio O givan
Aoyotumo, pe 0épo Hpweg tov Disney.
1. File>New->Movie ka1 Save As Acknon 3.dir
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2. Modify->Movie—>properties yio kabopicete emhoyéc omwg to péyebog g
GKNVNG KOl TO YPOUO TNG KOL TO YPOO Y0 TNV TOVIK TOL €Vl OVOIKTH 0T
™V oTiyun. Oélete va aAAAEETE TO YPAOUA TNG OKNVNG DOOTE 1| TALVIK GOG Vo
dlakpivetol KaATEPO ETAV® GTO POVTO.

XYMBOYAH: civatr koA 10600 vo €XETE TNV OKNVI] GOG KEVIPOPIOUEVN OTIG
tovieg tov Director. Olot ot yproteg mov TPoPRAarovy Tig Tavieg cag Oo pmopovv
£tol va PAETovV TV dpdiom kevipapiopévn oTig 000veg Tovg, aveEdptnta amd To
uéyebog twv obovav tovg. Av Kabopicete o BEomn oKNVAg MOV UETOPEPEL TN
oKNV o€ (o yovio e 000vng oag, UTopel vo, omoKOWEL LEPOG TNG TOWVIOG OE
kpotepeg 000ves. Av n emhoyn Stage Location dev £yet tebei on oe Centered,
TOTE YPNOYLOTOMGTE TO AVATTUGCOUEVO LEVOD Y10, VO TNV OAAAEETE.

3. K\ oto gpyaleio Stage color kot emAEETE pLopo YpOUA IO TV TOAETA.

MMawie

Stage Size: | 320 % | 240 -

Channels: | 160
Color: | #000000 ﬂ

Falethe: | Systern - Win b

@ RGE () Indes

[ Enable Edit Shartauts

Topa 0o Bécete puOud Yoo v Tovia cag. O pvOUdc ™ Touvia petpdrol o€
mhaiolo ava devteporento ) fps(frames per second).

O pvOuodS pag Touviag tiBeton oto KavéAl puOuon Tov score.

4.o610 score KAk oto Hide/Show Effects Channels ywo va gpgavicete to kavaiia
}

EQE. q ‘

‘Enerta 610 kavéAl puBpod kdvie SmAd KAK 610 mhaicto 1 yuo va epgoavicete to
nmopdOvpo dtokdyov Tempo.

5.010 Topabvpo dtaddyov Tempo emhéEte Tempo kot 60fps kot khik oto OK. To
TPAOTO TAAIG10 TOL KavaALoD TovileTon Yia va dei&el 0Tt Exete B€oetl Eva pvOud y
mv towvia. H tawvia 6o avaropdyetor pe 60fps péypt o Director vo cuvaviioet
i véa pobpen pubpod oto kavai.

Frame Properties: Tempo

@ Tempo: ]'[:| | [21*] B0 fps | oK |
) wait: 1] | [2]e secands | Cancel |
Wait for Mouse Click or Key Press
Wit for Cue Paint:

Channel | { Mo Cue Paints | Cue Paint: | { Mo Cus Paints | Help

6.1k oto Rewind ko Play ywo va mpoPdiete 10 amotéleoua g pl’)@fucmg
pvOuov. Eneidn eivar apketd ypriyopo 0éote éva pukpotepo pubuod my. 10 fps.
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Topa Ba kGvovue eloaymyn otoyeiov péca oto Cast.O Director siodyst moAlovg
TOTOVG apyeimv. Mropeite va dgite TOVE TOTOVG OTOV OVOTYETE TO LEVOD KATM AtO
v emtoyn List Files of Type. Ot tomot apysiov PICT ka1 Bitmap Image oe
aVTEG TIC MOTEG TOPLETOVV EIKOVEC TOV UTOPEITE VO EIGAYETE Y1 TIG TOVIEG OAG.
O1 0101 apyelV TOL GOG EMTPEMOVV VO, EIGAYETE TOAAATALS EIKOVES TAVTOYPOVO,
avaeépovtor oav FLC xar FLI yio Windows kot PICS kouw Scrabook yuo
Macintosh.

7. Elodyete T1¢ 8 e1kdveg oto cast pue tnv evtoAn import

8.umopeite av BéAete va avadiotdéete ta pén tov cast oto mapdabvpo Cast yio va
ta tonofetfioete ekel mov Oéhete. AmAG emAéyete 10 HEAOG , TO GUPETE KOl TO

tonofeteite ekel mov Oéhete. Me 1o mAfkTpo Shift pmopeite vo emdé€ete moAAG
wéAn pali, evod pe to TAnktpo Ctrl emdéyete pepovopéva.

9.File>Save As Epyacia 3.dir 6to ¢pakelo cog
Ta endpeva Prpata stvor va kdvoope ypnorn Eeé Meldvng kot kKivnon ewovag

10.emAélte 10 pérog 1 tov Cast ko petapépeté 10 oto Kavaal 1 miaicto 2 tov
score. Emetdn peta@épate 1o ypoapikd 6to SCore, 1 wova peavifeTol 6To KEVTIPO
¢ oknvie. KaBopiote 10 mAaicto apyng Tov 10mA0L va givol 6To TAOIG10 2, VO
10 TAaiclo t€hovg va givar 90. To mhaicto 1 oto kavéil 1 Ba epeavilel povo to
pavpo eOvTo Ko Emetta 10 TAaiclo 2 Ba eival To TP®TO TANIGIO0 GTNV TaLvio TOL
enpavitet éva eidwhro.

11.pe emAeypévo 1o €ld®A0 610 KOVAAL 1 epapuodote €@é peddvng yia va. Bydiete
10 Gompo POVTO NG Ekdvag. Ank. Background Transparent

Wil 1024 H:) 540

|nk:|BackgrDundTran5pars vl o - ox

12.petapépete to pérog 2 tov cast oto miaicto 20 kavdil 2. Opoing petapépete
Kot To néAog 3 tov cast oo mAaicto 20 KavaAtl 3 tov Score.

13.¢ppovrticte va ddoete Kivnon kot 6ta dVo €id®AA dNA. KATE TNV avomTapoywyn
™G toviog , (evoeTikd)n pia eiova vo LeovifeTon 16EPYOUEVN OO TAV® TPOG
To KAT® Ko 1 GAAN ekdva va eppaviletar and apiotepd mpog ta deid. Omote Ba
elodyete yo ta €ldwAa oto mAaiclo 40 ota kavdio 3 kol 4 éva TAaiclo kA&l
(keyframe) kot Oa kaBopicete v kivnon. (Onwg kavate kol 6ty doknon 2).

14 .xaBopiote to TAaic TEAOVS TOV EWOA®Y oTO KavdAla 2 ko 3 va givon 55.

g

-

Crdisneyl

O dizney2 Odisneyl———— 1
O dinsney? Odinsney: ———

[

YHMEIQXH: umopeite vo avamopdyete v towvio Kot vo KAEIoETE TPOSOPIVE
OA0 Ta OVOIKTO TopdBupa YPNOLOTOIDOVTAS TNV GLVIOUEVLCT TANKTPOAOYiOL
Alt+Ctrl+Shift+P (yio Windows). Eivat évag koddg yio vo dgite v Touvia cog
Yopig va ypetdletal vo PETOKIVACETE 1| Vo KAgloete tor mapdbvpo pe to omoia
epyaleote. Xpnowomolwdvtag T0 oplunTtikd TANKTIPOAOYl0, UmOpeite v
EeTuAiEeTe, VO OTOUOTNOETE Ko Vo avamopdyete o towvia. [Tatiote (0) yio vo v
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Eavatulilete, (1) Yo vo TV otopotioste Kol Enter ywo va v avamoapdyete. Av
natiote Shift+Enter, ola ta avowktd moapdbvpo Oa kKieicovv mTpocwpivd kot Ho
O€lTe HOVO TNV OKMNVY|, EVO OVOTOPAYETOL 1) TOViAL.

15. Eavatvri&te v towvia ko Play. Topommpnote 6t ta0 600 gidwia (ota
KavéAa 2 Kat 3) Kivovvtol TautdYpove —To £va EI0MA0 EIKOVAG KIVEITOL Ao
™V KOpLeN TG 000VNG TPOG TO KEVIPO TNG Kol TO GAAO €10MA0 €KOVOG
Kveital amd aplotePd TPOg T0 KEVIPO TNG GKNVNG.

Téhog Ba pabovpe vor KAVOVLLE OVTIGTPOPT| KIVIIGEMV

H evtoAr] Reverse Sequence tov Director avtiotpépet to. KEAMA 6T0 ETAEYUEVQL
eldwAa, £tol doTe va ToroBeTovvTan oty akpPmg avtiBetn cepd. Znv ovcia, 1
aVTIOTPOPN oG kiviong onpiovpyel €vo TOVOUOLOTUTO, OVTIGTPOUUEVO GET
KOTaY0pioe®mv o610 SCOre—ov Kot omottel pOvo Alyeg TANKTPOAOYNOELS. XTI
OVTIGTPOUEVES KIVIIOELG TOV ol ONLLLOVPYNGETE GTNV GUVEXELS, O1 EIKOVESG Ba fyovv
amd TNV 6KV akoAoLOmVTOG TIg 1018g O100POUEG e AVTEG TOL aKoAoLON GOV OTOV
UTAKOV LECOA GTNV GKNVY.

16. oto score kaBopicte 1o pevov Zoom va givar 50%. 'Encita emié€te ta
eidmAa ota kavaio 2 ko 3 ko Edit—->Copy Sprites
17. kévte KMk 070 TAic10 56 oto Koval 2 ko Edit—>Paste Sprites
18. Me emdeyuéva ta gidowlo ¢ emkoéiinone Modify—>Reverse Sequence. Xto
score pmopeite va deite 6TL T0L EI0AN £XOVV AVTIGTPAPEL.

Crdisney2 - disney {1 disney2 - disney

Crdinsneyd - dinsneyd {1 dinsneyd - dinsneyd

19. Metagépete 10 TAAIG10 TEAOVG TOV E10MAOV 6T0 KavdAl 1 oto mAaico 91.
20. File->Save, Rewind ka1 Play v touvia coc.

5.4 EvaAlayéc kot ot — 0éua Hpweg tov Disney

®a ocvveyicovpe TV mponyovuevn epyacic  mpocBétovtag Mo Kot
eMAEYOVTOG eVOAAYES OTmG GLVBESELS , Yo Vo TEAEUDGOVNE TV Towvia. To TpdTo
mov Oa kdvovpe vo KaBopicovpe ta Enueio Eyypaene. Ta onueia eyypoaeng ivor o
KOplog Tpémo¢ tomobétnong ewovov oty oknvl otov Director. ‘Eva onpeio
eyypoeng mopéxel €va  otobepd onueio  avagopds HECO OGE oL EIKOVOL.
[Mpoemdeyuéva, o Director avabéter éva onueio ava@opds 6to KEVIPO OAMV TOV
EIKOVOV, O0ALL GE TOAAEG TEPIMTAOCELS (0MG Vo OEAETE VO LETAKIVIOETE TO OTUEl0

gYYPAPNG.

1. File>open v Epyacia3.dir kot amobnkevote v o¢ Epyaciod.dir.

2. Metagpépete 10 péhog 4 tov cast oto kavdir 1, miaicto 92 Tov score kot
kabopiote 10 mlaiclo Téhovg tov ota 100. H ewodva eivor mAéov
KEVIPOPIGUEVT OTN OKNVI KOl GTO KEVIPO £YOLV €va ONUEID €YYpOaPng
TPOETMAEYUEVO.
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| dizneyds ——1

1
Kavte OMAO KAIK 010 €I0®MAO0 OTN OKNVY Yo Vo, ELPOVIcETE TO TapABvpo
Paint.

KAMK oto epyoleio Registration Point amd v epyolelobnkn . Apob
Kavete KAMK o€ avtd 10 epyaleio, Ba delte TIC TEUVOUEVES YPOLUUES OTO KEVTIPO
™G ewovag mov opilovv to onueio eyypaens. Mmopeite vo HETOKIVIOETE
avTd T0 oTOVPOVNL GE o VER BEom oty gkova Yo voL 0AAGEETE TOV TPOTO
ue tov omoio o Director gppaviCer v ewoévo oe o towvio. To onueio
eyypaong umopet va  1ebel oe  p €KOVAL OTNV  EQOPHOYN  TTOV
ypnopomomOnke yioo dOnpovpyia Tov N pmopeite va 1o B€cete 6TO TAPABLPO
Paint tov Director.

KMK KOl LETOPEPETE TO GTAVPOVNIA GTNV JEEI TAELPA TG EKOVOG Y10l VO,
aAlagete o onueio eyypaenc. Kieiote to Paint

To eldwio gppaviCeton emiong o pa véa Béon embveo ot oknvy. H eikdva

eupaviCetoar otV aploTep] TAELPE TG OKNVNG, AOY® TG véag Béong tov
onueiov eyypaeng . O Director kevtpdpel avtopata To onueio eyypaeng
ot oknvn. 'Etol to onpeio gyypaenc e eiovog autig eivot o KEVTPO TG
OKNVNG, TOL TOTOOETEL TNV EIKOVA GTA OPIGTEPA TOV KEVTPOL TG EIKOVOG.

Enrdpevn kivnon eivar va kévoope avraiiayr Meiov tov Cast

o010 Sscore emléEte oto kavdAl 1 10 €ldwAo ota mAaicia 92 € 100 o
Edit->Copy Sprites

Kavte KAk oto mAaicto 101, kovéAr 1 ko Edit->Paste Sprites. Opoimg
EMKOAANOTE TO €ldwA0 Ko o100 mAaicwo 110, xavair 1. Topa 10 €ldwAo
(néhog 4) eppaviCetar Tpelg eopég oto kavai 1 and ta mhaiocw 92 €wg T0
miaico 118 H_‘

—EIT dizneyt —{10 disneyd —— 1@ disneyd =]

_O
_O

To HéAOG 5 Tov cast ivan pa eikdéva. OmoTe 6TO SCOre emAEETE TO €E10WAO GTO
kavaAl 1, mhaicto 101 €wg 109. oto cast emiéEte To péhog S kot
otV Ypapun epyoieiov oto emdveo pEPog G 006vng, kdvie KAIK ©TO

gpyaieio Exchange Cast Members m H eticéta tov e1dmdAov aAralel og 5,
Otav M KEQOAN avoamapoywyns ¢tiocet oto miaico 101, oty oxnvy
EUQOVILETOL 1] EIKOVOL TOV EKOVE TNV OVTAAAAYTY).

|2 disneyt —10 disneys —1 < dizsneyd —{]

1

10.070 score emAéste 10 €idwAo 610 KavaM 1, mAaicto 110 émg 118 kot oto cast

T0 péAOG 6. oV ypapun epyoreiwv otnv Kopuven g 0086vng KAk 6TO
gpyareio Exchange Cast Members.

O dizneyd —— O disneys ——] @ dizneyf s
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11.Rewind v tawvia cag kat Play. ‘Ezeito anobnkevote tyv.

[MTape Topa va kévovpe evolloyn 00ovng. Xtov Director, ot evaiiayéc 086vng
elval OnTIKG €QE TOL YPNOIUOTOIOVVTOL YIOL VO OTOKOADYOLV 1] VO OQPALPEGOVV
avtikeipevo and v oknvh, my. o evadiayn Wipe Left supoavifer to emdupevo
mAaiclo ™G Towviog amoKoAVTTOVTAG To otnv 000vn, apyilovtag amd v dedid
TAELPE TNG CKNVIAG KOl LETOPEPOLEVO TTPOS TNV APLOTEPT], GOV Vo, TpAfdel 0 Beatng
po Kovptiva. Mmopeite va epapudcete v evaiiayn o€ OAN TV KNV 1| LOVO OTIG
TEPLOYES OV OAAALOVV eMdved oTNV GKNVY| Kol pmopeite va puBuicete v dtdpkela
KO TNV OPLOAOTN T TV TEPIOCOTEPWOV EVAALAYDV.

12.070 score, 6To KOVAA EVOALOYNG P wévre Sumho KMk oo Thaioto 2 Y va
enpavicete to mapdbvpo dwddyov Transition. To mhaiclo 1 mepiéyel v
povpn oKy Kot 1o TAaicto 2 mepiEyel 1o id®A0 POVIOV Tov TpochHicate
omv epyacial.dir. Torobeteite mhvta pio evorlhoyn o610 TAGIGLO , OOV
epeaviCovron o véa eldmAa 0T oKNVN, £I61 OOTE TO €QE EVOAAAYNG VA
umopel vo amokoAvyel Ta eidwia. Xe avty ™V mEpinT®mon, to véo £idmAo
oL epeavifeTan 6to TAaic1o2 ival To €idwAo Tov péAovg 1 tov cast.

13.0mn Mota Categories, emiééte All kar ot Aioto Transition emaééte Disolve,
BitsFast ko matnote OK. H gvailayr| yivetar topa to pérog 9 tov cast.

Frame Properties: Transition EE J

Categories Tranzitions

Cover DowrrLeft . 0K,
Corver Ceorver Down-Right : ‘:|
Dizzolve Cower Left SE

Other Cover Right ol
Puzh Cover p

| Reveal Cover Up-Left ‘E'

| Strips Cover Up-Right

[ uipe Dizzolve, Bits

| E]I I:F;!-__ 4 :'_-..

Diuration:  [f [«]+] 200  Seconds

Smoothress: ]'[:j

Affects: (71 Entire Stage @) Changing Area Only

14. EmidéEte 10 mAaicto 2 610 KOvAAL EVOALOYNG KOl OVTIYPAYTE TO OTO TAAICLOL
92, 101 kou 110 o0 KOVAM EVOALAYNC.

w4 ]| 4 3 3
of 1
"z
=

ar -

15. AtoOnkedote Vv tavia ko Ttotiote Play yia va deite 1o amotédeopa.
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[Tape Topa va [IpocBEcovpe Mo oto score

16. e1cdyete oto cast 6000 véa pEAT, dnA. 0vo apyeia yov .mp3 (uéAn 10 ko 11).
Metagépete 10 pédog 10 tov cast oto kavdir yov 1, mlaicto 1 tov score
Avtdég o Myog Bo avamapdystar 6to @Ovio(mapacknvio) kab’ OAn
SLAPKEL TNG TOPOYDYNS.

o 1\ FelzYouBaty Vol |- The Buterly YouTube wmy
'l
g

e ¥

17.EmAééte 1o pérog 11 tov cast ko khk oto Cast Member Properties tov

-

mopafHpov Cast"""I . 210 mopabvpo O1Adyov mov gpgovietor ota 0e&id
emiéEte Loop . Xvyvd Bélete €vag GLUYKEKPIUEVA YOS VO OVOTOPAYETOL
ocuveymg Kaf’ OAn 1t ddpkeln pag tovioc. Av 0éoete v emioyn Loop,
t61e 0 NYOG apyilel amd v apyn ToL apyelov NYOV, HOAS TEAEUDGEL TNV
OVOTTOP ALY WYY TOV.

Sound

[7]Locp . b

DOwration: 0:01:27.118
Sample Rate: $4.100 kHz
Eit Depth: 16 bits

Channels: steran

18. Metapépete 10 TAAIG10 TEAOVG TOV E10MAOVL apyeiov Nyov 1 oto TAaicto 118.
Topa 0o mpochécete éva dALo Nyo oto Kavail yov 2. H mpocOnkn evog
dgVTEPOL NYOL GTA KOVAALL MOV givan €vag Tpodmog Yo vo Tpafnéete v
TPOCOYN TOL KooV cag oe o towvio. O Nyog mov Ba mpocHicete Oa
avamapayeTol povo o6tav epgavifoviot to ypoeika pwéin 4, 5 kot 6 Tov cast,
aALG B0l AVOTOPAYETOL TOVTOYPOVA LLE TOV NYO TOPAGKNVIOV.

19. petapépete o pédog 11 tov cast oto kavéil nyov 2, mlaicto 92 péca oto
score. AAAGETe To mTAaioto TéEAOVS TOV MoV G€ 99.

20.emAélte T0 TAVO €ldAO Kol avtiypdyte To ota mAaicto 101 péyxpt 109 ko
Gwnkatgtaloq uéypt 118 6to kavair fyov 2.

i OMikeyMc OMickeyMel] OMickeyMe]

21. AmoBnkevote TNV epyacio Kot ovamapayeTé TV Yo Vo OEITE TO ATOTEAECLA.
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5.5 IlpooBnkn AAAnienidpaonc— 0épo Hpweg tov Disney

B NUIOVPYNCOLUE EVa LEVOD KO KOVUTTLHL Y10 TV TAPOVGINOT) GOG KOt LETE
Ba ypnowonomoovpe v Lingo, thv yAdooo cuyypagng script tov Director yio va
TPocOEceTE SOAOYIKOTNTOL.

Ot dohoyKéG Tonvieg EUTAEKOVY TOVG YPNOTES, EMTPETOVIAS TOVG VO, KAVOLV
KMK o€ gikdveg Yo va e€epevviioovy dAla pépr g taviag 1 ya va e&€Abovv dtav
etvar éroot. Xuvnbmg avtd To €100C SOAOYIKOTNTOG TAPEXETAL GE TOVIEC TOL
Director péom pag ypamtig evioAng mov kodeitor okpurt (script). Ta script
yYpapovtor ¢’ éva mapdbopo Script ypnoonoidvtag eviorés Kot AEEE mov gival
uépog g Lingo.

Y& ovtd o pabnua Ba ypayete 600 amhd script Lingo yia ta kovumid Credits
kot Quit. Ta script mov Oa ypdyete Ba enttpémovy 6TOVE YPHOTES VAL KAVOLV KAK GTO
kovouni Credits yi vo dovv o GAAn 006vn, mov Oa dnuiovpynoete oo TV
TOPOLGIOCT] GOG.

Ta xovumd eivor oNUAVTIKE YOPOKTINPIOTIKE GE OLUAOYIKEG TOPOVGLAGELS,
emeldn elvat To KAEWSLA Yo TNV TAOHYNON LECH TNG TapovGioong. Me Script kovumimv
o Director petaxwvel v kepoAn avomapaymyng ce €va GAlo mAoiclo péoa oTnyv
tovia M extehel AAAeg evToAég Tov mepthappavovtal oto script. Otav éva Script Aéet
otov Director va HetakiviioeL TV KEQOAT OVOTOPAY®YNG O€ £va. GALO TAGIG10, OVTY
HETOKIVEITOL 1] OLOKANOMVETAL GE €va OAAO TAOUGIO KOl UETA UTOPEL VO EMOTPEYEL
07O OPYIKO TAQIG10, LECM TOV EVIOA®V VOGS GALoL SCript.

[Tape Tdpa va dnuovpyncovpe poe 006vn pHevov

1. Avoi&te v doknon 4.dir kou amobnkevote v g doknon 5.dir 6to PaKeLd
ococ. Ewodyete oto cast véo péhog pia ewova (LéLog 12) ko ddote TG Ovopa

-
FRF) 2=
WFEf =

menul.
i b [E|menu

2. Metagpépete 10 péAOC 9 oto kavd 1, mhaicto 131 tov score
3. Avoi&te 10 mapabvpo Paint (Window->Paint) kot dnpiovpynote d00 ypopika
Buttons, o éva Oa £xet keipevo Credits kot to dAlo Quit

4.Avtioctotya yivovtar to péAN 13 ko 14 oto cast. @a gpovticete va Toug 0MCETE
ovopa oto cast , onA to péroc 13 Ba to ovopdoete ButtonCr kol to péiog 14
ButtonQt.

50
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TN ButtenCr Busttondit 15

il Il Il Il I

5.uetapépete Ta uéAN 13 kon 14 oto xavai 2, mhaicto 131 kot kava 3, TAaiclo
131 tov score, avtiototya. Xto ButtonCr 6o xévovv khk ot yproteg yio vo
uetapepfovv otnv 086vn Credits kot oto ButtonQt Oa kdvovv KAk yio va Byovv
amd TV tovia.

6.2tV oknvi petaeépete ta Vo ypapkd Buttons wote va gaivovtal 1o éva
dtmia dlmAa otV KAT® TAELPE TG OKNVIC.

7. X10 score emAéEte o eldmAa ota kavala 1,2 kot 3, maicto 131 kot 6éote
mAaicto Téhovg 132.

1=
o]
o]

Topa mov dnuovpyndnke n 006vn ToL pEVOD, TPEmEL Vo Ypayete éva SCript og
Lingo mov Ba to xpatd otnv 086vn dtav avorapdystor n towvia. H 006vn npénel va
TOPOUEIVEL GE EUPAVION £€TGL MOTE Ol YPNOTEG VO UTOPOVV Vo KAvovv KAK oTa
KOLUTLAL.

[Tape Todpa vo kdvovpe cuyypoen evog Script og Lingo

Mo va ypawyete éva script Lingo mov kpatd Ty KEPOAN avomapaymyng oty
Béon g ewdvag emdve oe éva mAaiclo, mpocbiécete éva SCript oto Kavait
oLUTEPLPOPAS, OV emiong Kaisitaw Kavail SCript. Omwe 1 KEQOAN avomapaymyng
LETOQEPETOL UEGO GE £val TAIGL0 oV meptEyel évo. Script, o Director dwafaler tig
EVIOAEC TOL Tepléyovtal péoa oTo SCript wou Tic extehel. AVTEC Ol EVTIOAEC
opyavavovtal o€ ouddeg mpotdcemv Lingo mov kodovvror yewprotéc(Handlers). Ot
YEPLoTég  «yepilovioy  ocvuPdvia Om®G KAK  TOL  TOVTIKIOD KOU  EVIOAEC
TANKTPOAOYIOV OTwG Kol dALOYEG TEPIPAAAOVTOG, OTTMOS TV 0Py HoG Touviag 1 TV
€160d0 og N Vv £€E0d0 amd €va mhaictlo. ‘Evag yeptotg amoteheitan amd £vo 6GHVOAO
EVTOAMDV, OUAOOTOMUEVMV OOV TPOTACELS G Lo mopaypapo. Kdabe yeipromg apyilet
ue on ko tehewdvel pe end.Ga dSNUIOVPYHOETE Eva XEIPLOTH TTOL KAvEL TV 006V TOL
uevoy vo mapapeivel otny oknvi, eve o Director mepiuével va kdvete KMk o€ Eva
KOULUTH.

8. 7o xavdAl Zoumeprpopd i KOvTE Ao KMk 610 mhaicto 132 yo va
avoitete éva Tapabvpo script.
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askhshd: Script = | (| [
@ 2skhshd: Scrip LB 2=

i w Script:Behavior Scrpt 15 = e
+ 4 b [El (7 } LB [ |Interna| v]
Linga - | | exitFrame v] £ — L ¥F Iﬂ.lL ﬁ_.E_

on exitFrame me

1 end

9.01 6V0 TposmAeyuéveg TpoTdoelg on exit Frame kai end Bpiokovtol M 610
Tapabvpo Script kot to onpeio El6aymYNG EXEL UITEL GE E50YN KAT® OO TNV TPDOTN
YpOLUN.

[TAnktporoynote «go to the frame» dnA.

@ askhshd: Script = [3 [
i % Scrpt:Behavior Script 15 = iz
+ 4 b [ﬁl . L7 ] 15 llnternal v|
| Linga | || [giobal] i@l El | LE UL
'on exitFrane ne ,
! Go to the frame
o end

H ¢pdon the frame sivor evoopatouévn cuvaptnon g Lingo mov
oniover tov aplBud mioisiov, 0mov Ppioketor avT TN CTIYW| N KEQOAN
avamopoyoyns. Av m Kepain Ppioketon my. oto mAaicto 50, 1o 50
EMOTPEPETOL OO TNV GLVAPTNOT).

H evtod go to otéhvel v kePoA avomapaymyng otnv 0éon
TAOLG1I0V TOL 0KOAOVOEL TNV EVTOAN.

H evtol go to the frame otélvel v KeQOA) avomapaymyng 6To
mAaiclo 6to omoio Ppicketol O, dNA. mapapnével 6To 110 TAAIG10 KoL OAL To
el0A0 6€ AVTO TO TANIGLO TOPAUEVOVY GTNV GKNVY.

10.KAgiote 10 mapdHupo Script.
11.Avorapdyete v tawvio ko Play.
[Mape va Anpovpynoovpe o 006vn Tpoopicrov

Topa Oa dnuovpynocete v 006vn Credits mov Oa spgpavictel Otav Kavete KAMK 6TO
kovuni Credits. Anhadn, n KeeoAn ovamoapoyoyng 0o doukiaddoel otny 006vn
Credits otav évag ypiomg kdéver KAk oto kovuni Credits péoca oty towvie. H
006vn Credits Oa amoteleitor and Eva pOVTO Kot KEILEVO.

12.Anpovpynote dvo gumrovtiopéva (.rtf) keipeva, to Creditsl.rtf oto onoio Ha
ewoayete keipevo Credits (Mopgpomoinon: Verdana, 32 otiypéc,Bold) ot to

Credits2.rtf oto onoio Ba elcdyete keipevo ota AyyAikd (m.y.: This movie has been
made by “to évoud cag”).
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13.0a s1odyete ta 600 avtd Keipeva oto cast, péin 16 ko 17 ko Bo petapépete
10 pérog 16 oto kavd 2, mhaicio 135 oto score. To kavdi 1, mhaicio 135 Oa

TPENEL VAL EI0AYETE TNV €1KOVA TOL péEAOVG 8. H mopdkapyr pHepik®dv TAoiciov
KAVEL P10, OTTTIKY O10KOTT 6TO SCOre mov 6o Pondd va dtoPdcete To SCOrem.y.:
aLTn 1 01KonY| cag Pondd va dtaxpivete avdpesa oTnv pon NG ToViog Kot G€ pio
0006vn, otV omoia Ha SaKAAODGOVY 0L YPNOTEC.

14 Metagépete to péhog 16 oto kavdaar 3, mhaicto 135 oto score.

2 disneyd
g
@17

15. em\é€te ta gidwia Credits] ko Credits2 oto score kat epapuocTte £QE

'.\':lElJb H:ldb

Ink.: | Background Transpare » |

uelavng Background Transparent.

oA ta otoyeia g 006vng Credits Bpiokovtar otn oknviy Kot givatl ®po va. To
Ton00eTHoETE £T61 MGTE OAOL VAL POIVOVTOL GUUUETPIKE KOl KEVIPAPIGUEVAL.

16.Emnééte View—>Guides and Grids—>Show Grid étol dote vo gpeoviotel to
TAEYHa Yoo va oo fondnoet va tomofetroete Ta I0MAN COGTH EMAVE® GTN GKNVY).

Av mpotipdte to gidwAa va Ehkovtal 6to TAEYpo, emAééte View—>Guides and
Grids—>Snap to.

17.01av 1o tomobethoete cootd emAé&te View—> Guides and Grids—> Show Grid
Y10 VO OTEVEPYOTOUCETE TO TAEY L.

18.EmiéEte ta eidmwAa 010 Score kavait 1, 2 ko 3, mhaicto 135, dnA. v ewdva
Kot To 000 credits kot dmote mAaioto télovg 139.

Crdisne[]
Q1E—]
17—

19.Auth6 KAk 610 KavaAl puOpov oto mAaicto 136 yia va avoiete o Tapdbvpo

dtddyov Tempo.

20.EmAéEre Wait, ypnolpomomote to TARKTpa PeAdV Yo va Bécete Tov ypdvo
avoapovig og 3 seconds kot OK.

Frame Properties: Tempo i 2

) Tempo: : i fps 0k |
@) Wiait (] [41*] 3 szeconds Cancel

1wt ait for Mouse Click or Key Prezs

1w ait for Cue Paint;

Channel | { Mo Cue Points } Cue Paint: | { Mo Cus Paoints } | Help
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21. Avamopayete kot play v tawvio.
22. Amobnkevote TV gpyacia.

[Mape todpa va kdvoovpe tpocHnkn Inuadiodv yuo ITiorynon

Me v oAAnAemidpoorn pmopeite vo mapEyete €vo TPOTO OTOLG YPNOTEG VA
eréyyouv 10 TS TpoPdaiovy pa touvia. o vo dnddoete éva TAaiclo 6to omoio
npénel va dtakAadmaoel o Director, swodyete éva onuddy, évo pikpd Tpiymvo mov
epeavifetot 6To KovAAL GNUASIOV GTHY KOPLEN TOL SCOre. Apob tomobetnoete éva
ONUASL GTO SCOre UTOPEITE VO TANKTPOAOYNGETE LA ETIKETA OITAO TOV

23. 1o kv Znuadimv, KMk oto mhaicto 131. Me toviopuévn v etikéta
TANKTPOAOYNOTE MENU Kou atnote Enter.

7 ¢ [ | F menu

-

24. swodyete évo onuadt oto mhaicto 135 kot ovopdote to Credits

7 menu W CREOITS

.

[Mape todpa va. Anuovpynoovpe Script ITAonynong

25.Emié€te oto cast to uéhog ButtonCr kot KAk 6to kovumi script Ko

mAnktporoynote go to frame “Credits”
! @ askhshd: Script a5 I_IEI I|ES [
£ w Script:Script of Cast Member 13:ButtonCr = =
+ 4 b [El ButtonCr ﬂ 12 llnternal v]
Linga v] [mnuseUp v] 3 L E w{' '3
]'Dn mou=elp -
go to frame "Credits"
= end

Kl\eiote 1o mopabupo tov script

26.01mho KAk oto mhaicto 139 610 Kavail GuUTEPLPOPAS Yo VO avOIEETE TO
napdBvpo Script kot mAnktporoynote go to frame “menu”

@ askhshd: Script

i Script:Behavior Script 18

T —

Lingo v] [exitFrarne - | ‘E

| on exitFramns me
go to frame "menu”

L end

54



27.Amobnkevote v epyaocia, avamapdyeté v kot Play kot 6tav @tdcete otnv
006vn pevov, kavte KAk oto kovumi Credits

28. stop v towvia . EmAéEte 1o péhog ButtonQt kon kdvte kMK 610 KOO

script Kol TANKTpoAoYNoTE qUit
o

ORI I ] II.!L

i ¥ Script:Scrpt of Cazt Member 14:ButtonQt =

+ 4 b E|Eﬁuttnnﬁ!t ﬂ 14 [E

Lingo * | | mousellp v] =

on nouselp
; quit
 end

29. Kheiote 10 mapdBvpo script, avamapdyste v tovia ko Play. Otov gtdoete
010 pevov matnote to kovuni Credits étol dote va gppaviotei 1 006vn credits
vy 2 devtepodienta. Otav €lote £TOOL VO EYKATAAEIYETE, KAVIE KAK GTO

kovpmi Quit.

[Tape topo va dnovpyncovpe poe tpoPoArrn. Ot mpoPorég eivar mpoypdupoto
ekteléolpa (.exe) ota Windows, to omoia Asrtovpyobv cav kabe GALo mpdypoppo
o€ &va vIoAoYloT, He TNV dwpopd 6tt AEN upmopeite va avoifete ko vo ta

eneEepyaoTElTE.

30. emAéEte File>Publish Settings
31. Kl otV kaptélo Projector
32. toexdapete Animate in Background, Full screen, Center stage in monitor,

escape key terminates, reset monitor to match movies volor depth, extra main

memory, system temporary memory.
33. matote OK

Publish Settings [
Frojectar =
Player bype: I Standard - ] Ok
A Standard projector containz the uncompresszed plavback .« | Fublizsh |
libraries along with a mowie and poszibly addtional movies, -
casts and =tras. -~ | Eanael |

7] Save splash image using frame: 1

] Custom icon for application file

[¥] &nirnate in backaround

|+ | Full screen

7| Lock stage size to movie's stage

[ Exit lock

[#] Center stage in monitor

] Single instance anly

[T Dizplay full script error text

[#] Reset monitor to match movie's color depth

[¥] Extra main remon 2000 | Defaults |

Syztem temporam memon | Help |
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5.6 Kivnon xvkMkng Atadpopng

o  onuwovpynoete  éva €PYo  XPNOILOTMOIDOVTOG TNV EVIOAN
Modify->Sprite—> Tweening tov Director yia va dnpovpynoete pia Kiviorn KukAMKNAG
dwdpoune. ‘Emerta Ba onuiovpynocovpe éva devtepo épyo oto omoio Oa kdvete tov
Director vo kotoypdeet tn S100popn evOog EI0MAOD OTMG TO UETAPEPETE EMAVED GTNV
006vn. O 6pog Yo avTd TOV TOTO KIVIONG KOAEITAL KOTOYPOLOT TPOLYLOTIKOD YPOVOV.

H evtoAry Modify—>Sprite>Tweening cog enttpénel vo TPOTOTOMGCETE TV
evolapeon dladpoun mov €xet dnpovpynoet non o director ywa éva eidmro. H evtoin
avtn enttpénel Opws otov Director va mopesufaiel ToAG TePIocdTEPA TPAYUATO OO
o omAn aAlayn Béong. Mmopeite va v ypnotpomomoste 0tav 0élete éva 10®A0
VO LETOKIVEITOL ETAV® GE 0L KOUTOAT SLOOPOUT, VO ETITAYVVETOL 1] VO ETLPPadvVETL
EMAV® GTNV GKNVN 1 Vo 0ALAEEL YPOUOL ) LETY LD YPOUATOV.

XPNGOTOLEITE TNV KATAYPOPT] TPOYLATIKOD YPOVOL Y10 VO, LETAKIVIGETE £VOl
eldmAo péoa ot oKy pe 10 movtikt. Otav YpNCILOTOIEITE KOTAYPOPY] TPUYLUTIKOV
xpovov, o Director kotoypdeel avTOHOTO TIC KIVNOELS ©6TO SCOre.llgue tdpo vo
kaBopicovpe Tig [d16TNTEG TNG TOUViOC.

Y10 épyo avtd ypnowwomolovpe v evtodn Modify—>Sprite>Tweening yio va
ONUIOVPYNCOVUE KIVNOT ETAV® GE [0, KUKAIKT S100pOpT), Y10 VO KAVOLUE U0 EIKOVO TNG
NG VO KIVEITOL G KOKAO YOP® Otd TOV TAL0.

1. File>New->Movie kot amobnkevote v gpyacio coc wg Aoknon6.dir.Xto
Google ekdveg Oa Ppeite 000 €IKOVES: Lol YioL TOV HALO KoL L0, YioL TV Y1).

2. eglodyete TIg OVO £1kOVEG 6TOo Cast, o NAog Ba eivon to pédog 1 ko m yn Ba elvan
T0 pELOG 2.

7 Lasiinternal

== | 4 » [[Ofe

|

I -

[MTape todpa va kabBopicovpe ta [MThaicio Kigdud

3. Metagpépere 10 pérog 1 tov cast oto kavail 1, mhaicto 1 Tov score ,emiong
petapépete 10 PEAOG 2 Tou cast oto Kavaal 2 , mlaicto 1 tov score.
Ooa xwnoete v I'm petokwvoviog v yOp® YOpw UEGO OTN OKNVY,
onuovpymvtoag mAaicw avdpecso oto mAaiclo kAEWd. Ot KWNoEeS Tov
dnuovpynoate o¢ Topa ivor ypoupkés kivinoels. Ta eldwio petakivovvton
o€ evbeia ypoupun endve oty oknvh Kot £® amd TV oknvi Endve oty id1a

dwdpoun. Xe ovti TNV gpyocio. oL Kwnoelg mov Bo  dnuUovpynoete
akoAovfovv o kapmdAn Sdpoun, mov o Director opiler avdpeoa ota
mlaiclo KAeW1d mov Bétete og éva gldwro. T va kdvete to €idwAo cag va
akolovOnoel por KopmOAn Oadpoun, mpémel vo OBécete 10 €ldwAO of
TOVAGYLOTOV TPELS BEGEIC GTNV OKNVY|, G S1OPOPETIKE TANIGLO KAELOL.

4. KGvie KAMK 010 mAaicto 1, kavdAl 2 kol HETA UETAPEPETE TN YN OTNV KOATM
aploTEPY] TAELPE NG OKNVNG. AVTO givol To TPdTO TANIGI0 KAEWL oL Oa
ONUIOVPYNOETE.
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[Ipéner va Bécete tpia akdOun mAaiclo KAEWA Yo TV €OV TS YNG Yo Vol
oAoKANpmoete ™V Kivnorn. EmidéEte Béceic yio v ewkdva ota mAoicilo
KAEWWA oL Bol ONUIOVPYNCOLVY O EAAEUWTTIKY OLOPOUY], TOL HIMEITOL TNV
TPOYLE TNG YNG YOP® amd TOV HAL0.

5. Z10 score kdvte KMk oto mAaiclo 7 kavail 2 kot Insert—>Keyframe. ‘Eneita
LETAPEPETE TN YN OTNV KAT® 0e&10 Yovia TG OKNVIG.

6. Ewodyete éva miaioclo kAedi oto mhaiclo 14, koval 2 Kol LETOPEPETE TN YN
oV Tave de&ld TEPLOYN TNG OKNVIG.

7. Ewodyete mhaioclo kAewdl oto mhaicto 21, kavdil 2 ko petapépete ) yn Adyo
EMOVD OmO TNV EMAV® TAELPA NG €KOVOG TOL MAOL GTN GKNVI| ylo. Vol
oAokANpdGeTE TV BEon Thauciov KAEWG100 TG EAMTNG Sladpoung.

s
i+ earth == aarth i earth i earth |

8. Amobfnkevote TV gpyacio cog.
Ortav mapotnpeite v kivnorn, o Director éyer tomobetnost avtouata ta.

miaicl avapeca oto mAaiclo kAswwd mov kabopicate. H dwadpoun eivon
KATWS KUKAKY], aAAd elvan teBhacpévn. Emiong, n yn mepvé pnpootd amd tov
NAo avti va mepvd and Tiom Tov. v emodpevn epyacia Oa eEopaddvere v
Kivnon ypnowonoidvrag v evroArn; Modify—->Sprite=>Tweening. Eniong 6o
dwtdéete ta eldMAN £TOL OGTE 1) YN VO TEPVA TG® OO TOV A0 GTNV TPOYLEL
™mge.
[Tape Topa va dnmovpynioovpe o Kivnon Kvkiikng dtadpoung

9. Mg 06l 10 €ldwA0 ot0 kOovéA 2 emheypévo,  emAélte
Modify-> Sprite-> Tweening

Sprite Tweening

=
-

Tweer: Path Foreground Color
Size Background Color
Fotatian Blend LCancel
Skew
Linear Mormal Extreme
Curvature: | [

Continuousz at Endpointz

Speed: (%) Sharp Changes
) Smooth Changes

Easer [] G0 =z

Ease Out (] o

To toekapiopévo mhaicto Path: kaver tov Director vo dnuiovpynoet tig KapmbAES
SdpouEG avapesa oto TAaiclo KAWL mov opicate mptv. Ot dALeg EMAOYEG GOG
EMTPENOLY VO KAVETE T EI0MAN VO KIVOUVTOL GE KUKAO, VO EMTOXOVOVTOL 1] VL
empPpadvvovtal. Mmopeite vo Kavete 1o €idwio va aAldler péyebog, oynua,
TPOCAVOATOAICUO, YPOUO 1| Uopeite va avapeiete éva el0MA0 Yo va KAVETE Vol
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enpaviete N vo. offvel, 0nwg o Director dnuovpyei 10 €idwio avipeco oe
mAoicto KAEWLA.

10. EmAé&re Continuous at endpoints kot petakiviote tov avéoueimtn Curvature
Myo mpog ™ 0e€18 TAELPE TG KALLOKOG.
H emioyn Continuous at Endpoints kéver ta €idwAia oe o kivinon vo
apyilovv kot va TeEAeldVOLV 610 1010 onueio. Kk OK.

11. Avamapayete ko Play v tovia. [elpapotioteite pe dAleg emloyec.

12. Emééte 1o €ldwAo 610 KavdAl 2 Kot EQOPUOCTE EPE UEAAVIC Y10l TOV AGTPO
@OVTO(OV LITAPYEL OTNV EIKOVO GOK).

13. "Hon emkeypévo to €idmwro oto koval 2, emiééte Modify—> Arrange—> Move
Backward. Ta gidmAa Tov AoV Kot TG NG ovTolAdocovy BEcelg 6To SCOre.
H evtol) avt| petakivel emdeypéva ei0mAM TPOG TO TGM KOTA £Vl KOVOAL.
Me 10 €l0®A0 TNG YNG LETAKIVIULEVO TTIPOC TA. TG®, TOPA KIVEITOL TIoW® 0d TOV
NMo Onwg mpémel, enewdn to €ld®A0 TOL NAOL glval € €va KOVAA e
HEYOADTEPO aP1OUO oo TO EI0WAO TNG YNC.

14. File->Save v gpyacio cag.

5.7Kivnon pe Kataypaoer Ipaypatucod Xpovoo

Topa Oa ypnoyomomcovpe o GAAN TeXVIKN Yoo dnpovpyia kivnong. H
KOTAYPOPN TPOYUATIKOD XpOvoy dnpiovpyel Kivnon koataypdeoviog Ty kivinon
€VOG E10MAOL OTMC TO LETAPEPETE EXAVEO GTNV GKNVA.
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Topo Bo dnuovpynoete (o kiviion enave o Eva YPAPIKO KATAYPAPOVTIOS TIC
KIWNGELG TOVL TOVTIKION GOG.

Oa avolntioete oto Google ewkdvee, €1KOVEG TOV TAOVNTOV TOV NALKOD HaG
GLOTAHOTOG Ko Oa TIG €10dyeTE WG HEAN 6TO Cast apoy TPMTU ONUIOVPYNCETE LU0
véa tauvio Ko Ty anobnkevoete o¢ doknon 7.dir.Extoc amd tov Ao kot t yn Oa
glodyoovpe tov Apn , v Aepodit ,to Aia ,tov Epun , to Kpovo, tov Ovpavd kot

7o I[ocedva.
e}

afroditi

9

LelE e

o

poseidonas 10

1. Metagépete v €wodva Tov fAlov pérog 1 tov cast oto mhaicio 1, kavail
TOV SCOre.
2. PETAPEPETE TNV EIKOVA TNG VNG LEAOG 2 ToL Cast 6To Kaval 2, mhaicto 1 Tov
Score. AvtioTtoyo KAVOLLE TO 1010 Kot €1GGYOLLE KOt T (AR PEAT .

AL

=un

earth

Ermis

afraditi

aris

dias

kronos

ouranos

e R e R e IR s Y o Y RN e Y = Y o |

poseidonas

3. 'Emerta B tomobetnoete Tig €1KOVEG TV TAOVNTAOV Kol TOL NAOVL GE Lol
GEPA LEGA GTI OKNVI OGS POAVETOL TN TOPAKAT® EIKOVAL.
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Metd o opicete pia S100popT| YL THV YN LEC® KOTOYPOPY|S TPOLYLOTUKOV
YPOVOU.
3.kMK 670 KOavOM 2, TAaicto 1 Kot toroBetote 10 €I0®A0 GTNV KAT® aploTePn
TAevpd TG CKNVNG, 0oL BEAeTE VO apyicel 1 elkOva TV Kivion .
4.xbvte KMK ot aploTepd Tov aplfpod kavaAlod oto koviit 2. Olo ta kKeMd
oto score ovapeco ota mhaicw 1 kot 30 tovilovtonr toOpa Kol M KEPOAN
AVOTOPUYOYNG TAPAUEVEL 6TO TTAAIGLO 1.
5.Avoi&te 1o Control Panel(Window—->Control Panel) kot kAik otov éleyyo
pLOUOY Yo va Tov emAéEeTe kat petd aAddEte tov pubud oe 5 ps.

T rantral Danzl ﬂ

W (wm b [ 30 [fps| SAifes] ~ |lgn ol

6.KavTE KAMK 670 edio eAEyyov pubpod Kot etodyete pia véa Tiun 5 fps

7.IMotote To Kovpmi Ppdyov &Y yio va 1o amevepyomomoete

8.6VEPYOMOMNGTE TO KOVUTE EMAEYUEVDV n)»oucsioov!. >to control panel k\ik to
Selected frames Only evepyomoteitan 1 pOOUIon pLOUOY PdVO Yo Ta TAOIGLL TTOV
&xete emAéEel oto Score. Av kdvete KMK 6€ avtd T0 KOLUTL TOTE 1 KATOYPOPT|
TPOYUATIKOD ¥POVOL YIVETOL HOVO OTO TAAICLH IOV £XETE EMAEEEL.

- e,

H gpodvion tov pvBuod dniaver tov mpokabopicpévo pubud pe tov omoio
TPEMEL VO AVOTTOPAYETOL TO TPEXOV TANIG10, 6€ TAAIcIO oVl OevTEPOAETTO. AV €xel
ewoayOel o puouion pvBpov oto KavaAL puOLOY TOL SCOre g £va oplopévo TAaicto,
10TE LT M POOUIoN TTponyeitan Tov pvOuov Tov BéteTe oTo control panel. Avti n
pvBuion Oa eppaviCeton eniong oto medio EAEyyov pvOuov, oto control panel.

Mohg avobécate tov apOuo oe 5 fps yio to emdeypéva mhaiolo. Oétete Tov
pLOud yo pia emhoyn mhaiciov pe tov Eleyyxo pvburod oto control panel, sildyovtog
wa véa Tun fps oto medio, N ypnoiponoidvog to TAKTpa BEADV Yo va. avERcETE M
va petwoete v poduton fps. H alhayn avtod tov pubpod 6tdyov oe puikpdtepn tiun
fps pewwver mv evaucOnoio tov Director, otig KIVAGEIS TOV TOVTIKIOD GOG, OTMG
KATAypAQeeTe. AVTd G0g TOPEYEL KAAVTEPO EAEYYO, OTAV KATUYPAPETE GE TPOYLOTIKO
YPOVO Kol TEAMKA €xel cav amotéAecpo. opaAotepn kivnon. Omote 0Oéhete va
ONUIOVPYNOETE 0L KATOYPOPY] TPAYLOTIKOD XPOVOV, UEIDCTE TOV Ppuiud dote va
KaToypaeel pe Kpdtepn taxTNTO 0o TNV TPAYUATIKY. AQOV Kataypapel, unopeite
va emavafEceTe TV TIUN pLOKOV GTNV LYNAOTEPT TN TNG.

9.emAé€te  Control->Real-Time Recording H  xotaypaen apyiler  uodiig
LETOQEPETE TO EIOMAO EMAV® GTY] OKNVY|, OMOTE TMPEMEL VO €10TE £TOOL VL
LETOKIVI|GETE TO TOVTIKL.

60



10.Metagpépete t0 €l0®A0 TG YNG O W €mBLUNTY OOPOU| EMAVED GTNV
oknvn, oe pa véa Béomn. ‘Exete 30 mlaicta yio va opicete o S1adpopn yio 1o
eldwAo, OmOTE TOpOTNPEITE TNV KEPOAN OVATOPAYWYNS OTO SCOre Ommg
peTapépeTe T0 €ldA0 emGved oty owdpour. Onwg kdvete v peTOQOPA,
BAémete 10 €ldwAO va Kiveital endvm otnv oknvr. To eldwio kot o1 Bécelg Tov Oa
KaToypaQovTol 6To SCOre. AQNote 10 KOLUTL TOV TOVTIKIOV Y10 VO GTOLOTICETE

TNV KOTOYpOQ).

H dwdwkacio avtn givar yvoot) cov Kataypoe] TPoypoTikoy ypévov
eneldn o Director kataypdeet T KIVGELS TOL TOVTIKIOD Katevbeioy 6To SCore, Omme
epyaleote. Apob o Director kataypdyet v kivnon tov €10dAov kot ota 30 mhaiota,
Ba tomobBetroel [ €1KOVOL TOV EWOMAOL GTNV OKNVY, OTNV TeAevtoio Béomn mov
Katoypdpetal. Av 0gv cog apécel To mo» TEAEWDVEL M Kivnomn, Umopeite vo
enavordPete v ddkacio Kataypagnc. o va 1o Kavete avto, emAEETE TAM TO
m\aiclo oto score ko petd Control->Real-Time Recording kot petagépete 1o €idmA0
péoa oto 30 mhaicia.

Il.khk oto Loop oto Control panel vy va evepyomomjoete owtd To
YOPOKTNPIOTIKO ONA. umopeite va dgite v kivnon va ovomapayete ovo Kot
Eavd.

12.Avomapdyete tnv tawvio kot Play. ‘Eneito otopathote Ty avomapaymyn e
Touviog ko emAEETE T0 €10A0 6TO KavdAL 2 (ONA. To €id®Ao TG YNng)Kot
Kavte KAK 610 mAaicto Trails oty ypapun epyoreiov el0OA®V.

Sprite | | |

) ab (N Wy g @
Mame: |

g e |

Ta ixvn(Trails) eivar o amd 11 eMAOYEG E10OAMY TOL PPiokeTe 6TV VPO
epyorelov edOlov. Av emdélete avtd to mAaiclo Otav €xete emAéEel €va
eldwAo, TOTE TO €IO®AO OPNVEL TIG® TOV éva TYvog EIKOVOV OTMOG PETOKIVEITOL
uéoa oty oknvi. Ot dvo aideg emioyég, Moveable kou Editable, spapupolovron
emiong oe €ldwAa , OALE EMTPEMOVY GTOLG YPNOTEG VO AAANAETIOPOVV UE TO
eidoia. Otav n emroyn Moveable gpoppoleton oe éva €idwAo, o1 ypnoTeg
UTOPOVV VO TO HETOPEPOLV GTNV OKNVI, EVO M Towvio avomapdystal. H emAoyn
Editable epoppoletor povo oe cidwia mov eivor media. To cidwha media
EMTPEMOVV GTOVG YPNOTEC VO EMAEEOLY KOl VO ENEEEPYACTOVV TO KEIUEVO €VOG
nediov eved avamapdyeton 1 tovia. Ta eldwio wedio mpootiBevion oe pia Tovia
Héom pag emaoyng oto mapdbvpo ToolPalette.

Topa 1 yn Ba aenvetl Eva iyvog g eKOvVOG ™G OTOC LETAKIVEITOL ETAVED GTNV
dwdpoun ™G Kivnong g otn oknvi. Mmopeite va egpapudcete iyvn o€
omolodnmote €idwAo €xete dMoEL Kivnon, KAvovtag KAIK 6To €i0®MA0 HEGH GTO
score ko petd emléyovtog o mhaioto Trails.
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13.Avamopdyete v Touvia kot Play yio va deite 1o amotédeopa.

14. AnoBnkevote v epyacio cag.

5.8 IMhaicta KA1 ko Enineda

Ye ovt) Vv epyocio Bo ypnowomomcovpe  mAAiclo KAEWL Yoo va
ONUIOVPYNOETE Uia Kivom £VOG YAPTION TTOL TTETA amd £vo PAKEAO G€ Eva AL, OTtmg
onpovpyeite v kivnon, Ba oAAGEeTe TV SKGTPOUATOGT GTO SCOrE Yio Vo KAVETE
T0 Yopti vo gaivetar 0Tl Pyaivel amd éva @AKELO Kol UETAPEPETAL GE £va AALO
(PAKENO.

[Ipwrta B Bécovpe Eva mpocappocuévo uEyebog oKnviG YPNOLOTOIDVTOG TO
napdBvpo doddyov Movie Properties. Ot tawvieg pe pukpotepo, peyédn oknvig eivot
KOADTEPEG Yo dnpovpyio tawvidv Shockwave. T'a va emttaydvete v eOpT®OTN OItd
10 Web, 0é\ete va kpatfoete 1o péyebog g touviog pkpo Kot o pkpotepn 00ovn
BonBd otn onpovpyia evog LkpOTEPOL apyEiov.

Apywd Oa Bpeite oto Google sikdveg TEcoEPIG EIKOVES EYYPAPOV, dVO EIKOVEG
QoKELOL Ko pio EIKOVA Yo pOVTO 6T oKNvY| oag. Evdsiktikd divovtal o1 eiKOveG 6T
@axeLlo aoknons.

1. Anuovpyeite o véo tawvia File>New—>Movie kot v omodnkedete mg

EPT'AXIA.dir .

2. Kabopiote 10 péyebog g oknviig Modify—>Movie—>Properties
3. Nao ewobyete T1¢ ecOVeES 61O Cast e TN mapakdve cepd.

;7 HEEYE

— | 774 :;*J'/ ——#
|| e—
V4 — 3

t

4. Evepyomomote to xovuni Hide/Show Effects Channel T £T01 MOTE TO
KavéAl puOuov va eival opato.

5. Auhé Kk oto mhaicto puBuov yia va avoitete to mapdbupo dtaddyov Tempo
Kot kobopiote to ota 10fps.

Frame Properties: Tempo

@ Tempa: [ | GI¥] 10 fps QK
1 W ai: seconds | Cancel

00wt ait For Mouse Click or Kep Press

(71w ait For Cue Paoint;

Channel: | Sound 1: Beauty & Cue Poink: | Mext Help ]
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6.

7.

8.

9.

Meragpépete to uédog 7 (Bground.jpg) tov cast oto mhaicio 1, kovéir 1 oto
score. ®povrtiote va kabopicete To mAaiclo télovg ota 30.

Metagpépete 10 pélog 5 tov cast(Folderl.jpg) oto xavail 2, miaicio 1 tov
Score.

Me emideypévo 1o €idmAo avtd, emiééte epé Meldvng Matte Tlov givon oto
sprite oto ink

Y1 oknvn emdé€te to eidwio Folderl kot petapépeté To 6TV KAT® aploTepy

TAEVPA TNG OKNVIG.

10. KAk oto mhaicwo 1, kavdil 3 oto score. ‘Eneita petapépete to pérog 1 tov

cast(Docl) otn oknvn, £tol GoTE Vo KOAOTTEL TOV QAKeEAO. Av ypetaleTan,
YPNOYLOTOUOTE TO TANKTPO. BEADV Yo va, To Pddete otn BEOT TOVL.

Ortav petogépete eidmia otn oknvn , o Director ta tpocbétel oto endpevo d100écipo
kavait. O Director npocOétet eniong to €idwAa oto score, apyilovtag and to TpEYOV
mAaiclo. Av kdvete KMK 6to Kaval 3, mAaicto 1 1o €idwio tonobeteitan oe vty ™)

0éom.

To Docl eivor to xoppdtt yopti mov Ba metdéel £€® amd Tov dkero. Mmopeite va
dgite 10 AoTPO POHVTO YOPW Omd TO YOPTL, OTOTE OALAETE TO EQE LEAAVNG.

11. Me emreypévo to Docl, kabopiote epé Mehavng Mattte oo to pevod Ink.

12. KAk ot0 mhaicto 1, kavait 4 ko petagépete to uédog 6 tov cast(Folder2) ot

13.
14.
15.

16.

oKnvl kol Tomofetnote 10 emdved oTo ldmA0 @akéAOL Kol YoPTLOD.
KaBopiote mdAt g@é peldvng yia to dompo pixels yopw omd v eikova.
Onwg deiyver n ewkdva:

b
ik
:

Av16 givan T0 emdve pTepO TOoL PakéLlov. To omoio eivan To péhog tov cast oto
Kaval 4.

Topa Bo dnuovpyncovpe Eva avtiypapo TOV SUCTPOUATOUEVOV EWDOADV Yo
Vo OMILLOVPYNCETE TOV PAKEAD TTPOG TOV 0Toio B meTd To YapTi.

Amobnkevon g epyaciog

EmiléEte ta kavaha 2 wg 4.

TomoBetnote TOV deikTn MGV 6T EMAEYUEVA Id®AN, Tatdte To mANKTpo Alt
KOl UETOPEPETE TNV EMAOYN O0TO KOVAAL 5. Kotoémv agnote 10 kovpumi tov
TOVTIKIOV Kot to Alt.

Me to avtiypago Tov QaKEAOL Kol TOL YapTov(kavdia S5 og 7) axoun
emieypéva, Petaépete ta otV 0e€1d mAevpd ™ oknvng. Tlatdte to TAKTPO
Shift 6nog o petapépete oplovria.
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17. 210 score emAélte 10 €idwA0 010 KavAAL 6 kol Saypdyte T0. AVvTO gival TO
deVTEPO KOUWATL YapTi 0TOV OeVTEPO (PAKELO. dEV TO Ypeldleote , emewdn Oa
EPYOOTEITE LE OLTO TO KOUUATL YOPTL OTO KOVOAL 3.

18. Enekteivere ta eidoia 2,3,4,5 kot 7 uéypt 1o mhaicio 30.

Tdhpa Ba Snpovpyncovpe TV Kivnon Tov yoptiov.

19. oto score, kdvte KMk 610 mAaico 1 kavdAlr 3. Oa aphoete T0 €id®AO TOL
yopTov exel Tov givor oM TomoBeTnuévo, emeldn N kivnon Ba apyicel and exet.
> oknvh Ba deite Ot éva eldwAo givorl emAeypévo, and 10 TAAICIO KOl TIG
AaPég ov Ba eppavictodv. To emdeypévo avtikeipevo ivar to yopti, oAAd dev
umopeite va 1o dgite ylorti PpiokeTon SOCTPOUATOUEVO KAT® Amd TO EMAVO
LEPOG TOL PUKEAOV.

20. oto Score, kavte KMk oto mAaiclo 10 kavdir 3(to yapti) kot gl6ayeTe Eva
(Keyframe)miaicio kietdi.

21. Me emideypévo oaxkoun To miaico KAeWwl oto mlaicwo 10 kavaar 3,
ypnoponoteiote to TANKTPo Endve BEAOVG Yo va LETAKIVIGETE TO XOPTL TPOG
to. emdve. Otav Ppioketon endve omd TOV QOKEAO WITOPEITE VO TOTNGETE TO
mktpo Shift kot ypnolonTOIGVTOC TO TOVTIKL VO TO UETOPEPETE AKOUN 71O
mivo(1 omAd cuveyilete va 1o HETaPEPETE e TO TANKTPO Emdve BELovg).

22. 10 score, kavte KAk oto mhaicto 20 kavdir 3 kKot elodyete mAoicto kAEdi

23. 2 oKknVN UETAQEPETE TO €IOMAO TOL YOPTIOD £TGL OCTE VO €lvVOL ETOVED
aKPIPOG Ao TOV PAKELO TPOOPIGLOV.

24. oo score kdvte KAK 610 TAaicto 30 kavait 3 Kot atcéwsis 1;%&{010 KAELL.
25. Zn oKNnv LETAQEPETE TO EIOMAO TOL YOPTIOD TPOG T KATW DGTE VO, vl KAT®
amd TOLG (QUKEAOVG TPOOPICHOV. XPNCIUOTOMOTE TA TANKTIPO PeA®dV av
yperaetal yo v TomofETnon Tov.
Mepkég popég elvar ypnoo va PAETETE HOvo éva HEPOG TG Touviag oag. Avti va
avamopayete OAn tng towvia yuo va mpoPdiete éva emieyuévo puépog g Kivnong,
umopeite vo emAéEete poévo to mAaiclo ota omoio BéAete va emikevipmbOeite. H
AVOTOPOY®YY] EMAEYUEVOV TAOICIOV NG Towviag €ivor pia omodotikn HEB0dog
OVTILETOTIONG TPOPANUATOV, TOL UTOPEITE VO YPTCLOTOIGETE Y10 VO, CNUEIDCETE
o, mAaiclo pog Kivnong mov dev  gpgovifovior O ta 0éAete Kot TNV
OVOTOPOY®YN TNG TOVIOG.
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26. KAk 670 SCOre yio va to kavete evepyd kot emAé&te omd To pevov Edit—>Select
All xou énerro. Edit->Edit Sprite Frames . H emoyn Edit Sprite Frames
evepyomolel £vol YOPOKTNPIOTIKO TOL GOG EMITPEMEL VO, EMAEEETE PUEUOVOUEVQL
TAOUG10 TV EWOOAMY TOV TOVIGOLLE.

27. oto kavd 1, emiééte Ta mhaiowa 15 €wg 30.

28. 'Eneita. epgaviote to Control Panel(Window->Control Panel) kot kdvte xhik
oto Selected Frames Only kot 6to Loop Playback.

Orav o Director kafopiotel vo avamopdyel povo emleypéva TAaicLo, o Tpacivn

ypopp epeaviCeTol KAT® amd TO TPAOTO KAVAAL GTO SCOE Yo VoL ONAMGEL QVTA TOL

TAaicoL.

29. kavte KAk oto play. ‘Enetra kdvte KAk oto Selected Framed Frames only yw
VO 0QOLPECETE TNV TPACIYN YPOUUN Kot xpnotporotote to Control panel ya
va EQVATUMEETE KOl VL avomapdyeTe OAN TNV Tovia.

30. o score emA£ETe OAa Ta €IdMAN 6TO KOVOAL 3

31.'Enerta. emAéEre Modify—> Sprite>Tweening ywo va kavete tv kivnon 7o
oA, Yy’ avto kabopiote to deiktn Curvature ot cwot 6éon.

32. ZEavartvAi&te ko Play v touvia.

To yapti ocvveyiler va mmyoaivel micow oand Tov @dkelo mpoopiopov. To
TPOPANUa eivon to eminedo ota omoia Ppickovtarl Ta Kovail: To yopti givol
070 KOVOAL 3, 0AAL TO ETAV® HEPOG TOV SEVTEPOV POKELOV €ival GTO KOVOALT
Kol T0 KAT® pHéPog tov givarl 6to kovad 5. Emeldn kot ta 600 eldwia pokéAwmy
elval og kovaMo pe peyoldtepovg aptBpovc and to €idwAo Tov YapTIoD, TO
YopTi eaiveton va Tepva TANP®S Tiowm amd tov eakero. [Ipénel va petakvnoete
Kamolo amd To EI0MAN GE SLOUPOPETIKA KOVAALAL.

O amloboTEPOg TPOTOC elval Vo PETOPEPETE £Vl EMAEYUEVO €I0MAO GTNV VED TOV
0¢omn. Mropeite va 10 Kavete avtd POVO oV T0 KOVOM TPOoPIGHov givor kevo. I va
avadlotdéete To l0mAN GTO SCOre aKOUN Kot 0V OEV VITAPYOLV KEVE KOVAALQ, ETIAEETE
v evtoAr; Modify->Arrange. Mnopeite va ypnoIUOTOWCETE €MIONG TO. TANKTPO
Endvo kor Katow Bélovg yia va emitvyete ta ido amoteréopoto. To Ctrl+Endvem
Bélog petokivel ta emieypéva idmia mpog ta gunpdc ot oknvn, To Ctrl+Kdatm
Béloc petakivel ta emAeypévo ei0mA0 TPOG TO TIGM GTI GKNV).

33. o score emAé€te Ta mAaiowa 21 wg 30, oto Kavaal3

34. Tlatote Ctrl+ Endveo Béhog emavalnmrikd péypt ta emieypévo miaioa vo
Bpebovv 010 Kavai 6. Xto upvoua tov Director wov gpgoviCel emiéEre OK

35. Avamopdyete tnv towvia kot Play yio va deite 1o amotédespa. To yapti pumaivel
0TO 6MOTO EMMEDO KO TEPTEL LEGOL GTO PAKEAO.

36. 10 score emiéste Ta mAaicwa 21 ¢ 30 Tov elddAoV ota kavdAla 3 Kot 4.

37. Metakivelote Ta emieyuéva eidwia ota miaiowa 21 wg 30 ,ota kavala 4 Kot
5, ypnowonoidvrog Ctri+Emdveo Bélog.

38. AmoOnkevote TV epyacio cog.

39. Z10 score emiéEte 1o mAaiclo 2, kavdA3 koi oto cast emAéEte to pEAOG
2(Doc2). ‘Emetta. ot ypopun epyodeiov tov Director kdvte khk 610 xovumi
Exchange Cast Member.

[Ipéner va deite Tov apBpd 2 oe owtd 10 KEA. AV 0ev 10 Ogite T0TE emAEETE

View->Sprite Labels—>Changes Only.
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40.

41.
42.

43.

44,

45.
46.

47.

Awpopeadote v TPoPoAny  kaTAAANA0.  oto  SCore  emAéyovtag
View—>Zoom->200% yio. peyébovon.

0710 Score emiééte mhaioto 3 kova3 kot avtadAddste o pe To péog 3 tov cast

010 Score emAééte mAaiowo 4, Koval 3 Kot avtoAAdETE TO PE TO HEAOG 4 TOV
cast

EnavalaBete avt v dwdikacio avtolloyne péExpt va €xete aAraEel v
axolovbia 1,2,3,4 yio 6Aa ta €idmwAo 610 KOVOAL 3.

EvoAldEre ta puédn tov cast oto koavai 6 pe v idw oepd (oto Prua 43),
miaiola 21 wg 30.

Avamapdayete ko Play v towvia cog.

Ewodyete oto cast éva véo péhog , dnA. éva apyeio povowkng *.mp3. Avto Ha
elvar o pélog 8 tov cast.

Emé&re to pélog 8 tov cast kar kévte khk oto Cast Member Properties, exei
ToEKAPETE TO TANiG10 Tov Loop kot OK

£ ¥ Property Inzpector i=

Beauty Eeauty And The Beast- Be Our Guest

d The Internal _
peas € = @
Sound
Loop . B

DOwration: 0:06:56.626
Sample Rate; $4.100 kHz
Eit Depth: 16 bits
Channels: sterec

48. Metapépete 0 péEAOG 8 tov cast oto mhaicto 1, kavdAl yov 1 tov score kot

kaBopiote Ta TAaicia téAovg ota 30.

49. Amobnkedote Vv gpyacia cog Kot Play yia va deite 1o amotédeopa.

5.9 Xvumeprpopd Kot TPOTONOINGT GLUTEPIPOPAS

Mmnopovpe  vo mpocBécovpe OSHAOYIKOTNTA YPNOLLOTOIOVTINS TOV emBe@pnTN
ovumepipopdg(Behavior Inspector), mov cag eMTPENEL VO YPAWOLE GKPITT Y®PIG VoL
ypewdletal vo TAnKTpoLoyeite T evioAég Lingo povol cag.

Ta okpurt mov dnpovpyovpe pe tov Behavior Inspector ovopdaloviol cupmeprpopés,
EMELON YPNOLULOTOOVVTAL KVUPIMG Yo VO, 0pIGOVY TV GLUTEPLPOPE oToLyEiwV HEG
oTNV ToWvio GOG, Y. TOV TPOTO OV £val KOLUTL AmoKpiveTol OTOV KAVETE KAK 1 TIG
EVEPYELEC IOV YIVOVTAL OTOV 1] KEQOAT] OVOTOPAYWDYNG EICEPYETAL GE 1} Pyaivel amd éva
OLYKEKPIUEVO TAOIG10 GTO SCOre.

Mo cvpumepipopd aroteheiton omd Tpia focikd otovyeio:

To 6vopa copmeprpopds coc fonda va avayvopiceTe TNV GLUTEPLPOPA.
To ocvpPav eivar n epedvion oy tovio TOL EKKIVEL TNV GLUTEPLPOPAL.
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H evépyerwo eivor to okputt mov ektedei o Director oe amdkpion oe éva

ovuPav.

Xe avtn TV gpyacia Ba dnuovpyncovpe Vo eldwAN TomobeT®VTOC Eva LEAOG TOV
cast ot oknv 000 oopéc. ‘Emerta Oa  ypnowomomcovpe v PiArodnkm
CLUTEPLPOPEG YIoL Vo EMAEEETE UL CUUTEPLPOPA KOl VO TNV EQUPUOCOVE GTO
eldmAa pa v Qopd kol vo O0VUE TO OmOTEAESUA. XTn cvvexewn Bo udbete Tdg

Umopeite vo epapprocete TPOGHETEG GLUTEPLPOPES Kot VO OAAAEETE 0VTEG OV €XETE
avabécel NoN péca og €va £pYo.

1.

2.
3.

8.

Anpovpyeite o véo towvioa File>New—>Movie kot v omoOnkedete mg
Aocxnon9.dir .

KabBopiote to péyebog g oxnvic Modify—->Movie—> Properties

Noa glodyete T1g ikdveg mov Ppiokoviol 610 PAKEAO aoknon9 avicTtoyo 6T
péAn 1 ko peAn?2 tov cast.

.._.'_:J--.-'. b | ] II'...I|

xl®,

CARTOON M| eyebsll?z |

I 1T 1T

Metagépete to pédog 1 tov cast oto mhaicio 1 kavdil kou otn oknvy
tonofetnote o otn péon. Eeapudote epé Mehavng background Transparent

O TNV AVOTTUGGOUEVT MoTO €PE PEAGVIG OtV YpapuT epyareiov El0dAwV.
wi|22r M| 27

Ink.: | Background Transpare - |

Metagépete 10 péAog 2 tov cast dvo popéc, dnA. oto mAaicto 1 kavdil 2 kot
miaicto 1 kavéi 3. 'Eneita S10pop@dote KoTAAANAO To VO EI0MAN «LOTION
oTN OKNVN Kot TorofeTioTe Ta G PATIo 6To £i0A0 TOL cartoon man.

Kabe eldmro pmopet vo €xel 10 d1kO TOL GUVOAO GULUTEPLPOP®V, ONA. KaOE
eldA0 umopel var GUUTEPLPEPETAL OLAPOPETIKA ATtd TO GAAO 1 LTOPOVV KOl TOL
d00 VO GUUTTEPLPEPOVTOL LE TOV 1010 TPOTO.

EmAéEte T 000 €idmAa pHoTIOV KavaAle 2 Kot 3 Kot EQAPUOCTE EQE LEAAVNG

Matte amd v oavortueoouevn AMota @€ HEAGVNG OTNV YPOUUN EPYOAEI®V
Ewoiwnv.

Ink: | Matte = | 1

EnéEre Window-> Control panel yia va to avoi&ete ko kdvte khk oto Play
Y10 VO AVOTTOPAYETE TNV TOLVidL.
[Tapatnpeite 611 dev cupPaivel Timota 6T CKNVY).

Amobnkedote TV epyacio cag.

Oa mpochEcoLE U0 GUUTEPLPOPA Yo VO KIVIGOLUE €va €IdmA0 pésa amd TV
Library Palette kot peta@épovidg v endvm 6To i0mA0 1| 6TO KOVAAL EBMAOV.
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9. Emé&re Window-> Library Palette. Edd pmopeite vo emdééete avaueca oe
TOAMAEG KT yopies O100ECIU®V CUUTEPLPOPDOV.
10. EmAéEte Animation-> Interactive om6 to pevoo.

Library |
ﬂ = Biehaviors - Interactive
Components

[i a0 3 = Awoid Sprite
: Accessibility B

Cantrols v Interactive
Inkernet b Sprite Transitions Hlcins
Media 3 = . -
A . raqgto ocale
Mavigation y? 4
. Painthox e
Flip r.t,~ Draggable
Texk P 1
el
T v Show Mames =T Mowe, Fotate and Scale
ra

11. kGvte kMK ot0 BELOG KOAONG KAT® 0T0 KaTt® uépoc tov mapdbvpov Library
Palette péypt va eppaviotei n coprepipopd Turn Towards Mouse.

12. Kévte kMK oto €kovidlo g ovumepipopdg Turn Towards Mouse ko
LETAPEPETE TO EMAVD GTO £IOMAO E:)gég(_)__l:) patov(péAog3 Kavai3).

,.+._ I
"h-_-.i: %
[Turn Towards

L L
13. %10 mopdbvpo OwAdOyov  Parameters umopeite va  kabopicete

TPOGOPLOCHEVEG pLOUiceElS Yo TV cvpmeplpopd. Ondte emdéEte “towards

the mouse”, “always”, “remain in the new position” kot OK.
Avt n ovumeppopd Bo KAvel TO €IOMAO HATIOL VO TEPIOTPEPETOL KOl VO

«PBAémey O TOVTIKL, OTOV TO TOVTIKL LETOKIVEITAL ENAVED GTNV OKNVI. AV dgv
Béoete ™V ocvumeplpopd «va. mapapével otny véa Béomx»(remain in the new
position) tote N €1KOVA TOL PATION Oo EXAVEPYETOL GTNV APYIKN TNG KOTAOTOOT
O6tav 10 movTiKL oTOpaTd TNV Kivion TOL.AVT 1 VEX GLUTEPLPOPE ELODAOL
tonofeteitan cav éva véo pélog tov cast, uéiog 3. To Ovopo tov oto cast
eaivetat oav “Turn Towards”(cvvtopoypaeio tov “Turn Towards Mouse”).

14. Avamapdyete TV TOVio GOC KOL OYOALAGTE TO OTOTEAEGLAL.
15. Anobnkebdote TV epyacia cag.

Me T1g cvumeplpopés pmopeite vo kdvete kivion péoca o€ évo mAaiclo o 1010
ebKoAo ToV pmopeite va Kavete kivnon pésa og 30 miaiocto. Av vt 1 Kivnon frav
LEPOG €VOC HEYAADTEPOL £PYOV, DOl UTOPOVGATE VO EPYOCTEITE MO EVKOAN LE TO
£pY0, KPATMOVTOG TO SCOre 660 10 dVVATO MO GUUTAYEG,.
16. Xto score ocvumiéote ta Tpia ldAN pHEca o€ Eva LOvo TAicto, ONA. emAEETE
T KovaAtle 1,2 ko 3 ko 0éote mAaioto télovg Ty 1.

17. kGvte KMk og £va un Kotelnuuévo kel oto score ko ovoi&te tov Behavior
Inspector emAéyovtag Window->Behavior Inspector.

68



18.

Avotyel éva kevo mapdBupo. H emhoyn evdg kehol mov dev ¥pnoIUOTOIEITOL GTO
score, mpwv to Gvoryua tov Behavior Inspector mAnpogopei tov Inspector ot
ONUIoLPYEiTOL UL CLUUTEPIPOPE TOL SCOre Kot Oyl MO GUUTEPIPOPE TOV
gL0OA0V.

KAvte KAK o010 kovumi Xvumepupopdc kot emhéEte New Behavior. Xto
napdBvpo New Behavior ovopdote v véa cvumepipopd Hold kon kavte ki
OK.

Behavior Inspector

* - &=
Turn Towards Mouse [Internal] myOrientation:“toward... N £a au |'-'] n EF:H {_DGQ d
Hold [Internal] -
Koupni ZuppavTocg
e +

- -

exitFrame wat:TE’/’ﬁ

uuni Evepysiacg

19. kavte KAk 610 Kovuni Event ko emiéEte EXit Frame. Kavte KAk 6to kovpmi

20.

Action ko emAéEre Wait->0n Current Frame. O Behavior Inspector deiyvet
TG EMAOYEG GOG,.
H ocvumeprpopd dnpovpyeitan ko torobeteiton ocav péhog 4 tov cast.

jom exitF rams

m e
E]
m
5

Y& avtibeon pe aAdeg ocoumepipopés , N ocoumepipopd Wait on Current Frame
dev ypetdleTar va cog (ntd va dnpovpynoete Tpocapuocsies 101otntes. H povn
™G EVEPYEWDL €Vl VO KPOTO TNV KEPOAN OVOTOPUY®OYNS, MOTE VO PNV TEPVE
népa amd avTo T0 TAiG10, eMPAALOVTOG TNV ovoia Eva atelehtnto Bpodyo 6To
TAOIG10 GTO 01010 YPNCILOTOIEITOL.

Y10 cast emAéETe To pEAOG 4 OMA. TO VEO HEAOG CLUTEPIPOPAS KO LETAPEPETE
T0 67O TOPAOLPO TOV SCOre 610 MTAiGo 1 TOL KAVAALOD CLUTEPLPOPAES.
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21. Avomapdyete TNV TOvio Kot LETOKIVAGTE TOV OEIKTI TOV TOVTIKIOD EMAVED GTNV
006vn.
O Behavior Inspector eivor ypriowog 7y onuiovpyia, TpoOmOTOiNON KO
embedpnon copmeplpopdv. Xto Score PePormbeite 6t gppaviCetar n ypouun
EPYOAELDV ELODOAWMV.

22.emAéEte TO0 €l0MAO OTO KOVOAM GCULUTEPLPOPAS KOl KOAVIE KMK OTO KOLUTL
Behavior Inspector.Avoiyet to mopabvpo Behavior Inspector mov éxet epedvion
mopOpolol HE OVTH TOL gixe OTtav  dnpovpyncate v ocvumepipopd Hold
TPONYOVUEVEMG.

23.x6avte KMk oto kKovuni Tkpirt otov Behavior Inspector.Ilepiéyet tov kddwka Lingo
Y10 TNV GUUTEPLPOPAL.

i

KOUUN ZupnEpgupopoc KOUpm EZKoInT
F’!‘ZI

oy = fam -

wmeF s A ol st o Casirera Frames

25. khelote 0 TOpabupo Zkpurt ko Tov Behavior Inspector. ‘Eneita emAééte 1o
eldmAo o100 KavdAl 2, ONA . 10 €ld®WAO0 TOL pOTOD 7OV dev £xeEl i
OCLUTEPIPOPE TTpoGOPTNUEVT O aVTO, Ko avoiéte mol tov Behavior
Inspector

26. Kavte KMK 610 Kovpuni vpumepipopdg kot emAaé&te Turn Towards Mouse
27. xAeiote Tov Behavior Inspector kot avamapdyste tnv tavia.
ue 10 €idOA0 oTO KOVAAL 2 okOun emAeyuévo eueoviote mdAr tov Behavior

Inspector kot kavte kMK oto kovumi Ilopapétpov, dimia oto Kovumi XKpurt.
YPNOWOTOUOTE TO. OVOOLOUEVA LEVOL 6TO TapdBupo dtaAdyov Yo va Béoete Tig
TOPAUETPOVG TG EIKOVOC.

Parameters for “Turn Towards Mouse"

[t llowards the mouse |

|| Cox ]

[«

\always

[|£

e

Otherwise gremain in the new position W

28. Na avamapdyete Kot vo omodnKevoTe TV £pyacio oog.
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5.10 IIpocapuocuévor dpoueig

Ymv mapovca epyacio o aAldovue TNV EUEEVIOTN TOL OpoUEd, MOTE Vo
amokpivetor oe éva ovuPdv. To AelTovPylKE GULGTAUATO VTOAOYICTAOV GOV TO
Windows ypnoipomolovy pie ypo@ikn SlecOVOEST ¥PNoTN Kol 0. GUOKELN
KATAdEENS, cLVNOM®G £va TOVTIKL, TTOL EMTPEMOVLY GTOV YPNOTY VO EPYACTEL LE TOV
VTOAOYIOTH e €éva onTikd Tpdmo. O SpOopENG TOL TOVIIKIOD, TPOEMAEYUEVO EVOG
piKpog deiktng pe oynua fELovg, ONAdveL oTov ¥protn Tov Ba yivel kdmolo evEpyeLa.
Y& TOAAEG eQPOPUOYES OUMG , TO OVTIKEILEVO OTO OTTOT0 UITOPEITE VL KAVETE KAK OEV
powalovv pe TO TOPAOOGLOKE KOLUTIG- €101KA ©€ 16T0GEAMSEG. Mmopovv, yia
napadetypa, vo potalovv pe o gikova 1 keipevo. ‘Evag and tovg tpdémovg mov EEpet
évag ypnotng 0Tt umopel va yivel KAIK o€ pia 0éom givor 6t 1 €kdva Tov dpopéa
aAAGCel, Otav TepVA ETAVE amd vt T 0o

Ye auth Vv gpyacia Oa mpocBiécete mANpoPopieg Yoo vo KAveTe Eva dpopén
va aAAGCel epedvion Otav mepVE emavm amd Eva €l0mA0, TOL £YETE TOTOOETNOEL GTNV
oknvi. Avalntote to Google Ewdveg dvo potoypapieg pe 0éua Ioupoteyvipata kot
glodyete 1§ oto cast tov Director.

1. Anuovpynote pa véa tovio Kot amodnkedote TNV 6ToV PAKELO GOC.
2. Orpotoypagieg mov gicdyote oto cast omorskouv To pEAN 1 won 2.

(L4 e L Je=r |
eikorinc | silonina’?

3. Emdé&re 1o péhog 3 tov cast kaw Window->Paint y va eupavicete 10
avtiotoryo moapdbvpo Kol va oxedldoete Eva YEHGUEVO 0pHOYDVIO LE YPDULOL
kokkwvo. Ovoudote To avrtikeipevo owtd oto cast Background.

4. Meragépete to uéhog 3 (Background) oto mhaicto 1, kavair 1 tov score.

Me emleypévo 1o €idmio avtd kavte KAk otov Behavior Inspector 1 av dev

enpaviCetan emiéEre Window—>Behavior Inspector.

Topa Ba dnpovpynoete ot CLUTEPIPOPA Yoo Vo aAAGEETE TOV dpouéa TOV

TOVTIKLOV, OTaY TEPVE eTGvem amd to €idmwio Background oty okmvi.

6. exel emAélte 10 Kkovumi Xvumeprpopdc kot emthoyn to New Behavior,0dote
ovopa Cursor In ko OK H véa copmepipopd eivan to uskog 4 tov cast.

v LOO0E B enavion INSpecror

o

Behavior Inspector

+ S

x

B ehavwvior ngup'ﬁl] Score Behavior

7. Amd 1o avadvopevo pevov Xvupaviov emiéste Mouse Enter kou amd to
uevov Evepyeiov emaéEre Cursor->Change Cursor->Hand—-> Ok

Erchavior Inspectar

+ o S

Cursor In (Internal] Score Behavior

-

+ - | o+

mouseEnter Change Cursor ko ZE0Q
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O

dpouéac Hand givar evoopotopévog dpopéag kot éxetl tov aptduod 260, onote to

napdBvpo Evepyeidv deiyver “Change Cursor to 260”.

8.

9.

10.”

11.
12.

Y10 Control Panel xévte xlk oto Loop Playback yiwn va emavainefei n

OVOTTOPOY YY) TNG TOVIOC.

[Mopatnpeite 6T 6tav 0 deiktng TOV TOVTIKIOD lvar £€® 0md TO €I0WAO TOV

opfoymviov oev oAAGler , evd Otav  eloépyetar  P€co OTO  EIOMAO

petapopemvetol o€ xépt. To mpoPinua mov vrdpyel eivar 6Tt cvveyiler va

elvar xépt Ko £E® amd 10 €10wA0. AVTO TAE VO TO OAAAEOVLE .

Eneta emAééte 10 €idmwAo oto kaval 1 ko avoi&te tov Behavior Inspector.
Anpovpynote pio véa Zvumeprpopd pe 6vouo Cursor Out, oto pevov
YouPdvtov emréEte Mouse Leave kot oto pevov Evepyeidv emiéSte
Cursor->Change Cursor->Arrow—>OK.

Avamapdyete TV TOvio Kol GYOAMAGTE TO ATOTEAEGLO.

Amobnkevote Vv gpyacio Gog.

211G TEPIOCOTEPES EPUPLOYES TOL OVTIKEILEVO TNV 006V £Y0VV «KAVOVIKO» Gy
Suyva givar opBoydvia kol peptkég popég KOKAoL 1 kat eAleiyelc. Otav apyicete va
ONUovpyeite O TEPITAOKA YPOPIKA OGOV AVTIKEILEVA €Nl TV OMOIMV UTOPEiTE Vo
KaveTe KMK, TPEMEL VoL LEAETNGETE MG TAL OPOTAE TOLG GYNMOTA GYXETILOVTOL LLE TO TL O
VTOAOYIOTNG Bewpel oynua kot péyebog tovg M TIg mEPLOYES oproBéTong Tovg. Xe
avt Vv gpyocio Bo Ttomobeticovpe €va avVTIKEINEVO HE aKAVOVIGTO GYNUO GTNV

006vn

kot B gpgvvnioovpe TV TEPLoyN oploBétnong dmov pmopel va yivel KAIK 610

OVTIKEILEVO.

13.

Y10 cast kdvte KAk oto pélog 3(Background) kot avoite to mapdabvpo Paint.
Exel oyedidote kot dALo éva opBoydvio kdBETO GTO TPAOTO.

=

haclground

14."Enerta xheiote 10 mopabvpo Paint ka1 emiéEre Modify—>Movie—>Properties

15.
16.
17.
18.
19.
20.
21.

22,

23.

ywo. vo. kKobopicete to ypodpo oknvig o€ Stage Color->Black.

I'o 1o gidwio tov Background pélog3 spapuoote epé pekdvng Matte.
Avamapdyete TV TOvio Kol GYOAMAGTE TO ATOTEAEGLO.

AmoBnkevon g epyociog cog.

oto pélog 3 tov cast kavte kKik ko emlé€te Edit-> Copy Cast Members

"Enetta emucoAAnote 10 610 PHEAOG S Ko 6 Tov Ccast.

Avoi&te 10 mapabvpo Paint kot 6OGTE SL0pOPETIKO YPDLLOL Yo To LEAN 5 Ko 6.
Ovoudote to péroc 5 Mouse Over kot to pédog 6 Mouse Down. Kieiote to
napabvpo Paint.

R AN RS

==

Mousa D".'.ar Mouse Down
EméEre Window->Library Palette kou ypnowonomote 1o kovuni Library
List-=>Controls.
Befowwbeite 611 10 €ldwro eivon emheypuévo oto koval 1 tov score xai
HeTaQEPETE TN ovumepipopd Push Button amd t Library Palette oto €idwio
péca 6to Score.
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o
.

Push Button

24. Y10 mopabvpo dwwddyov mov epeoavilel Oéote pélog Standard: Background,
uéhog Rollover: Mouse Over «ow pélog Mouse Down: Mouse Down kot

emiéEte OK yia va Kielogte to mapdBupo d1addyov.

Parameters for "Push Button” =
- GRAPHICS - Standard member for sprite | background -/ [ oK
Rollover member [Mouse Over *‘ | cancel
MouseDown member ’Mouse Down *‘
Disabled member | Mouse Down - |
- INTERACTION - Button is initially | Active -
Sprites which cover the button l block all mouse events = ‘
Action on mouseUp [sendAlESpntes *‘
YourCustomMessage

25. Avamapdyete v Tovia .
26. AmoOnkevote TV gpyacio cog.

5.11 Kavéiio Ahpo

Y10 mponyoOUEVE HOONUOTO EPYOCTAKOTE HE HEPIKEG OO TIC MEAAVEG
eld®Awv tov Director. H 1316trta pekdvng evog eldmiov kabopilel nog o Director Oa
EUPOVIGEL TNV EIKOVA TOV EW0MAOL EMAVD o€ GAAN EidmAN OV ivan amd kdtw tov. H
uelavn Copy onpaivetl 0TL N ekdva avtypdoetor TAnpwe. H Background Transparent
KAVEL TO XPOUA POVTOL VOGS ELOMAOD 0OPATO, EMTPETOVTING GTO EI0MAN GTNV GKNVA,
KAT® amd avtd, vo EUEOVIGTOOV HEGH omd TV TEPLoy] eOvVTov. AANEC HeAdveES
LITOPOVV VO GOG OMGOLV E0IKA €€ ypoudtov | cav v Blend, va avapiovv 6in
TNV €IKOVA UE TIG EIKOVES TTOL £ivat omd KAT® TNC.

H Blend eivar yprioyun peddvn. Mmopeite vo 0écete 1o piypo yio 6lo 10
eldwAo pe Tipég mov mowkidovy amd 0%, oyt avauén, péxpt 100% manpng avapuén.
Mepicéc popéc Oumg iomg va ypelaleote akoun peyorvtepo €ieyyo. Ily.: icwg va
0éhete OLOPOPETIKES TTEPLOYEG NG EIKOVOG VO £XOVV SLOPOPETIKEG TIUES OVAENG.
Towg va Bérete T0 KEVTPO NG EKOVOS VO UV €xel KaBOAOL avapiEn Kol To. AKpa NG
va €ovv AP ovaén. o va ypnopomomoete éva tétolo €€, Ba mpémel va
OpicETE M0 LACKO KOl VO XPTCLUOTOMGETE U0, 01KN LEAGVT] OV KoAgitol peAdvn
Médoxoc. H pehdvn pdokog cog emTPENEL VO TPOGOUOIDGETE OVTO OV £ivVOL YVMOGTO
ocav Kavai Aipa.

o va katovonoete 10 KavadAl AAQO TPEMEL VO KOTOVONOCETE TMOG
ypopotilovron Ta ypaekd bitmap. Mo tAnpng ewdva bitmap 24-bits £xet tpio AN
Kavalo xpdpotog: éva cvotatikd Kokkivov 8-bit, éva ocvotatikd Tpdowvov 8-bit kot
évo. ovototikd Mmhe 8-bit. Avtd ta tpia cvotatikd opilovv tig tuég RGB (Red-
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Green-Blue, «koékkwo -mpdowo-umie) poag swkovag. Kabe Pixel oty ewova
meprapPdver o T yio Kaféva and to tpio kovaho ypopatog RGB. Kdabe tiun
RGB pmopei va givar otnv meproyn 0 emg 255. Otav ko o tpio kavdiio evog pixel
€000V o€ 255, 10 ypdOUA TOL glKovooTolyEiov gival dompo, encwdn to Kokkivo, 1o
[Ipdowo kot 0 MmAe givar Oha 6TIg PéYLOTEG THEG TOVG. AV HOVO €val KOvOAL glvat
255, my. to Mmhe ka1 ta vwoAowma givor 0, To ypodpo givor Made yia owtd to Pixel,
eMeON HOVo to KoviA Mmie mepiéyet o tun. Emedn kabéva and to Koxkivo,
[Ipdowvo kot Mmhe pumopel va €xet Tpég amd 0 ¢ 255, vmdpyel o peyaan ykdpo
YPOUATOV, EKATOUUDPLOL YPDLLATA.

‘Eva Pixel pmopel vo éyel évo 1€t0pto 0LGTATIKO, TO KOVOAL Al@o, 7OV
ypnoponotel 8-bits axoun(yia va £xovv éva covoro 32-bits yio v eikdva). Avtd 1o
Kaval pmopet va BewpnOel eniong cov to kavdil avapuéne. ok, kabe pixel propsei
va Tipég amd 0 og 255. H tyun avth kabopilel v mosdta TG avapiEng mov TpEmet
va epappootel yio owtd to Pixel 6tav cuvtibeton 1 cuyymvedeton pe pio GAAN KOV,
[Tape Tdpa otV doknon .

1. Avoi&te tov director kot omoOnkevote TV £pyacio 6og 6TO PAKEALD GOG MG
Epyacia 9.dir

2. Ewdayete myv ewdévo tov TalMayor pe tmv oupiyAn oto cast, péiog 1.
Metapépete 10 pérog 1 010 mhaicto 1 kavdirl 1 Tov score.

Em\éEre Window—> Text yuo va avoiéete to mopabvpo Text.
4. g avtd 10 mapdbupo, aArdéte 1o péyebog ypappatocelpds oe 36 ot. Kot

epapuoote ‘Evrovn ypaoen. Eneito minktporoynote taj mahal .To avtikeipevo
avtd £ywve 10 PéAOG 2 Tov cast.

w

S

||

mi mahal
o A

t3) mahal taj text

5. Metagpépete 1o péAog 2 tov cast oto miaicto 1 kovai 2 tov score. ‘Enetta
OTN OKNVN UETAPEPETE TO €I0MAO0 TOL KEWEVOL GTNV OPLOTEPT] TAELPE TNG
GKNVNG.

6. Ewodyete mhaicio kAedl yia 1o pérog 2, oto mhaicto 30 kavd 2.

7. Totnote 1o mAnktpo Shift ko petaeépete 10 €idwio oto 6e€10 Gkpo TG
OKNVNG, 0TV TEAIKN BE0T TOV E10DAOVL.

To eidwro petakveitan og evbeio ypappun tpog ta de€id, eneld| TaTOVING TO
mnktpo shift evd kdavete v petapopd , mepropilete v kivnon mpog o
puévo kotevbuvon. Avtd tonobetel 1o ldwAo oV amévovtt BEo.

8. Avoi&te to Control panel kot BefarmBeite 611 n emdoyn Loop Playback eivat
evepyn kot B¢ote Tov puOS oe 10 Thaioia avd devtepOAETTOL.

9. Avomapdyete Vv Tovia Kot arodnkedote v epyacia cog.
taj mahal {1
taj benk i)

Ot peldveg emmpealovv tov tpoémo oyediaonc N amddoong (rendering) evog
EL0MAOV, ETAV® OTIG EIKOVEG TTOV €lval amd KAT® TOV.
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10. Xto mopdBvpo score, emriéEte 10 €idwA0 2 kol aAAGETe TV pEAdVTM Of
Background Transparent. Befaim0eite 011 emdé€ate 6A0 t0 £i6wA02, KO Oyt
HOVO Ta AKPO TOV.

11. Avomapdyete v tovio Kot Ogite TO ATOTEAEGLOL.

12. EmAéEte Eava to €idwio 2 kot aArdEte v peddvn tov oe Blend. ‘Enetta

aAAGETE TO TOG00TO avauéng oe 50%
To mocootd avaéng kabopiler mdéco rendering yivetor 6to €idwA0 o€ oyion
ue to rendering tng eikovog amd Katm. AnA. pio avauién 100% onpaivet 6t to
eldmro eréyyet to 100% ToL TPOCKNVIOL, KAVOVTOG TO TAPUCKNVIO GTNV 0VGIN
dwpavég. Mo avauén 50% onpaivel 0Tt T0 GO TOL EWBOAOL TPOGKN VIOV
dlTnpel To O1KO TOL YPMUO KOL TO UIGO OVOULYVOETOL LE TO XPMUO TOV 0o
KAt €mAov. Mo avauén 0% onpaiver 6t dev eppaviCeton timote and t0
eldwAo Tpooknviov Kot 0Tt N ekdva deiyvel poVo o amd KAt idmA0- TO VEO
eldmAo amhag dev eppavileral.

13. Avoamapdyete tnVv Tovio Kot OiTE TO OMOTEAEG LA,

14. ¥to score emAé€te 10 idmAo 1(taj mahal) ko petaeépeté 1o 610 KavaAL 3.

15. Avamapdyete Eova v Tovia.

Topa to keipevo dev givarl opatd Omwg Tepvd KAt omd v eikdva. H peldavn
copy g ewovag pérog 1 epmodilet To €idmA0 TOV KEWEVOL.

16. Xto score emAé€te 10 €idA0 0T0 KOvAAL 3 ko oAAGETe T peddvn og blend
Kol T0 10600610 o€ 50%.

Mmnopeite va deite 011 1 €1KOVA QTICETOL AUEGHOS GTN CKNV.
17. Amobnkedote TNV Touvio GOG KoL OVOTAPAYETE TV Y10 VO, OEITE TO OMOTEAEG LA
O Director mapéyer v peildavn Mask mov kdver évo bitmap va avopyvoeton pe
mv ewova amd kato tov Pixel mpog pixel coupwva pe Eva yaptn avapopds. Avtog o
Yap¢ pmopei va givarl po Egymplot) ewdvo 8-bit 1 pmopei va givar to téTapTO
Kaval 8-bit pog ewcovag 32-bit. H pekdvn Mask cuvdvaouévn pe o eiovo pdokag,
kabopilet axpimg moo Pixels evog eiddAov eivar dtapavn Kot Toto adtagav.

18. Xto castuetapépete 10 puéhog 2 (to keipevo) oto pérog 7.H peddvm Mask
amoltel M paokapepEVN KOva va €yxel o, bitmap pdoka oty apéowmg
emopevn 0éon pélovg oto cast. Emedn avt) n Béon upéhovg sivan
KATELNUUEVT amd To HEAOG NG €KOVOS, TpEmel vo. PAAETE aLTO TO HEAOG
KAmov aAlov Yo va anedevBepdoete TNV B€om 2.

19. EmiéEte to pélog 1 oto cast ko Edit->Duplicate. ‘Eneita ovoudote 1o taj
mahal mask.

20. Mg emieyuévo to pérog 2 tov cast, emiéEre Modify—-> Transform bitmap

21. Eméte color Depth: 8Bits kot v maAéta Grayscale kot kdvte KMk 6To
Remap Colors yia va to emlé€ete. Kavte khk oto kovumi Transform ko
petd kik oto OK oto mapdbupo dtadldyov mpogidomoinong mov epgaviCetot.
Ola ta xpodpota o avTioTol o0V €K VEOL GTIV TOALTO ATOYPMGEMY TOV YKPL,
£TG1L OOTE TO O GKOVPO YPMUOTA VO EYOVV LEYOADTEPO dEIKTN OTNV TAALTO
KOLL TOL 7O OVOLYTA XPMUOTA VO £XOVV LUIKPOTEPO OEIKTN OTNV TOAETAL.
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22,

23.

24,

25.
26.

217.

28.

1 Transform Bitmap |

afidth Height Scale
Size: B20 w366 o0 Transform

[] M aintain Propartions Cancel

th: | & Bits v

INEENEEE ﬂ.'ﬁﬂﬂ'kh‘ﬂ
ket Ty y

the: [ [arayzcale

@ Remap Colars
7 Dither

Help

L. )

¥to score, emAé€te to eidwAo 1(taj mahal) ko emavaeépete 0 TOCOGTO
avauéng og 100% kot émerta oAAAETE TNV pEAdvT Tov eddAov oe Mask.
LEll QAMAGTE Y.

Irnk: | Mlask - ]

Avomapdyete v tavio Kot Ogite T0 OMOTEAEG L.

Mmnopeite va Ocite pepucég Aemtéc ahlayég oty avapuén. Avtd coppaivet
EMEWON 1 UACKO UE QTOYPMDGELS TOV YKPL Elval aKOUN GLVOAIKA GKovpa. Oa
YPEWGTEL VO VENGETE TIG OLPOPEG AVAEGO GTO OVOIKTO Kol GTO GKOLPO Yo
va dgite koahvTEPO TNV OVAUEN.

EméEte v pdoxa oto mapdbuvpo cast(puérog 2) kot Modify—> Transform
Bitmap. AAMGEte to Bdbog ypodpotog oe Babog 1-bit. EmiéEte Transform won
kévte Kk oto OK oto mapdbuvpo tposidonoinong mov epeavileta.
Avamopdyete TNV Touvia Kot amodnkeLoTE TNV £pYACia Gag.

Kaévte dumhd Kk 6to pérog 2 tov cast yuo vo gpeavictel To mapddvpo Paint
Kol Totnote 10 Ypaupa E amd 1o mAnktpoAdylo cag yio va evepyomoin0ei o
gpyoreio I'dpa.

Xpnowonromote ) ['Opa Yoo vo, KATapyNoeTE TIC KATM YOVIEG TOV EL0MAOV
KO VOL TIG KOVETE TO GTPOYYLALS.

K\eiote to mapdabvpo tov Paint ko avorapdyete v touwvio.

* Sooem

s

ol i
E =
x|
Poleri o -
imenena
[ LL]
L umhyad

l'.‘-l'.ll'.llI

L L L il )=
| ¥ Gastintormal

P

i a » |[O[amee -
5

[l T T I
T

I'o va deite 10 keipevo mov petaxveite miocwm omd to Taj Majal adlhd emdvo
and 10 PovTOo, givarl avaykaio va £xete dVo avtiypaga g kovag taj mahal

Eaj
ol

LT

oTNV OKNVN: €vaL 6T0 POVTO, e peddvn Copy Kot £va 6Ty Kopuen, 6T0 0moio
€xeL EPAPUOCTEL N LAGKAL.
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29.

30.

31. Avamopdyete v Touvio Kot amodnKedoTe TNV EpyOcio Gog

Em\éEte 1o €idwAo oto kavail 3(taj mahal) ko Edit->Copy Sprites ywo va to
avtrypdyete. EmkoAAnote 10 €ldwio oto kavdi 1, miaicto 1.

AMGETE TV peddvn tov elddiov 1 oe peddvn Copy.

H ewédva Taj Mahal npénet va gpoaviotel tdpo kovovikd endve oty 006vn.

Kavéva popkdpiopo dev givor opatd, eneidn 1o €idwAio Taj mahal pe v
peAdvn copy deiyvel oTidNmote £xEL LAGKAPEL TO €I0MA0 QVTO pE TNV LEAGV
Mask

5.12 Mevov
e ovtd o padnuo o dNUIOVPYNGOLE TNV EGAYMYN KoL TAL LEVOD Y10, oL

SLAOYIKT] GLALROYT TEXVNG LE LEPKOVS LOVAOTKOVS UNYOVIGLOVS TAOTYNONG.

1.
2.

3.

AvoiEte éva véo apyeio. Epeaviletar o keviy oknvn.
Emé&re File> Import ya va avoi&ete to moapdbvpo dtaddyov Import. Topa

Ba e1odyete Ta ool el LEGMV.
Bpeite tov @dkelo askhshl2 kon xévte khk oto Add All. Ola ta ovopato

apyeiov eppaviCovrar oty Mota apyeiov. EmidéEte Import.

ort Files into "Internal” B
Mzpeivnon oz: || askhsh12 - @ F = mEr
Dwopo = Hpepopnvia Tpom.. =
E Reservefrt 20,/3/1997 7:03 pp
% ReserveDim 20/3/1997 7:00 pp
"= ReserveTitle 20/3/1997 7:08 pp
@ UserTips 20/3/1997 712 pp [
ﬂ waterLOOP 12/5/1997 5:01 pp =
EN| [T ] ¥
Chvopa CMUserstelpidat Desktop™leyterhsaskhseishask Impaort
opxsiou: —
Apxzia Tl:lﬂOUZ[N Files v] [ Arupo ]
[ add | addan [ Remove | [ Intemet. |
File List: &
M edia:  Standard Import V]
-
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4. ¥1o0 mapdbupo doddyov Image Options emdéEte Stage (24 bits).
Avdloyo pe TOv TOTO 000VNG KOl VTOAOYIGTH) 7OL YPnollomoleite , i

poOuion «ekatoppdpla ypodpatoy propet va ivarl 24-bits 1 32-bits. Avtd 1o
Babog bit (mov emiong koieitor PdOog ¥pd®ROTOG) avapépeTe GTOV APOUO TV
bits uvAung mov ypnoomoovVIOL Yo amrofKELOT TANPOPOPLOY Yo TO
ypodpo oe évo povo pixel péoa oe éva ypoaekd. Me 24bits yio ke pixel,
vdpyoov 16777216 mBavoi ovvovoacopol ypoUdTOV  (KEKATOUUVPLO
YPOUOTAY), TOV €lvol OPKETOL Yoo Vo TOPAEYOLV OTOLONTOTE E€MBLUNTY
amoy PO Yo, ypaeika true-color.

o ™mv emioyn Palette xdvte kAik oto Remap To kot PePfarwbeite 611 M
TOAETO TOL GLGTHUOTOS YO TOV TUTO VTOAOYLOTI) OV EXETE, £YEL EMAEYEL amd TO
pevov. Av m moAéta eivor 1O cwOTH Yy T0 cVoTNUG oag, 1 emhoyy Remap To
umopet va givar apvdpn. Katomy emdéEre Dither.

Image Opticns for Ch\Users\elpida\De...askhsh12\Bicgraphy 2
Color Depth: () Imags (32 bits DK
@ Stage [24 bitz) —————
Cancel |
Palette: Irpart [Image Haz Mo Palette]
3 Femap to Spztem - Wik

Image: [ Trim “White Space
[T Dither

[] 5ame Settingz for Bemaining Images | Help

L=

5. Xe avtd 1o mapdbvpo dtoroyov emAaé&te Same Settings for Remaining Images
ka1 kavte KAk oto OK yia va kheicete to mopdbvpo dtahdyov.
IMa avtd To pddnua BEAovpe O A Ta Ypapikd vo potpdlovion Ty id1a TaALTa.

H emoyn g emhoyng Same Settings for remaining images spoppolet Tig
EMAOYEC TTOL ExeTe EMAEEEL 6€ aLTO TO TOPEOVPO daAdYOL GE OO TO YPOPIKA
mov elodyete. Av dev emhé€ete avtn TV emdoyn , o Director epoavilel avtd
10 TapdBvpo S10AdYoL Yo KAOE EIKOVO TTOV EIGAYETE.

6. AmoOnkevote v Touvia pe ovopo askhsh12.dir otov @dkelo coc.
g TpoMyovUEVT EpYACTia EPAPUOGALLE TNV 1d10 TOAETO GE OAO T YPAPIKE GTNV TOLvVia
coc. ['a va BefarmBeite 6TL avtd To Ypapikd epeavioviol cmoTd 6TV Tovio cag ,
npénel va Pefarmbeite emiong 011 N 1010 moAéTa €xel avatebel ota mAaiclo oto omoia
epneavifovror ta ypoaeikd. To koviM ToAETAG 6TO SCOre Gog EMITPENEL VO avodEcETE
po ToAéto o€ KaOe mAaiolo g Taviag. o va kpatnoovpe OU®s avtd To £PYo amAd,
Ba opicete pia mpoesmAeypévn ToAéTa Yo OA ToL TAOIGLOL GTNV TOViC. € oV TNV
epyaocia Ba opicete emiong to péyebog g oKNVIG Kot TO YpAOLA @GHVTO Y10 TN CKNV.

7. Emé&re Modify->Movie—>Properties.
8. BePaiwbeite 60T1 | TAAETO CLGTHUOTOG YOl TOV O1KO GO TOHTO VITOAOYIGTY| £XEL
emleyel and 1o pevov Default Palette.
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[Mpoemreypéva o Director emAéyel tnv moréto System-Win yio vmoAoyiotég
Windows. Otav ekkiveite £va £pyo Opmg, dev givat Kakd va e EYEETE AVTEC TIG

pvOuioceis.
Frame Properties: Palette |i|
Palette: [System -Win - Lok ]
Action: @) Palette Transition | Cancel
"1 Calor Cycling

Rate: P (G 30 s

(@) Between Frames

Span Selected Frames

Options; () Fade ta Black
1 Fade to'White

Frames Selected: 1 @ Dan't Fade Help

Thpa €xete oryovpéyel 6t O o Ta Ypopkd oto £pyo cog Ba eppoavifovior cwotd
aveCdptnta and 1o Tov ta ypnowonoteite. Ta ypapikd poipalovior v 1010 TOAETA
Kol ovT N ToAETa avatifetal Tavto cav 1 TpoemAeypévn g touviag. H diéveén
moAéTag ovuPaivel 6tav Eva ypoeikod dgv €xel v 1010 moAéTa e TO TAAICIO OTO
omoio eugavifetor. Avtd «kaver tov Director va sugoavicer 10 YpaQiKo,
YPNOUYLOTOIDVTAG T YPDOUOTO OO TNV TOAETO, TOV TAOLGIOL KOL GLYVA TO XPMLLOTOL
etvar tedeiog AavBoouéva yoo TO YpaOIKO, OOMNY®VTOG O KAMO0 \WYuyedehkod
OTOTELECLLOL.

9. B®¢oTte 10 YPOUO TOV POVTIOL TNG TAVIOG GE LOOPO.

Mawie

Stage Size: | 640 | 480 4

Channels: | 150

Color: | #z22027 ﬂ

Falette: [ Siy=term - win - ]

10. ®¢ote Vv oknvn og 640x480

11. ®éote Vv Béon g oknving oe Centered onA. emiééte and v Kaptéla
Display Template am6 tov mapdbvpo Property inspector kot toekdpete tnv
emhoyn Centered.

| == Display Template

Title: |
Type: [ Docurment -
Location: | 263 T
[¥] Centered [J] Fiesizable
[j Diocking
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12. Emé&re Edit->Preferences—>cast yio va avoiéete to mapdbvpo dtaddyov cast
Window Preferences. EmiéEre Number:Name ond to pevov Label kot petd
kavte KAk oto OK 7y va kAeicete to moapdbvpo dwoddyov. Emiéyovtog to
med0 aVTO oaG EMTPEMEL VAL Ogite TOGO TOV 0PlOUO OGO KOl TO OVOU TOL HLEAOVG
Tov cast oto mapdBupo score.

5

P

Cast Window Preferences for “Internal

Cast View: [ | Apply to &l Casts ok
- ik ] Save bz Default
" | Created

[] Madified D ate
[ Madified By
Filename

List Columns: [¥]

|| Comments
Thumbrailz Visible: |1,EIDEI "]
Flow Width: [ Fit o Window v
Thumbnail Size: [ Medium v
Label: [Number:Name v|
Media Type lcohs: |AII Tvpes "]

Show: [V Script Help

13. Emé&re Edit->Preferences—=>Sprite ywo va avoiete 10 mapdbvpo Sprite
Preferences. ITAnktpoloyfote 13 oto medio Span Duration (yia va gugaviCovran
T gldwAa pe 13 miaiowa)kon kdvie KAk oto OK yuo va kheicete 10 mapdbupo
dwhdyov H duapkela 13 mhouciov enedéyn, aming enedn elval apketd peydan
Yo vo. oG eMTPENEL Vo dgite To. ovOpoTe TV PEA®V Tov Cast oto Score.
Mmnopeite emiong vo 0éoete HOVIHOL pio TPOEMAEYUEVT] OLAPKELN OTO TO UEVOD
Sprite Preferences (Edit—>Preferences—> Sprite).

Sprite Preferences :___E_}_E__ )
Stage Selection: @) Erntire Sprite
(") Current Frame Only
Cancel
Span Defaults: [~ Dizplay Sprite Frames
[¥] Tweening
Span Duration: @ 13 Frames

(70 Width of Seore Window

[V] T erminate at Markers

Span Starts: @) Previous Marker

*) Current Frame

() Firgt Frame in Score ‘Window

14. %10 moapdBvpo cast, petoeépere to pEAN tov cast oe pio Aoyikr oepd.

[Tpotewvdpevn cepd pedmv tov cast:
FH:= | 4 o (@0 )

Intro.

= II,J\ LIRLILIG

B:QuestionDir| 7:Questit 12:Linzament |13:] L\r-eamarl 14:PrivationD |15:Privation [16:Reservel:|17:Resarve

\-J R Eelle) =0l |

18:Lineament, [19:ReserveA 20:PrivationA 21:Lineament 22:PrivationTi 23:Reserveli| 24:dotieft | 25:d [28: ‘User 28] ™ :fivesa 31:EndPara 3Z2:0val

80



15. Amobnkedote TV epyacia Gog.
16. Metagépete To pérog 3 tov cast oto kova 1, miaicto 15.1TAaicto téAovg 27.

w_| O |

+ F:Pain i e s—

17. Metogépete 10 péhog 4 tov cast, Fingerhoney, oty oknvn, étol ®ote va
eupaviCetor otV Kdto 0e&1d yovia TG oKNVNAG. LTO SCOre 10 £16AYETE TO HEAOG
avTo 670 KavaAl2, miaicto 15. [Thaicio téhovg 27.

18. Emié&re View—>Sprite Overlay->Show Info.Xtn oknvn epgaviletat Eva yipt
TAOUG10 OV TEPLEYEL TANPOPOPIES Yo TO  €MAEYHEVO €ldmA0. Avti elvar 1
gmaloyn drov(sprite overlay)

19. Me emeyuévo to pérog 4 kabopiote kdmoieg 1010TTEC TOV 0md TO TOPdBvpo
Sprite Properties. @éote 1o mhaicw Left oe 164 kau Top oe 91,Width 157 ,
Height 123, X 242 ot Y 152.Ta media owtd omotelodv o medio. Location kot
opiouv v Béon ToL €WO®AOL GE GYEOM HE TNV EMAVM OPLOTEPT YOVIOL TNG
GKNVNC. 1

wloaz v[we

Lits T|9 Rz BM

W .| 187 H:| 123

Topa Ba Tpocbécete apketd oTOYEID GTNV GKNVI] TAVTOYPOVAL.

20. Metapépete avutd Too LéEAT Tov cast oto mhaicto 15 tov score, apyilovrog amd

TO KOVOAL 5.

14: PrivationDim KOVOALS
12: LineamentDim KOVOALG
16:ReserveDim KovaAL?
8:BiographyDim Kavo 8
6:QuestionDim Kové 9
10: EXITDIm kovéi 10

Avtd ta péAN ToL Cast TapleTovV TIG EMA0YEG TOL B UTOPOVV VAL KAVOLV Ol YPT|OTEG
amo To KLPLO HeVoV, 6tav Tpofdiiovy v mapovsioon. Oa speavifovral oty 0e&ld
TAELPE TNG OKNVNG, APOV TIG TOTOOETNGETE 0TO TOPAKATO Prpata. o v dpa, lvan
OAEC KEVIPAPIOUEVEG OTNV oKNVA Kat o Tivakog Sprite Overlay mov PAénete mepiéyet
W310TNTEG TOV AVIKOLV GTO TEAELTAIO E10AO TOL TOMOOETHGATE GTO SCOre.

14:PrivationDim—
12:Line amentDim —]
16:FeserveDim—]
3:BiographyDim—{
E:GuestionDim—]
ADE R T Dy ]
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21. Xto score emAéEte 10 €10MAO GTO KOVOAL 5 Kot KAVTE KAIK 6TO gkovidlo Sprite
Properties oto Sprite Overlay kot 6éote Tnv 6éom T0VL €1d®AOL o€ Left 241, Top
230.

22. EméEte View—>Grids—> Settings, minktpoloynote 50 oto medio Width ko 25
oto medio Height kot khk oto Vvisible. Avtd dnuovpyel Eva mhéypa pe mhaicio
nov £yovv mAdtog 50 Pixels ko Vyog 25 Pixels.

Guides: !l
] visitle
J' Snap To
[ Lock

NEW:E |—|_+ | Femowe All

-
Girid: ﬂ Oots (@) Lines
[ wisible

[T]8napTa

W: | 50 H: | 25

23. EmiéEte View—>Grids—> Snap to yia va evepyomotoete tnv EAEN 6T0 ALY,
Katomy eniréEre View—->Grids—=> Show. Topa propeite va dgite 1o mAéyua. H
EAEN 0TO TAEYHO GLYOVPEVEL OTL OTIONTOTE UETAPEPETE KOVIA GE L0l YPOLLUT
TAEYLOTOG O GTOLYIOTEL QVTOUATO LLE TNV YPOUUN TAEYLOTOC.

24. XpnolHomoumvTag TV TOPUKAT®O €KOVE ooV odNnyo, KAvie KMK o€ KdaOe
elO®OAO OV TOPAPEVEL OTO KEVIPO TNG OKNVNG Ko UETAPEPETE TO otV 0e&ld
TAELPE TG OKNVNC.

25. Amevepyomomote 10 TAEYHO Ko TV EAEN 0TO TAEY L.

26. kdvte OwAd KMk ot0 mAoico 27 ©T0 KOVAAL GULUTEPIPOPAS KO
mAnktporoynote go to the frame. Kieiote to mapdbvpo tov oxpurr.
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27. Ztnv oknvi, Kavte KAk 610 gidwio 14:privationDim mov tonobeticate kovid
otV Kopven g oknvig . Katdmv kdvte KAk oto gikovidio Behavior Inspector
Yo TO eMAEYIEVO €10®AO.

28. Xtov Behavior Inspector, emiAéEte New Behavior and 1o pevov Behaviors.
Y10 mopdabvpo dwrdyov Name Behavior mov epgaviletar, ovoudote t véa
ovumeplpopd Buttonl. 'Eneita kdvte kik oto OK yia va 10 KAgioeTe.

29. Avoi&te to pevov Events kon emaéEte Mouse Within.,

To ovpPav mouseWithin cuppaivel emavaAnmtikd eved 0 SPOUENS TOV TOVTIKIOD

OV YpNoT elvar pésa ot OpLa Tov eWWM®AoL. Ta dpta givar ot ypappés Kot ot
AoPég mov pmopeite va dgite Otav 1O £idwAo givor emieypévo emAve otV

GKNV1.

30. Avoi&te 1o pevov Actions kon emhéEte Sprite—>Change Cast Member. ‘Enetta
em\é€te to uéhog Privation tov cast and to pevov kot kdvte kAk oto OK.
Avt 1 evépyela mov Levyapavete pe to copPdv MouseWithin cag enttpénet va

emiéEete éva pélog tov cast mov Ba ypnoipomombel yoo AvVTIKOTAGTOCT TOL
TPEYOVTOG EMAEYUEVOL €10MA0V. 'Eva eldmAo Tov pédovg tov cast mov emAéyete
Ba eppaviotel oty Béon ToL apyKOD €1B0MAOL, OTaV cvuPaivel To cLUPAV
mouseWithin. EmiAéyovtag to pélog Privation tov cast, emAiéyete v kabapn
€KO00MN KEWEVOD TOV €10MA0V. TdOpo dINUOVPYNCAUTE £VOL GUVOVOCUO EVEPYELNG
Kot GVUPAEVTOG Yl Lo GLUTEPIPOPA OV Papproletar oto £idAo Tov emALEate
oto Prua 1. Otav ot pnoTeg HETAPEPOVY TO dPOUEN LEGO GTO OPLOL TOV ELODAOL
oTNV oKNVY|, T0 €0WA0 LE TO VPO Keipevo Ba avtodiayel pe po kabapotepa
YPOUUEVT KOO0 TOV.

Change Cast Member |Privation

31. Mg v ovunepipopd buttonl axoun emieypévn 61OV TivaKa CLUTEPIPOPOV,
emlé€te MouselLeave amd to pevov Events. Emaé&re Sprite—>Change Cast
Member to member amd to pevov Actions, emié€te to pélog PrivationDim tov
cast kat kavte KAk oto OK. Topa 600 coppdvta avatiBevior oty cupmeppopd
Buttonl:mouseWithin kouw mouseLeave. O Director aviyveder éva copPav
mouseleave 6tav o dpopéag eyKataAginel ta Oplo. TOL EWBOAOV, GTO ONOIO
€QOPUOLETOL OVTN 1) CLUTEPIPOPEL.

Change Cast Member |PrivationDim v‘

32. Amobnkevote v epyacia cag.

33. avamapdystor v towvio. Metagpépete tov dpopén emdved oto €0MA0 GTO
omoio avaBéoate v cvumepipopd Buttonl xkor petd petapépeté tov dpopéa
¢€m amd To EI0WAO.

83



34. Xy oknvn kavte KAk oto gidwio 12:LineamentDim. Mg avowktd axdun tov
Behavior Inspector, dnpovpyfote o véo copmepipopd Button2 ue éva coppav
mouseWithin kot pua evépyeta Sprite—>Exchange Cast member mov avtaiidoost
To €ldwio pe 1o péhog Leneament tov cast. Katomv mpocbéote Eva coufdv
mouselLeave kol po evépyslo. mOL AVTOAAAGGEL TO €idwAo pe TO HEAOG
LineamentDim tov cast.

"

2

1 Mame Behavior

Behavior Hame:  button2 OK
Cancel |

35. Kavte xhk oto €idwro 16:ReserveDim kot dnpovpynote (o, GOUTEPIPOPE.
Button3. Avoféote ta ovuPdavio MouseWithin  kou mouseLeave oty
ovumeplpopd Button3 mov avtarridoocovv to €ldwAo pe ta uéAn Reserve kot
ReserveDim tov cast, avtiotoyo.

36. Khieiote Tov Behavior Inspector.

37. Metagpépete 10 pérog S:Line tov cast oto kavdAr 3 , mlaico 15 xou
TomofeToTE TO0 KAT® Omd TOV TiTAO oTnv oknvi. Ofote v pekdvn o€
Background Transparent.

38. Mg emheyuévo axodun to gidwro Line, emiéEre Window—>Tool Palette yo va,
avoiEETE TNV TOAETA YPOUATOV.

39. Amd 10 gpyaleio UMPOOTA YPOUOATOG GTNV TOAETA YPOUATOV, ETAEETE Eval
TOPTOKOAM Yp®dUO OV Vo Toplalel 660 T0 dSuvaTO TEPICCOTEPO LE TO TOPTOKOAL
OV YPNOLUOTOLEITAL Y10 VTO TOV TUTO.

40. EméEre View->Sprite Overlay->Show info yw va amevepyomoioete 1o
Sprite Overlay.

41. Amobnkevote TV £pyacio Gog.

42. xavte Ao KAk oto puéhog 4 tov cast ywo vo avoifete to mapdbvpo Paint.
EnéEre Window—> Color Palettes yia va avoi&ete o mapdbupo Color Palettes.
43. EméEte éva ypopo omd 10 epyorEio UTPOCTH YPOUATOS OGTOV TIVOKO
gpyareiov tov mapdbopov Paint.Otav emrééete éva ypodpo oto mapadvpo Paint,

70 1010 YpdpO EMAEYETOL E60 GTO TOPAOVPO TAAETOG YPOUATOV.

44. «heiote To Tapabvpo Paint kon Color Palettes

45. EméEte to eidmwlo Line oto kavdair 3 kor Modify—> Sprite—=> Properties.

46. KabBopiote 1 yio o Yyog tov €1d8drov. To gidwio Line odialetr uéyebog.

47. wbévte KMK 010 TAic10 15 péca oto KavaAl TAAGIOV Yo VO LETOPEPETE TNV
KEPOAN OvVOTOPOy®YNG 6TO TANiG1o 15.

48. Kk oto epyodeio Filled Ellipse omv moAéto epyodeiov kot peTd
OMNUOVPYNOTE £va PIKPO KOKAO GTNV GKNVN, GTO ap1oTEPO AKPO TNG VPO,

49. Y10 cast emAéEte 10 péAOG yepuopévn EAlewyn tov cast mov oA
dnuovpynoate kol TAnkporoynote Dot 6to medio ovopatog tov mapabHpov
cast.

50. EmavemAé&re 1o €idmwio Dot otnv oknvi kauw Modify—> Sprite—>Properties kat
ONUEUDCTE TNV EMAVEO GUVTETAYLEVT] TOL EWOMAOV.

51. Metapépete 10 péhog Dot tov cast and to mapdbuvpo cast oto kavdar 12,
miaicto 15 . 'Enetta petapépete to €idwlo og o 0éon oty oknvi 610 6e&10
dxpo tov eWdmAov Line.

52. Mg emeypévo axodun to eidwro, emrééte Modify—> Sprite>Properties ot
EI0AYETE TNV ETAV®O GLVTETAYUEVT TOV onUeEldSaTE 6To Prina S0
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53. Metoagépate to pérog Dot oto wavah 13, mhaicolS. EmAélre
Modify—>Sprite—>Properties kot 6éote 10 TAGTOC KoL TO Vyog o 10 wan 10.
Koatomy 0éote v 0éom og 155,105.

54. Metapépete to péAog Intro tov cast oto kavdir nyovl, miaicol péca oto
score

55. kavte omAd KMk 010 mAaiclo 13 tov kovoiov pvOpov kol 6To TaPAbLPO
daddyov kavte khk oto Wait for Cue Point, emidééte {End} oto medio Cue
Point kou OK.

Frame Properties: Tempo

~

) Tempe: ﬁ . : 1 [3]%] 30 fps
-:-'W'ait: \. M 8! pressre = seconds

(71 Wit for Mouse Click or Key Press

@ ' ait for Cue Paint:

Channel: ISDur‘u:H: Intra

vJ Cue Pairt: [{ End}

L

56. Metapépete 1o péhog Logos tov cast oto mhaictol kavéiil
57. xdvte omAd KMk oto mAoicto 14 tov kavaAloh evaAlayng, emAélte o
evoliayn Edges In, Square kot OK.

Frame Properties: Transition _E‘E_ |

; Categories Tranzihionz
1| [ | Dissolve, Pissls - oK

Cover Dizzalve, Pirels Fast

Dizzolve Edges In, Horizontal :

Other Edages In, Squ m Hiligs:,

Push Edges In, Yertical — -

Reveal Puzh Down

Stripz Puzh Left

Wipe Puszh Right
| Puzh Up b

Duration; I{:i | [+7%] 200 Seconds
Smoothness: f]
Affects: (7 Entire Stage @ Changing frea Only Help

58. Kk&vte STA6 KAIK 670 Thaico 15 Tov KaveAov evaAlayng, emiéEte Center
Out, Square ka1 OK.

59. Amofnkevote TV £pyacia Gog Kot ovamopayeTe TNV ToviaL.

5.13Mgvov-Zkpurt

210 TPONYOOUEVO HABNLO ONUIOVPYNCAUE TNV EIGAYMYN Kol TO KOPLO UEVOD
Yl {0 GUAAOYT TEYVNG TOAVUEC®V, TPOGHETOVTAG NYO, YPOUPIKE Kol EMAOYEC LEVOD
oV 0AAGLoVV o€ GALEC EIKOVEC, OTOV LETOPEPETE TOV OPOUEN EMAVE TOVG. X& OVTH
mv gpyacia Ba TpocBicovpe CKPIMT Ge AVTES TIG EMAOYEC LeEVOD oL Ba emttpEémovy
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OTOVG YPNOTESG VO LETAPEPOHOVYV GTO aVTIGTOLYO £pYO TEYVNG LEGA GTNV GLAAOYY|, OTAV
KAVOLV KAK GE L ETA0YN TOV HEVOD.

1. Avoi&te 10 apyeio askhsh12.dir tng mponyodvevng epyaciag kat omobnkevote ™V
010 PakeAd cag mg askhshl3.dir.

2. Emégre Edit->Preferences—> Sprite yio va. avoiete to mapdbupo dtokdyov Sprite
Preferences kot mAnktpoAroynote 13 oto Spam Duration kot OK.
Me tov 1pémo avtd opicote tov Director mote vo mpocbicete gidwio oo Score
ne duapketa 13 mhousiov.

3. Kavrte Kl oto mAaicto 15 oto kavdAl onpadidv Kot mAnktpoloynote Main cav
6vopa onpadod. ‘Eneita matote Enter.
AvT6 10 oNUAdL OAdVeL TV B€om TOL TAGIOV TOL KVPIOV HEVOD

W Main

4. Ewodyete onuddia ota mAaicto 30,45 kot 60 ko ovopdorte to Priv, Line kou Res
avticTtolya.
Avtd to onuddie dmimvovv T Bécelg Tv oBovov mpoopiopov mov Oa
eupaviocovv to daeopa £pya téXVNG otnv cvAroyn. To ovopata eivar apketd
HEYOAD OOTE VO ONAMVOLV TO €pYyo TEXVNG 6TO omoio avagépovtot.H tomoBétnon
aVTOV TOV onuaddv oe andotacr 15 mhociov elvar Aoyikn, emeldn avt) 1
amootoon Palel kdmoo Keva TAAIoLo aVALESH GTO OTILAdL0, MOTE VO UTOPEITE Vo
To. O€lTE oav SLOKPLTA UEPT TNG TOPOVGIOOTG.

5. Ewodyete évo onuadt oto mhaicto 75 ko ovoudote to Bio. ‘Enetta siodyete éva
dAAo onuadt oto mAaicto 90 kot ovopdote To ?.

i W ain F Priv “F Line ¥ Fes ¥ Elo W

| 3 I

6. Amofnkevote TV gpyacia Gog.

Topa Oo dnuovpyeite eidwAia 6to mAaiclo 6mov tomobetioate T0 onuadt Priv.
Avt 1 006V Tpoopiopod Ba epeavicet To Epyo privation and excesses.

7. Metagépete 1o péhog 20:PrivationArt tov cast oto kavai 1, mhaicio 30 oto0
Score.
Avtd givar To épyo téyxvne ne ovopo Privation and excesses. IMapotnpriote 01t t0
eldmAro eppaviCetarl ota mAaicta 30 o¢ 42 podvo.

8. Mertapépete 1o moapakdtem pEAN Tov cast ota kKavdAlo Kol TAOIGIL OV
avaeEPovVToL dimia.

22:PrivationTitle Kaovai 2, thaiocto 30
24:dotleft Kavar 3, thaiocto 30
25:dotright Koavé 4, mhaioto 30
26:dotbottom Kovai 5, mhaicto 30

Ta eldwlo mov petapépate oto Score eivar otolaypdve OAo 610 KEVIPO NG
oKNVNG. Xt ocvvéyeln Ba TomobetoeTe aTA TO. oTOLKEID EKEL OOV TPEMEL VL
epneavifovtal ot oK.
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20:Privationart —]
2Z:PrivationTitle —]
24:dotleft—————]
25:datright ————]
2E:datbiotho rm s—]

9. TMoatdre o mAnktpo Shift kau petagpépete 10 €idwA0 MOV eMAEENTE GTO KEVTIPO TNG

10.

11.

12.

13.
14.

OKNVYG , € i Béon KovTd 610 KAT® PEPOG TNG OKNVIG.

Avtd egivor 1o gidwio 26:dotbottom 6mov eivan o amdn ewova bitmap piog
dompng tereiog og Eva padpo PovTo.

Kévte khk oty dompn tedeion 610 KEVIPO TNG OKNVAG Yl Vo TNV emMAEEETE,
natdte to mAnktpo Shift kot petapépete v ommv d6e€1d Thevpd ™G GKNVAC.
Kotomy emdééte v tedeion mOL OmOUEVEL GTO KEVIPO TNG OKNVAG KOl KAVTE
Shift-petapopd yio va v HETAPEPETE GTNV APLOTEPT TAEVPE TG GKNVIG.

O tedeieg mpémer vo gppaviovtal otn oknviy OTwg QAIVETOL GTNV TOPOKAT®
EIKOVQL.

EmiléEte 10 €idmAo TiTAOL GTO KEVTPO TG OKNVIG Kot LeTd Kavte Shift-puetapopd
Y10 VO LETOPEPETE TO EIOMAO OTNV EXAVEO TAELPA TNG CKNVIG.

Y10 score, emAéEte Ta ldwAa 010 TAaico 30 ,Kavdia 1 €mg 5 Ko avtiypdyte Ta.
"Enerta emuxoAAnote T00 6TO TAOiG10 45 Kavad 1.

Avtiypago tov ed0lov sugavifovtal topa kate® and to onuddt Line. Oa
ouveyioeTe Vo EMKOALATE 0VTA T I0MAN KATM oo To, VTOAOUTA GMUASLOL.
EmuoAAnote Ta ldwAa oto kavdAll, miaicia 60, 75 kot 90.

Amobnkedote TV epyacio cag.

o 20:Frivationsars ——1
O 22:PrivationTitle —1
O 2ddotleft —— 1
O Zh:dotright ————O
o EEdotbottom —

O 20:Privaticonsce ——1
o 22:PrivationTitle —1
o Zd:dotleft———— ]
O 2Edotright ———— O
o ZEdotbottom ———

o 20:Frivaticnare ——1
O 22:FPrivationTitle —1
O 24:dotleft ———— 1
O Zhdorright —————
o EEdotbottom ———

o 20:Privationsre ——1
o 22:PrivationTitle —1
O Zd:dotleft —— ]
o Z2E:dotright ———O
— ZE:dotbottom —

o 20:Privaticonare ——1
O 22:FPrivationTitle —1
O 24:dotleft ———— 1
o 25 dotright ——
= ZE:dotbottom —
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15.

16.

17.

18.

19.

20.

21.

22.

23.
24.
25.

26.

EméEte 10 €idmro 20:PrivationArt oto mlaicto 45, kaval 1. ‘Ensrta emAiééte to
uélog 18:LineamentArt tov cast oto mopabvpo Cast ko kavte KAk oto Exchange
Cast Member otnv ypauun epyolreiov.

Y10 mhaicto 45, to épyo privation avtikabictovror oo to £pyo lineament.
Emé&re 10 €idmio 22:PrivationTitle oto mhaicio 45, kavil 2 kot avtaAlaéte To
ue to pnélog 21:LineamentTitle tov cast

Xpnowomomote to Exchange Cast Member ywo va gpoavicete v gikova peAog
19 ReserveArt oto kavolt 1 mhoioto 60 kot tov cwoto titho 23 ReserveTitle yio
TO £pYO0 rEServe mov mpémet va Peaviotel 0to mAaicto 60 Yo To onudol Res.
Xpnowonomote v evitoly Exchange Cast Member yw va sueovicete v
ewovo 28:BioPage oto kaval 1, mAiaicto 75. ‘Emerta emdééte 1o €idmAo
22:PrivationTitle oto xaval 2 kdto amd ovtd kKo totnote Delete.
Xpnowomomote to Exchange Cast Member yw va eugavicete v ewkova
27:UserTips oto kavam 1, miaicio 90. ‘Emerta Swypdyte 10  €idmAo
22:PrivationTitle kdtw and avtd 6T0 KOV 2.

Amofnkevote Vv gpyocio Gog.

O 20:Privationsrt—]
O 22:Privation Title —]
O 24:datleft——]
O 2h:datright ————2
Cr 2E:dotbatkom ——2

O 1&:Lineamentart—]
O 2Lineament Title —]
O 24:dotlet———]
& Zhedatright ————0
2 2E:datbottom ———0

O {3 Fesernvesit—]
@ 23 FeserveTille s
O 2ddaotleft————]
& 2Bdatright ——O
o 2Edotbottom ——0

O 2&Biopage——]

O 24:dotleft——]
Cr 2hdatright ————2
O 2E:dotbattom ———2

O 2FUserTips —1

O 24:dotleit ———]
& Zhdatright ————0
O 2E:datbottom ———0

210 Score kdvte KAK 6to mAaicto 15 610 Kavai mhoucimv.

> oknvn Ba PAEreTE TO KUPLO PEVOD.

EnéEte View—> Sprite Overlay—-> Show Info

Avtn evepyomotel 1o yopaktnplotikd Sprite Overlay étol dote vo pmopeite va
Oelte TIC cLUTEPLPOPEG OV €YoV avatebel ota eldwAN, OTOV EMAEYOVTOL GTNV
OKNVY).

Kévte khik 010 €idmAo 14:PrivationDim oty endvo 6e&16 yovio TG oKNViG.
Eupgaviote 10 mapdbupo tov Behavior Inspector.

Amo 1o pevov Events emléEre mouseDown. Katdmv, amd 1o pevod Actions
emlé€te Navigation—>Go to Market

Amo 10 pevod oto mapdbupo doddyov, emiéEte to onuadt Priv. Kot kévte ki
oto OK.

Topa , 0tav yivel KAk 6to €1d0wlo privation and excesses, évo uivopa cuuPavtog
MouseDown otéhlveton Director, mov daKANdDVEL
AVOTOPAY®YNG 6TO oNUaot Priv.

GTOV NV KEQOAN

Go to Marker: [Prh.r
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217.

28.

29.

30.

31.

32.

33.

v

+ - |+

- -

miousewithin Change Cast Member to ..
mouseleave
mouseDown

Emilé€te 10 €idwlo 12:LineamentDim, koavdir 6, mhaicto 15 kol epugaviote tov
Behavior Inspector kot mpocOéote éva cuuPdv MouseDown oty cvumepipopd
tov Button2. T'o v evépyela, smAiéEre Navigation>Go to Marker kot petd
emlé€te to onuadt Line.

_FI A0 Siak n e Tul i H n S,

1 Specify Marker 2

Go to Marker: ILLne v] | OK |
Cancel |

[IpocBéote éva ovuPdv MouseDown oty ovumepwpopd Button3d oto 16
ReserveDim mov £yel avatebel oty emdoyn reserve. BeBawwbeite 011 1 evépyeia,
OV EMALEATE PETAPEPEL TNV KEPOAT QVOTOPAY®YNS 6TO onuddl Res ato score

Amofnkevote Vv epyoacia coc. EavotoMETE TNV KOU  OvVATOPAYETE  TNV.

[Mopoatpnote TV KEQOAN OVATOPOY®YNG YO TIG TPES TPOTEG EMAOYEG TOL
Bactkov pevoo.

Topa mpocsBéote éva cvupdv MouseDown otic coumeprpopég Button 4 won
Button 5 mov éyovv oavartebel otic emhoyéc pevov Biography xor Question
avtioctoyo. AnAadn to 8 BiographyDim oto kavoaiil Ba mnyaivel oto onuadt Bio
kot to 6 QuestionDim mov Bpioketar 6to Kavoit 9 Oa wnyovel oto onuadt ? .To
Befouwbeite 011 emie€ate o cootd onuddia oto omoia o petaPeite. H emioyn
uevov EXxit dev éxel mapet o cvumepipopd MouseDown axoun.

Kavte duthd KAk 610 KavdAl coumeprpopds , mhaicto 30. [TAnktpoAioynote go to
frame “Priv’ kdto ond 1o on exitFrame. Kotomv motmote Enter omd to
aplOuNTIKO TANKTPOAOY1O.

[MpocBéote éva okputt go to frame ““Line” oto mAaicio 45 oto Kavalt
ovumepipopds. Katomv npocbéote éva okpint go to frame “Res”’oto mhaicio 60
0TO KOVAAL GOUTEPIPOPAG.

Amobnkevote TV €pyacio cog Kot avamapdyeTe TNV tavio yio va Kivnbeite og
kaBepio amd T1g 006vVEG TPOOPIGLOV KOl VO, SOKIUAGETE TO, CKPUTT TAOUGIMV.

5.14 EvaAhayn| ypoudtov kot Miypoto

H evalloayn ypopdtov Kot to piypoto eivol TeXVIKEG TOV YPNCLLOTOI0VVTAL Y10

onuovpyia kivnong, ympig va ypeldleTon vo ONUIOVPYNOETE SUPOPETIKES EIKOVES. Me
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™mv evolhayn ypoudtov Aéte otov Director va alddlel ocvuveydg pepikd 1 OAa to
YPOLOTO TTOL YPNOLUOTOIOVVTOL GE [0 EKOVA, dNUOVPYDOVTOG TNV Yevdaichnon ot
N ewova avaper kor ofrve. Me v avaién Umopeite va KAVETE Mol €1KOVO, VO

eaivetonr 0Tt gapaviletonr kot epgaviCetor oto @ovio. Kot ot 0o tepviKeg
TPOGHETOVV £Va EVIVTTOGIOKO OTTIKO OMOTEAEGLOL KOL EAKDOVY AUECH TNV TPOGOYN].

1.
2.

w

11.
12.

13.

14.

Avoi&te v askhsh13.dir ko amobnkevote v wg askhshl14.dir.

EnéEte Edit->Preferences—> Sprite yw vo avoiéete to mapdbvpo dtaddyov
Sprite Preferences kou mAnktpoloynote 13 oto medio Span Duration kot kiik
oto OK.

Y70 KovOAl ZNpadidv vo eledyeTe Evo onuadt Kot va To ovopdoete EXiti.
Metagépete to péroc 32:0val tov cast oto mhaicio 105, kovéir 1. Xe
nepintmon mov dev dgite to Sprite Overlay ywa to €idwio Oval, yw va 1o
evepyomomoete emiéEte View—> Sprite Overlay—> Show Info.

Kdvte xhk oto kovuni Sprite Properties otov mivaxa Sprite Overlay yio va
avoiete to mapdbvpo Sprite Properties ka1 Béote v Béon tov €100V GE
Left:50 xou Top:25.

Liso  T[zm
Y10 score emAééte 1o eidwro Oval.Kdavte dumhd khik o610 €idwAo Yo vo
avoiete 10 mopabvpo Paint. Tto mopdbvpo avtd kavte KAIK 610 gpyaAEio
UTPOGTA YpOHOTOS Kot EMAEETE €val EvTovo pol amd TV TAALTO YPOUATOV.
Emilééte to epyareio Tepiopotog pe ypopo kol Kévie KMK o€ o dompn
TEPLOYT LEGO GTNV EWKOVOL.
Kavte kM oto epyoreio pumpootd ypoupotoc kot emiéére dompo. 'Emeita
emiééte 10 gpyareio Tepiopévovr Opboymviov kot oyedidote éva Aompo
opBoydvio péca otnv EAAEYM.
Kleiote to Topabupo Paint.

. Me 10 €idwro Oval axoun emieyuévo, KAvie KMK 610 €PYOAEI0 YPDOUOTOG

QOVTOL 0TV ToAETA YpoUdTeV. AAAGETE TO gpyadeio ypdUATOG EOHVTOV GTO
010 pol mov YPNOUOTOMCOTE Yoo Vo YEUIOETE TNV TEPLOYN YOP® Omd TNV
EMewyn.

Y10 score Béote v puehdavn yio to idwio Oval oe Background Transparent.
Metagpépete 10 pérog 29:fiveears tov cast oto mhaicto 105 kavai 2 oto
mopdBvpo tov score. ‘Emeita otnv oxmvi KevIpapeté to péoa 6To AOTPO

opBoydvio.
L1
32:0val————]1

29:five g ars s—]

EméEre View—>Sprite Overlay>Show Info yio va anevepyomomoete to
YOPAKTNPLOTIKO OVTO.
Amofnkevote Vv gpyoacio Gog.

H teyvikn xivnong evaiiayn ypopdtov cog divel v yevdaicnon g kivinong
EVOALAGOOVTOC YPOUOTO HECOH GE U0 EMAEYUEVN TEPLOYN YPOUATOV CE [
TAETO.

15.

270 KOVAA TOAETAG LETAPEPETE TO TOVTIKL 0OG Yio Vo EMAEEETE Tl KavaAla 105
g 117.
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16. EméEte Modify—>Frame—>Palette yw va avoiéete 10 mopdbvpo Sodldyov
Palette. Kavte kAik oto Color Cycling.
17. Zmv moAéta omnv aplotepn mAsvpd tov mapdbvpov Sahdyov Palette,

HETOQEPETE YOO VO EMAEEETE TNV TEPLOY YPpOUdToV mov Oékete va
evalrldooete. Kdvte KAk oto Between Frames kot petd 6éote tov pvbud oe
10fps

P

Frame Properties: Palette 'il

EN EEEY EEEEEE
...-. .f,;maIII:Q:I Palette: | Sypstem - Win 'l

el ] | |

[ 1] ] &= . = ..

[ EEC L] Action: () Palette Tranzition Carcel
HEN [T T]] : R
- e a @ Color Cycling
EREE : pi ,

u Bate: [T | [al*] 10 fps
[ | -
lllllllll.. @ Between Frames

Select Colars to Cycle ) Span Selected Frames

Cycle Length: 1 Eoclesi |

Optionz (7 Suta Reverse

@ Loop

Frames Selected: 13

L.

H emioyr Between Frames Aéet otov Director 6t o€ kabéva and ta 13 emheypéva
mlaiole, 0éAete va evaAAdooesTE oL OpA HECH OTA EMAEYUEVA YpopoTa. Oa
deite 13 evoddayéc ypopdTov, £va oe Kabe Tlaicto.

18. Kévte KAk 010 OK y1o va kAeioete To Tapdbupo dtaddyov.
19. Metagépete to péhog 30:waterLOOP tov cast oto mAaicio 105 ot0 kavdr
Nyov 1.

yster - Systemn - -

20:waterLO0P s—f]

20. Kavte KAk o010 mhaicto 15 010 kavdAl mAouciov Yo vo. PETOKIVAGETE TNV
KEPOAN OVOTOPAY®OYNG GTO KOPLO HEVOD. TN GKNVN KAVTE KMK GTNV ETIAOYN
EXxit ko eppaviote tov Behavior Inspector yio avtod to gidwho.

21. TIpooBéote og avtd éva ocvouPdv to MouseDown kot amd 1o pevodv Actions
emAéEte Navigation>Go to Marker ko emilé&te EXit cav dvopa onpadion Kot
KMk oto OK.

o to Marker: | Exiti

22. AmoBnkevote va gpyaocia cog.
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Xpnowonotgite v avamén pali pe v okiaypaenon (tweening) ywo va
Kévete to €ldwAa va eEapavifovion kal va gueaviCovtar oe éva eovro. H
e€apavion ekOvov givar £vog ouvnOiopévog tpdmog dnuovpyiog TEAEIOUATOV
Y10 TOPOVCLAGELS, OTMG GPNVEL 6TO TEAOG TNG [0 CLUPATIKY Tovia.

23. Xto score emréEte to eidmAo fiveears kot oAAGETe T0 TAaiolo Téhovg og 132.
24. Me 1o gidmro fiveears emheyuévo akoun, emiéEre Modify—> Sprite—> Tweening
25. BePfawwbeite 611 t0 TAaicto Blend eivar emieypévo.

| N
Sprite Tweening | 22 |
Tween: [V] Path [¥] Foreground Calar Tl
[] Size [¥] Background Color
[¥] Rotation [¥] Blend | Cancel
[¥] Skew
Linear Mormal Extreme
Curvature; | |

[ Cantinuous at Endpoints

Speed: @ Sharp Changes
70 Smoath Changes

(]
(] GEI0 5 (sschsh

Eazen:

Eaze-Out:

Topa o Director 6o oxloypa@noet ovtopaTo TIC TIES avapuéng mov Eyovv tebel yia
To. TAoiclo KAEWWL €vOG 10MA0V. Mia Tiun avapéng eAEyyet v Sopaveld evog
€0MAOVL- dNAaodn Tov Pabud Katd tov omoio @aivetar to GOVIO pEcO Omd TO
gldowhro.

Otav 1 tun avépuéng evog ewdmrov givar 100% tdte dev paivetor kaboAov eovTo,
otav givar opwg 0% tote 10 €ldwA0 Oev Qaiveror kaBolov Kot PAémete puovo to
@oVTO.

26. Kadvte Ak oto mlaicio 118 1ov edwiov fiveears ka1  emlé€te
Insert->Keyframe

27. Kévte KMk oto mhaicto 132 tov elddAov ko €16AyeTe Eva TAOIG10 KAWL, N
ypopp epyoieiov eWOA®V, emAéEte TNV T TOGOGTOL avAENng Kot
kaBopiote v og 0%.
210 mhaiocto 132 , mwov givon t0 TEAEVTAIO TAOIGLO TOV EW0MAOV, TO £Id®A0 Ba
opnvel tekeioc. Topo avapeca oto mAaicwo 118 kot 132, o Director avabétet
avTOpoTO S1Apopa TocooTd avaéng oe kdbe mhaiclo Tov €WMOAOL, Yo Vo

ONUIoVPYNGEL TO £0€ GPNGILOTOC.

Inik: [ Copy - | a -
28. Emi\é€te 1o €idmho Myov waterLOOP kot aALd&ETe To TAaicto téhovg og 132.
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29. Amofnkevaote TV gpyacio Gog.
Topa Oa tpocbécete ta teheidpato oty 006vn EXit.

30. Xto score, petopépete to pérog 31:EndPara tov cast oto kavii 2, mAaiclo
133.

31. ¥t oknvn kdvte OmAO KMK 610 €I0®MA0 aLTO Yo VO ELEOVICTEL TO TapABvLPO
Paint.

32. Kdavte kMxk oto gpyoreio un yepuouévov opboymviov kot HeTd Kévte SUTAS KMK
omV €mMAOYN] GALOL TAGTOVG OTO KOT® WEPOG TNG TAALTOG EPYOAEI®V TOV
napdBvpov Paint.

33. Zto mapdbvpo dardyov, Béote tov awousimwth TAdTovg ypapung “Other” oe
12 pixels kot petd kavte kKik oto OK.

Paint Window Preferences

™

P

Brush Tools: [ Remember Color | oK |
[¥] Remember Ink

) ; . Cancel
Color Cycling: () Repeat Sequence

@ Reverse Sequence

“Other” Line Width: [T 1 [312] 12 piveks

Blend Armaount: | [x] 40 %
Lighten/D arken: [

ghower faster

Interpolate by: @) Color Walue
| Palette Location | Help |

e

34. Xpnoomomote T0 €PYOAEl0 UTPOCTA YPOUOTOC Yo Vo BE0ETE TO UTPOGTA
YPOUO GE LOVPO.

35.Enerta éxovtag axoun emieypévo to gpyadeio pn yepopévov Opboywmviov,
oyedldote Eva opboydvio mov mepPariel to bitmap g mapaypdpov mov givat
Nnon péoa oto mTopabvpo Paint.

36. EmAéte 10 epyaleio yepiopotog pe ypoua kot emAéEte Gradient amd to pevov
Ink.

| Gradient - | *

37. Kavte dumhd KMk oT0 gpyoAelo YEUGUOTOG HE YPOMO Yo VO OVOIEETE TO
napdBvpo daddyov Gradient Settings.

38. Emilé€te 10 epyodeio apykod ypopotog dafdduiong yw vo avoiete v
TOAETA YPpOUATOG Tov. EmAélte to ypdpa otnv apyf TG OEVTEPNG YPOLUNG
7oV €ivol T0 TOPTOKOAL Gav apykd ypoua. EmAiélte to gpyaieio ypodpatog
dwPddong mpoopiopoy Kot EMAEETE TO YPOUO OTO TEAOG TNG OEVTEPNG
YPOUUNG, ONA. TO pol, GOV TEAMKO YPOLLOL.

39. A6 to pevov Method, emidéEre Adjacent Colors. And to pevov Direction,
emlé€te Right to Left. Apnote tig dAleg pubuicelg 6nmg sivar Kot petd Kavte
KMk oto OK yuo va KAeioete 10 Tapabupo d1aAdYov.

40. Mg 1o gpyareio YEUMOUOTOS [E YPOUA KAVTE KAIK GTNV YPOUUR TOL 0pBoymviov
OV GYENAGATE YOP® OO TNV TOPAYPOPO.

41. Kheiote to mapdBupo Paint.
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Gradient Settings

P—

|"|

D estination . ... ..

k] |
Foreground .6 7
E ackgrnund......# J

Patterm ....e

42.

Type: @ Dither
(71 Pattern

| 5%

I ethod: [.-'-‘-.diau:ent Colars

Diirection: [Left to Right

Cycles: [I:Ine

1
S 9 = ]

Spread: I Equal

Range: IF'aint Object

napabvpo daAadyov Palette.

43.

*| [ Help ]_,:]

Kavte omAd xhx oto mhaicto 133 oto KavdAl moAétog yio vo avoiEete o

Aimha oto Action kdavte khk oto Color Cycling kot petagépete tov

avéopeiowt Rate oe 20fps. v maréta ypopdtov, PETAPEPETE TOV OEiKT
TOV TOVTIKIOD Y10 Vo EMAEEETE TO YPOUOTO OTNV TPITN YPOUUN TOV HOALG
ypnoporomcate otnv dtodduon kot kavte KAk oto OK yia vo kieioete 10

mopdOvpo dtoAdyov.

Frame Properties: Palette

EN SEED EEEEEN

Select Colors to Cycle
Cycle Length: 16

Frames Selected: 1

Palette: | Spstem - Win vJ
Achion: () Palette Tramsition
@ Color Cycling
Rate: Il 1 G 20 fps
(@ Between Frames
Span Selected Frames
Cycles: 1
Optionz: () Auto Reverse

@ Loop

44. Y10 xavam morétag, emihé€te to mhaicto 133 ko émerto motdte To Alt kot
HETOQEPETE TO TEMKO TAAIGIO TOL EWOMAOV KOVOALOD TOAETOC G6TO TAiclo 145.

45, Kdvte owmAd KAk o©T0 TAOIGLO

System - Win

145 o10 wové

CLUUTEPLPOPES KO

minktporoynote halt kétw amd to exitFrame ko kAgiote to Tapdbvpo Tkpinrt.
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Otav n KeQoA oavomopaywyns eykotoleinet avtd to mAaicto, o Director
otapatd v towvio. H evépyeio avt eivon mapopota e To vo KAVETE KAK GTO
Kovumi Stop otnv ypauun epyareiov. Ymapyetl eniong o vtoAn quit mov oty
ovoia gykataieinel tnv epappoyn director. H evtoin halt eivon kodvtepn yati
etvat ToAD ypovoPopo va eAEYyeTe TNV aAAnAovyio TEAOVS £YKATAAEITOVTOG TOV
Director. X o mapovsio g Toviag , 1 eviodn halt eykataieinet to épyo.

46. AmoOnkevote ) epyacio coc. EETLAIETE TV TavVio KO OVOTTOPAYETE TNV.
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